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Integrated EMS Configuration 
Management

Introduction
Configuration Management in Nortel Networks Integrated EMS 
includes:

• adding objects

— platforms

— element managers

— EMS applications

— network elements

• editing object properties

• viewing object properties

• viewing the inventory

• resynchronizing element manager details

Integrated EMS provides user friendly GUIs to perform the above 
operations. These tasks can be done from Java Web Start Client and 
Web Client GUIs. The Integrated EMS Cofiguration Management 
guide, NN10330-511 is divided into the following:

• Working with IEMS topologies in the Java Web Start client

— Adding objects to topology

— Editing properties of objects

— Using the topology operations

• Working with inventory panel

• Working with topologies in Web Client

• Working with inventory in Web Client
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Working with IEMS topologies in the 
Java Web Start client

The topology provides a symbolic representation of the Element 
Management Systems (EMSs), Network Elements (NEs), platforms, 
and applications that are being managed by Integrated EMS. A 
topology node consists of one or more of the following objects:

• symbols that represent managed resources

• topology links that represent the connection between resources

• groups that represent a set of resources grouped logically

• containers that contain resources within them

The node named Integrated EMS Topologies can be found in the 
Integrated EMS tree as in the following figures:
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The sub-sections covered in this section are listed below:

• Adding objects to topology

— Adding EMS platform

— Adding element managers

— Adding EMS applications

— Adding network elements

• Editing properties of objects

• Using the topology operations

Note: Do not specify the IP address in the client GUI or the 
command prompt UI, with an octet which is prefixed with a "zero".  An 
IP address whose octet ranges from 0 to 255, when prefixed with 
zero, such as 010, is interpreted as an octal number and is passed 
as an "8", which results in an invalid IP address.
Integrated EMS Configuration Management
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Identifying object map symbols
The various map symbols used in the topologies to represent the 
objects in Integrated EMS Client are tabulated below:

Identifying object map symbols

Map Symbol Associated EMS/NE

Element managers

Audio Provisioning Server Manager (APS Manager)

Communication Server 2000 Core Manager (CS 2000 Core 
Manager)

Core Element Manager (CEM)

Multimedia Communication Server 5200 Manager (MCS 
Manager)

Fault and Performance Manager (FPM)
NN10330-511   (I)SN08   Standard 02.05 March 2006
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Communication Server 2000 Gateway Controller Manager 
(CS 2000 GWC Manager)

Media Gateway 9000 Manager (MG 9000 Manager)

Communication Server 2000 SAM21 Manager (CS 2000 
SAM21 Manager)

Universal Audio Server Manager (UAS Manager)

Centrex IP Client Manager (CICM Manager)

Integrated Element Management System (IEMS)

Identifying object map symbols

Map Symbol Associated EMS/NE
Integrated EMS Configuration Management
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MCS system manager unit

FPM (Fault and Performance Manager) 

EMS applications

Audio Provisioning Server (APS)

Line Maintenance Manager (LMM)

Trunk Maintenance Manager (TMM)

OSSGate

Identifying object map symbols

Map Symbol Associated EMS/NE
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Network Patch Manager (NPM)

QoS Collector Application (QCA)

Synchronized Backup Restore Manager (SBRM)

EMS platforms

Server Platform Foundation Software (SSPFS)

Multi-Service Data Manager

SuperNode Data Manager (SDM)

Identifying object map symbols

Map Symbol Associated EMS/NE
Integrated EMS Configuration Management
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NEs

Universal Signaling Point (USP)

Passport 8600 (PP8600)

Media Server 2000 (MS 2000)

Storage Management (STORM)

Media Application Server (MAS)

Communication Server 2000 Core NE (CS 2000 Core NE) 
managed by CS 2000 Core Manager

Identifying object map symbols

Map Symbol Associated EMS/NE
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Call Agent Core managed by CS 2000 Core Manager

Call Agent Platform is subnode of Call Agent Core

Multimedia Communication Server (MCS) NE managed by 
MCS Manager

Virtual Switching Point (VSP) NE managed by Multi-Service 
Data Manager

Multiservice Switch 15000 (MSS 15000) NE managed by 
Multi-Service Data Manager

Multiservice Switch 7000 (MSS 7000) NE managed by 
Multi-Service Data Manager

Identifying object map symbols

Map Symbol Associated EMS/NE
Integrated EMS Configuration Management



Nortel Networks Confidential12Copyright © 2006, Nortel Networks
Objects supporting GUI application or Command Line application 
launch from topology

The following EMS platforms, element managers, EMS applications, 
and NEs supports launching of GUI applications from Integrated EMS 
Client:

• EMS platforms

— SSPFS

• element managers

— Audio Provisioning Server Manager

— CS 2000 Manager

— MCS Manager

— Fault and Performance Manager

Multiservice Switch 20000 (MSS 20000) managed by 
Multi-Service Data Manager

Pocket Voice Gateway (PVG) managed by Multi-Service 
Data Manager

Centrex IP Client Manager (CICM) NE managed by CICM 
Manager.

RTP Media Portal NE

Identifying object map symbols

Map Symbol Associated EMS/NE
NN10330-511   (I)SN08   Standard 02.05 March 2006
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— CEM Manager

— GWC Manager

— MG 9000 Manager

— Multi-Service Data Manager

— SAM21 Manager

— Universal Audio Server

— CICM Manager

• EMS applications

— APS application

— Line Maintenance Manager

— Trunk Maintenance Manager

— Network Patch Manager

— Audio Provisioning Server

— OSSGate

• NEs

— Universal Signaling Point

— STORM

— GWC

— MCS

— Passport 8600

— MS 2000

— SAM21

— CS 2000 Core

— Session Server

— MAS

— CICM (in CICM Card View)
Integrated EMS Configuration Management
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The following EMS platforms, element managers, EMS applications, 
and NEs supports launching of Command Line interface from 
Integrated EMS Client:

• EMS platforms

— MDM

— SSPFS

— SDM

• element managers

— Multi-Service Data Manager

— CICM Manager

— MCS Manager

• EMS applications

— QoS Collector Application

— OSSGate

— SBRM application

• NEs

— Passport 8600

— STORM

— USP

— MS 2000

— Call Agent Core

– Call Agent Platform

— GWC

— Universal Audio Server

— Session Server

— CS 2000 Core

— MCS and Media Proxy

— PVG 7480/15000 and MSS 15000

— SAM21

— UAS

The procedure to launch the applications from Integrated EMS is 
described and explained in "Launching Applications from Integrated 
EMS" of the Integrated EMS Basics, NN10329-111.
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Adding objects to topology

This section describes adding a map symbol from your Integrated EMS 
Client. A map symbol can be associated with a managed object 
representing its status. Some objects can be automatically added to the 
Integrated EMS topology, while others have to be manually added. The 
following table details the mode of discovery for each object.

Mode of discovery of various EMS/NE

Object Mode of Discovery 

element managers

Audio Provisioning Server Manager Manually added

CS 2000 Core Manager Manually added

MCS Manager manages MCS and Media Proxy NE Manually added

Core Element Manager Manually added

GWC Manager Manually added

MG 9000 Manager Manually added

Multi-Service Data Manager Manually added

SAM21 Manager Manually added

UAS Manager Manually added

CICM Manager Manually added

EMS applications

Line Maintenance Manager Manually added

Trunk Maintenance Manager Manually added

OSSGate Application Manually added

Network Patch Manager Manually added

QoS Collector Application Manually added

Audio Provisioning Server Automatic discovery
Integrated EMS Configuration Management
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EMS platform

SSPFS Manually added

MDM Manually added

SDM Automatic discovery

NEs

Universal Signaling Point Manually added

Passport 8600 NE Manually added

STORM Manually added

Media Server 2000 Manually added

Media Application Server Manually added

Session Server Manually added

CICM NE managed by CICM Manager Manually added

CS 2000 Core NE managed by CS 2000 Core 
Manager

Automatic discovery

Call Agent Core managed by CS 2000 Core Manager Automatic discovery

Call Agent Platform managed by CS 2000 Core 
Manager

Automatic discovery

MCS NE managed by MCS Manager Automatic discovery

Media Proxy NE managed by MCS Manager Automatic discovery

PVG 7480/15000 managed by Multi-Service Data 
Manager

Automatic discovery

Multiservice Switch 15000 (MS 15000) managed by 
Multi-Service Data Manager

Automatic discovery

GWC NE managed by GWC Manager Automatic discovery

MG 9000 NE managed by MG 9000 Manager Automatic discovery

Mode of discovery of various EMS/NE

Object Mode of Discovery 
NN10330-511   (I)SN08   Standard 02.05 March 2006
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To add a map symbol in Integrated EMS Client, follow these steps:

1. Launch the Add EMS/NE wizard using the menu command 
Tools-->Add--><Object to be added>, where <Object to be 
added> can be an EMS platform, EMS/NE, or Application.

2. Enter the details of the object added.

3. Click the Next button.

4. Enter the fault interface details if any.

5. Click the Next button.

6. Enter the performance interface details if any.

7. Click the Finish button.

Invoking Add Object Wizard
The Add Object Wizard can be launched using any of the methods in 
the following table:

SAM21 NE managed by SAM21 Manager Automatic discovery

UAS NE managed by UAS Manager Automatic discovery

CICM SAM21 card view Automatic discovery

MTX NE managed by CEM Manager Automatic discovery

MSC NE managed by CEM Manager Automatic discovery

HLR NE managed by CEM Manager Automatic discovery

TRI NE managed by CEM Manager Automatic discovery

Mode of discovery of various EMS/NE

Object Mode of Discovery 

Various Methods to Invoke EMS/NE Wizard

Managed Object to be 
Added From Menu Bar Shortcut Key

element managers or 
NEs

Tools-->Add-->EMS/NE Ctrl+Shift+E

EMS applications Tools-->Add-->Application Ctrl+Shift+A

EMS platforms Tools-->Add-->Platform Ctrl+Shift+P
Integrated EMS Configuration Management
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The following figure shows a Add EMS/NE wizard launched using the 
Tools-->Add-->EMS/NE menu command.

Providing the object details
The add object wizard allows the addition of EMS platform, element 
manager, EMS application, or an NE to the Integrated EMS topology. 
The following listing provides a description of the required fields that 
need to be entered.

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.
NN10330-511   (I)SN08   Standard 02.05 March 2006
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Click the Next button to proceed to the Fault Interface details screen.

Providing the fault interface details
After providing the object details, the Fault Interface details associated 
with the object must be provided. If the message stating "No Fault 
Interface" is displayed, proceed to next step.

Note: The fields in the Details panel change according to the 
selected object (element manager, EMS, platform, or NE).

Providing the performance interface details
The Performance Interface details associated with the object must be 
provided in the Performance Details of the wizard. If the message 
stating "No Performance Interface" is displayed, proceed to next step.

Note: The fields in the Performance Interface screen change 
according to the selected object (element manager, EMS, platform or 
NE).

Click the Finish button to add the required object to the Integrated EMS 
topology. If successful, the following message is shown in the status bar 
of the wizard:

If the object host DNS is not resolved, the object is added to the 
topology with the provided details, and the status bar shows the 
following message:

Display Name Enter the display name to be displayed in the topology for 
the map symbol.

Type Select the type of object to be added to database from the 
list box.

Field Description
Integrated EMS Configuration Management
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If the object is not added in the topology, the status bar of the wizard 
shows the following message:

If the host name or IP address specified in the Host Name/IP Address 
field is invalid, the status bar of the wizard shows the following 
message:

Note 1: The added object name and its IP address can be viewed in 
the log messages displayed in the Security Log window invoked 
through the Tools menu command. 

Note 2: If the map symbols are disturbed or moved in the topology 
panel, then the objects are added to the same topology panel. The 
added map symbols can overlap with existing map symbols, hence 
to rearrange the map symbols properly, select the View-->Refresh 
menu command.
NN10330-511   (I)SN08   Standard 02.05 March 2006
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Adding EMS platform

The Nortel Networks element management systems are deployed in a 
Nortel Networks platform. Integrated EMS provides an interface to 
provision and manage these platforms. This section provides the 
procedures to add these platforms to the Integrated EMS topology. The 
platforms that can be managed by Integrated EMS are listed below:

• SSPFS

• MDM

• SDM

Note: The SDM platforms are automatically discovered by 
Integrated EMS and added to the topology. The discovered SDM 
platform map symbols can be viewed under the EMS Platforms 
topology node in the Integrated EMS tree.
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Adding an Succession Server Platform Foundation Software (SSPFS 
Platform)

The SSPFS platform is the run-time environment for various Nortel 
Networks EMSs and applications. This section describes how to add 
the SSPFS platform to the topology.

The following list provides the operations available for the SSPFS 
platform in Integrated EMS.

Tasks Supported in Integrated EMS for the SSPFS platform

Task in Integrated EMS

Availability 

Java Web Start 
Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Launching corresponding applications Yes No
NN10330-511   (I)SN08   Standard 02.05 March 2006
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To add the SSPFS platform to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->Platform menu command to invoke 
the Add Platform wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "SSPFS" from the Device Type list box.

5 Select the mode from the Mode list box. If "Simplex" item is 
selected from Mode list box, perform sub-step step 5a and 
proceed to step 6. If "Duplex" item is selected from the Mode list 
box, follow these steps:

Security

Centralized authentication and authorization 
(RADIUS client)

Yes (for version 
7.0 and 8.0)

No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for the SSPFS platform

Task in Integrated EMS

Availability 

Java Web Start 
Client Web Client

Description of fields in Add Platform Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the platform. 
In HA (High Availability) configuration, this is the primary 
IP.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
Integrated EMS Configuration Management
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a Enter the IP address of the active unit in the Unit 0 field.

b Enter the IP address of the inactive unit in the Unit 1  field.

6 Select the version of the device from the Device Version list 
box.

7 Click the Next button. 

A list of fields displaying the location of various log files, such as 
Customer Log File, Audit Log File, and Security Log File is 
displayed.

8 Click the Next button.

"No Performance Interface" message is displayed.

9 Check the Radius Secret field to enable the RADIUS secret 
password and enter RADIUS secret password in the Radius 
Secret field.

Note: If the Radius Secret field is checked and the password 
is not entered, the wizard displays "Enter the radius secret" 
error.

10 Click the Next button.

11 Enter the port value "2222" (in which the SSPFS communicates 
with Integrated EMS) in the Port field.

12 Enter the community in the Community field.

13 Select the SNMP version "v2c" from the Version list box.

14 Click the Next button.

15 Enter the port value "1161" in the Port field.

16 Enter the community in the Community field.

17 Select the SNMP version "v1" from the Version list box.

18 Click the Finish button to add the SSPFS platform.

Once the SSPFS platform is added, a message appears in the 
status bar of the wizard is shown as in the following screen shot:

If selected device version 
is

Do

6.2 follow step 7, step 8, and 
step 18

7.0 go to step 9

8.0 go to step 9
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The SSPFS platform with the specified name is added as map 
symbol to the EMS Platforms topology panel. It is also added to 
the SSPFS topology under the EMS Platforms topology node in 
Integrated EMS tree.

Note: Integrated EMS correlates events received only from 
the SSPFS SNMP interface. The non-SNMP interfaces such 
as SYSLOG must be disabled using the "disable local logging" 
option from CLI. For details, refer to "Disabling local logging of 
SSPFS platform faults" section of ATM/IP Solution-level Fault 
Management, NN10408-900.
Integrated EMS Configuration Management
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Adding an Multi-Service Data Manager platform (MDM platform)

The Multi-Service Data Manager platform is the runtime environment 
for various Nortel Networks EMSs and applications. Integrated EMS 
adds the Multi-Service Data Manager (MDM) platform 8.0 automatically 
when adding the MDM 8.0 to the Integrated EMS topology. The 
corresponding MDM platform is automatically discovered and added 
under the MDM topology (present under Platforms topology in the 
Integrated EMS tree) as in the following figure: 

This procedure describes how to add the MDM platform version 6.2 and 
7.0 to the topology. The following list provides the operations available 
for MDM platform in Integrated EMS.

Tasks Supported in Integrated EMS for the MDM platform

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No
NN10330-511   (I)SN08   Standard 02.05 March 2006
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To add the MDM platform to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events Yes (only for 
version 8.0)

Yes (only for 
version 8.0)

Clearing alarms Yes (only for 
version 8.0)

Yes (only for 
version 8.0)

Deleting alarms Yes (only for 
version 8.0)

Yes (only for 
version 8.0)

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for the MDM platform

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
Integrated EMS Configuration Management
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2 Select the Tools-->Add-->Platform menu command to invoke 
the Add Platform wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "MDM" from the Device Type list box.

5 Select the version of the device from the Device Version list 
box.

6 Click the Next button. 

A "No Fault Interface" message is displayed.

7 Click the Next button.

A "No Performance Interface" message is displayed.

8 Click the Finish button to add the MDM platform.

Once the MDM platform is added, a message in the status bar 
of the wizard is shown as in the following screen shot:

The MDM platform with the specified name is added as a map 
symbol to the EMS Platforms topology panel. It is also added to 
the MDM topology under the EMS Platforms topology node in 
the Integrated EMS tree.

Description of fields in Add Platform Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the platform.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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Adding an SuperNode Data Manager platform (SDM platform)

Integrated EMS adds the SuperNode Data Manager (SDM) platforms 
are added automatically when adding the CS 2000 Manager (with 
platform as SDM) to the Integrated EMS topology. The SuperNode Data 
Manager (SDM) platforms added as map symbols in EMS Platforms 
topology panel and in the SDM topology under the EMS Platforms 
topology node of Integrated EMS tree.

The following list provides the operations available for SDM platform in 
Integrated EMS.

Tasks Supported in Integrated EMS for the SDM platform

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No
Integrated EMS Configuration Management
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Security

Centralized authentication and 
authorization (RADIUS client)

Yes (only for 
version 8.0)

No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for the SDM platform

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
NN10330-511   (I)SN08   Standard 02.05 March 2006
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Adding element managers

Integrated EMS provides an integration point for the various element 
managers. It allows a centralized point, to launch the various element 
managers and the ability to view the faults from these systems in a 
common graphical interface. This section describes the procedures to 
add various element managers listed below:

• Adding an Audio Provisioning Server Manager (APS Manager)

• Adding a Communication Server 2000 Core Manager (CS 2000 
Core Manager)

• Adding a Core Element Manager (CEM)

• Adding a Multimedia Communication Server Manager (MCS 
Manager)

• Adding a Fault and Performance Manager (FPM)

• Adding a Gateway Controller Manager (GWC Manager)

• Adding a Multi-Service Gateway 9000 Manager (MG 9000 
Manager)

• Adding a Multi-Service Data Manager (MDM)

• Adding an SAM21 Manager

• Adding an Universal Audio Server Manager (UAS Manager)

• Adding a Centrex IP Client Manager (CICM Manager)

Note 1: When the above element managers are added to the 
Integrated EMS topology, the NEs managed by these element 
managers are discovered automatically and added to the Integrated 
EMS topology.

Note 2: Integrated EMS support dynamic updates for some of the 
element managers. Integrated EMS topology is updated based on 
the objects managed by the corresponding element managers. 
Integrated EMS supports dynamic topology updates for following 
element managers:

• Audio Provisioning Server Manager

• Universal Audio Server Manager

• GWC Manager

Note 3: Do not specify the IP address in the client GUI or the 
command prompt UI, with an octet which is prefixed with a "zero". An 
IP address whose octet ranges from 0 to 255, when prefixed with 
Integrated EMS Configuration Management
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zero, such as 010, is interpreted as an octal number and is passed 
as an "8", which results in an invalid IP address.
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Adding an Audio Provisioning Server Manager (APS Manager)

The Audio Provisioning Server (APS) is used to provision the encoded 
mu-law and a-law announcements that the UAS network element plays. 
Upon provisioning, the APS Manager Integrated EMS discovers the 
APS applications configured in the CMT server. After an APS Manager 
is added to the Integrated EMS topology, the corresponding APS 
application is discovered and added under the EMS Applications 
topology. This procedure describes how to add the APS Manager to the 
Integrated EMS topology.

The following list provides the operations available for APS Manager in 
Integrated EMS.

Tasks Supported in Integrated EMS for APS Manager

Task in Integrated EMS

Availability

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job No No

Report job No No

Transfer job No No
Integrated EMS Configuration Management
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To add the APS Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "APS Mgr" from the Device Type list box.

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for APS Manager

Task in Integrated EMS

Availability

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Note: The IP address must be the primary IP address of 
the CMT platform.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Click the Next button.

The channel name and the administrator name are displayed in 
various fields.

9 Click the Next button.

"No Performance Interface" message is displayed.

10 Click the Finish button to add the APS Manager.

Once the APS Manager is added, a message in the status bar of 
the wizard is shown as in the following screen shot:

The APS Manager with the specified name is added as map 
symbol to the Element Managers topology panel. In addition, a 
topology node named APS Manager with the specified display 
name in brackets is added under the Element Managers 
topology node in Integrated EMS tree. Also, Integrated EMS 
automatically discovers the APS application of the 
corresponding APS Manager (which is added) and added as 
map symbol under the EMS Applications topology.

The APS Manager can be added using Integrated EMS Web Client. For 
details, refer to Adding an APS Manager procedure.
Integrated EMS Configuration Management
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Adding a Communication Server 2000 Core Manager (CS 2000 Core 
Manager)

CS 2000 Core Manager is also known as CS2K Manager since 2K 
stands for 2000. CS 2000 Core Manager manages CS 2000 Core and 
Call Agent Core NEs. When the Call Agent Core NE is added, the 
corresponding Call Agent platform is discovered automatically. In 
addition, the Call Agent Core NE node is added in Call Agent Core 
topology node under the Networks Elements node in the Integrated 
EMS tree. The Call Agent platform is added in the Call Agent Platform 
topology node (under the Networks Elements-->Call Agent Core 
node) in the Integrated EMS tree.

Note 1: While configuring the CS 2000 Core Manager logroute, 
ensure the following:

• Logroute on the associated SDM must be configured for TCPIN.

• Logroute on the associated SDM must be configured with 
ECORE set to OFF.

• Logroute on a CS 2000 Core Manager with a pre SDM20 software 
load version: the associated SDM log format must be set to STD 
or SCC2.

• Logroute on a CS 2000 Core Manager with a SDM20 or greater 
software load version: the associated SDM log format must be set 
to STD_OLD or SCC2_OLD.

Note 2: The end of log format for the NTSTD and SCC2 feeds can 
be configured in Integrated EMS by modifying the 
MLDefaultParams.xml file under the /opt/nortel/iems/current/conf 
folder. The SCC2 end of log format is specified in "SCC2_MESSAGE 
ENDOFLOG" parameter and NTSTD end of log format is specified in 
"NTSTD_MESSAGE ENDOFLOG" parameter. The end of log format 
must be using the X character format and be separated with colon 
(":"). The default end of log format values in MLDefaultParams.xml 
file are:

SCC2_MESSAGE ENDOFLOG="0A:0D:20:0A:0D"

NTSTD_MESSAGE ENDOFLOG="0A:19:0A:0D"

If the end of log format is changed in the MLDefaultParams.conf, the 
Integrated EMS Server requires restart to reflect the changes. 

Note 3: Integrated EMS polls periodically to check the CS 2000 
platform object status. If the data is not received between two status 
polls, Integrated EMS disconnects and reconnects the CS 2000 Core 
Manager. If the reconnect attempt throws an error, the CS 2000 Core 
Manager and its corresponding components turn to an unknown 
NN10330-511   (I)SN08   Standard 02.05 March 2006



Nortel Networks Confidential37Copyright © 2006, Nortel Networks
object status in Integrated EMS. In other words, the map symbols of 
these objects will turn to a gray background. For details on color for 
various severity levels, refer to the table in the Updating status of 
objects manually.

It is suggested that the polling interval for the CS 2000 Core Manager 
object in Integrated EMS retain (or be left near) the default value (300 
seconds). Reducing this significantly can result in frequent and 
unnecessary attempts to reconnect to the CS 2000 Core Manager 
fault feed.

Note 4: All the events from the CS 2000 Core Manager are added 
as stateless events in Integrated EMS. These events are not 
correlated to alarms.

Note 5: The CS 2000 Core Manager residing on SSPFS platform is 
known as Core Billing Manager.

The following list provides the operations available for CS 2000 Core 
Manager in Integrated EMS.

Tasks Supported in Integrated EMS for CS 2000 Core Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events Yes Yes

Clearing alarms No No

Deleting alarms No No

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management
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To add the CS 2000 Core Manager to the topology, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

Yes (only for 
version 8.0)

No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for CS 2000 Core Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.
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4 Select "EMS" from the Type list box.

5 Select "CS2K Core Mgr" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Check the Radius Secret field to enable the RADIUS secret 
password and enter RADIUS secret password in the Radius 
Secret field.

Note: If the Radius Secret field is checked and the password 
is not entered, the wizard displays "Enter the radius secret" 
error.

8 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belongs to any 
platform.

Note: When the CS 2000 Core Manager version 7.0 is added 
with associated platform as "SSPFS", it implied that CS 2000 
Core Manager is a Core Billing Manager (CBM). 

9 Select the NE type "CS 2000 Core" or "Call Agent Core" from the 
Managing NE Type list box (By default, "CS 2000 Core" is 
selected in the list box). If "CS 2000 Core" is selected from the 
Managing NE Type list box, type the CS 2000 Core device IP 
address in the CS 2000 Core IP Address field. If "Call Agent 
Core" is selected from the Managing NE Type list box, follow 
these steps: 

a Select the mode from the Mode list box. If "Duplex" item is 
selected, perform sub-step b and proceed to step 10.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 

Description of fields in Add EMS/NE Wizard

Field Description

If the selected device 
version is

Do

8.0 Go to step 7

7.0 Go to step 8

6.2 Go to step 8
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b Type the valid IP address of the active unit in the Active Unit 
IP field.

c Type the valid IP address of the inactive unit in the Inactive 
Unit IP field.

10 Enter the display for the NE in the NE Display Name editable list 
box or select a value from the NE Display Name editable list 
box.

11 Click the Next button.

Note: If CEM is already added in the Integrated EMS, the 
message as in the following screen shot is displayed. If you 
want to continue, click the Yes button.

12 Refer to the Note 1 and check the NTSTD Port or SCC2 Port 
and change the Port (if required). 

Note: The CS 2000 Core Manager sends log messages 
either through the NTSTD interface or through the SCC2 
interface. Select the applicable interface fields and change the 
port (if different from default value).

13 Click the Next button.

A "No Performance Interface" message is displayed.

14 Click the Finish button to add the CS 2000 Core Manager.

Once the CS 2000 Core Manager is added, a message appears 
in the status bar of the wizard as in the following screen shot:

The CS 2000 Core Manager with the specified name is added as 
a map symbol to the Element Managers topology panel. In 
addition, a topology node named CS 2000 Manager with the 
specified display name in brackets is added under the Element 
Managers topology node in the Integrated EMS tree.
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If the NE type "Call Agent Core" is selected from the Managing 
NE Type list box, the Call Agent Core NE is discovered and the 
corresponding Call Agent platform is discovered automatically 
and added. The Call Agent Core NE node is added in the Call 
Agent Core topology node (under the Networks Elements 
node) in the Integrated EMS tree. The Call Agent platform is 
added in the Call Agent Platform topology node (under the 
Networks Elements-->Call Agent Core node) in the Integrated 
EMS tree.

The CS 2000 Manager can be added using Integrated EMS Web Client. 
For details, refer to Adding an CS 2000 Core Manager procedure.
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Adding a Core Element Manager (CEM)

This procedure describes how to add the Core Element Manager (CEM 
Manager) to the Integrated EMS topology. When CEM is added to 
Integrated EMS topology, the MTX NE (Mobile Telephone Exchange 
NE), MSC NE (Mobile Switching Center NE), HLR NE (Home Location 
Register NE), and TRI NE are automatically discovered and added in 
the CEM topology node under the Networks Elements topology.

Note: The Core Element Manager is only supported in wireless 
markets and available with selected versions of Carrier VoIP 
platforms. Hence, Core Element Manager is available in selected 
sites of Carrier VoIP platforms.

The following list provides the operations available for CEM Manager in 
Integrated EMS.

Tasks Supported in Integrated EMS for CEM Manager

Task in Integrated EMS

Availability

Java Web 
Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job No No
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To add the CEM Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

Report job No No

Transfer job No No

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for CEM Manager

Task in Integrated EMS

Availability

Java Web 
Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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5 Select "CEM Mgr" from the Device Type list box.

6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

7 Click the Next button.

Note: If CS 2000 Manager is already added in the Integrated 
EMS, the message as in the following screen shot is 
displayed. If you want to continue, click the Yes button.

The CEM Manager port is displayed in the CEM Port field.

8 Click the Next button.

A "No Performance Interface" message is displayed.

9 Click the Finish button to add the CEM Manager.

Once the CEM Manager is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The CEM with the specified name is added as a map symbol to 
the Element Managers topology panel. In addition, a topology 
node named Core Element Manager with the specified display 
name in brackets is added under the Element Managers 
topology node in the Integrated EMS tree

The CEM can be added using Integrated EMS Web Client. For details, 
refer to Adding an CEM procedure.
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Adding a Multimedia Communication Server Manager (MCS Manager)

MCS Manager manages MCS/CSE MX and Media Proxy NEs. When 
you add an MCS Manager, the MCS/CSE MX or Media Proxy NE is 
added as a map symbol under the Network Elements topology and 
MCS/CSE or RTP Media Portal topology (under Network Elements 
node). The MCS Manager is added as logical system manager server 
map symbol in the Element Managers topology. Also, the physical 
MCS system manager (SM) are added as map symbols in the MCS SM 
topology (with parent MCS Manager display name in brackets). This 
procedure describes how to add the MCS Manager to the Integrated 
EMS topology.

Note 1: When adding MCS Manager 7.0 in Integrated EMS, both the 
active and inactive MCS Managers must be added as separate 
objects in the Integrated EMS topology. The physical IP address of 
the active or inactive MCS Manager host must be entered in the Host 
Name/IP Address of Add EMS/NE wizard. If events are received 
from the MCS Manager with virtual IP address, they are correlated as 
events from unknown device.

Note 2: In the HA configuration, the standby MCS Manager is 
always in an "unknown" state and it raises the Unable To 
Communicate with Device alarm. This alarm cannot be cleared in 
Integrated EMS.

Note 3: The MCS system manager (MCS SM) is also known as 
MCS 5200 Manager.

Prerequisites: for Integrated EMS to receive MCS fault and 
performance data

MCS must be configured to send fault and performance data to 
Integrated EMS. Without this configuration, Integrated EMS receives no 
fault and performance data from Session Server NEs.

Prerequisites for launching MCS Client
MCS client launch is available only on a PC that has MCS software 
installed. For details of how to install the software, refer to MCS System 
Management Console User Guide, NN10247-111. MCS Client 
software can be launched only in Microsoft Windows platforms.
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The requirements for launching the MCP Management Console from 
the MCS system manager are:

• The client workstation must have JRE 1.4.2_06 version installed in 
it.

• The MCP System Management Console can be launched only for 
Microsoft Windows platform-based client workstations.

Adding an MCS Manager using Java Web Start client
The following list provides the operations available for MCS Manager in 
Integrated EMS.

Tasks Supported in Integrated EMS for MCS Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No
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To add the MCS Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE dialog.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "MCS Mgr" from the Device Type list box.

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for MCS Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the version of the device from the Device Version list 
box.

7 Enter the user name of the device in the User Name field. 

8 Select the mode of the device from the Mode list box.

If "Duplex" mode is selected, enter the primary IP address and 
secondary IP address in the Instance 0 and Instance 1 fields 
respectively.

9 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

10 Select the NE type "MCS/CSE MX" or "Media Proxy" from the 
Managing NE Type list box. By default, "MCS/CSE MX" is 
selected in the list box.

11 Click the Next button.

12 In the Port field, enter the port value (in which the EMS 
communicates with Integrated EMS).

13 Enter the community in the Community field.

14 Select the SNMP version "v2c" from the Version list box.

Note: The port value and the SNMP version are dependent 
on the MCS Manager configuration that is added.

15 Click the Next button.

16 In the Directory Name field, enter the directory name where the 
CSV file is present in the device.

For MCS Manager 8.0, wildcard support is available for this field. 
In general, the MCS System Manager operational measurement 
(OM) files resides in 
“/var/mcp/oss/om/MCP_4.0/<fault-performance manager 
instance ID>/<network element instance ID>/<file format option 
name>” folder.

Example
“/var/mcp/oss/om/MCP_4.0/SM_0/*/csv/” where * is a 
wildcard representing “network element instance ID”.

If the selected version is Do

6.2 steps 9 to 15 and step 20

7.0 steps 9 to 20 

8.0 steps 7 to 20
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If the MCS System Manager is in duplex mode, then, the 
performance data collection jobs should continue and the OM 
files should be collected from the currently active physical unit IP. 
The OM directory path for the two physical units are different and 
hence when a SWACT takes place in the MCS System Manager 
host, the directory from which the OM files should be collected 
will differ. As only one path can be given when configuring the 
MCS System Manager, the wildcard * can be used when 
specifying the directory path so that the different directory paths 
in the units are handled. This way, collection of the OM files can 
happen even after a SWACT had taken place.

Example
“/var/mcp/oss/om/MCP_4.0/FPM1_*/*/csv-file”

17 In the File Name field, enter the file mask of the CSV file present 
in the device.

Wildcard support is available for this field.

Example
If the file names start with "CSVOM" string, you can enter the 
value "CSVOM*.csv".

18 Enter the user name for FTP account in the User ID field.

19 Enter the corresponding password for FTP account in the 
Password field.

20 Click the Finish button to add the MCS Manager.

Once the MCS Manager is added, a message appears in the 
status bar of the wizard as in the following screen shot:

Note: After adding an MCS Manager version 8.0, the fault interface 
and performance details are associated to corresponding physical 
SM servers that are added in the MCS SM(XXX) node (MCS SM 
node with the parent MCS Manager display name) under the Element 
Managers topology. Hence the fault interface and performance 
details cannot be modified for MCS Manager map symbol in the 
Element Managers topology. It can be modified only for 
corresponding physical SM server in MCS SM(XXX) node.

 The MCS Manager 8.0 with the specified name is added as a logical 
SM server map symbol to the Element Managers topology panel. The 
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MCS SM (with the specified display name in brackets) is added under 
the Element Managers topology node of the Integrated EMS tree. The 
physical MCS SM server are added as map symbols in the topology 
node named MCS SM(XXX) (with the specified display name in 
brackets). When adding a MCS Manager 8.0 in duplex mode, the 
primary and secondary physical SM servers are added as map symbol 
in the MCS SM(XXX) node present under the Element Managers 
topology node of the Integrated EMS tree similar to the following screen 
shot.

Note: The primary and secondary physical SM server map symbols 
display names are "<MCS Manager display name>_0" and "<MCS 
Manager display name>_1" respectively (similar to the preceding 
screen shot).

The MCS (or MCS/CSE) NE or Media Proxy NE added under the 
Network Elements node and MCS/CSE or RTP Media Portal node 
has the display name appended with the parent MCS Manager display 
name in brackets similar to the following screen shot:
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This also applies to the Web Client.

The MCS Manager can be added using Integrated EMS Web Client. 
For details, refer to "Adding an MCS Manager".
Integrated EMS Configuration Management



Nortel Networks Confidential52Copyright © 2006, Nortel Networks
Adding a Fault and Performance Manager (FPM)

This procedure describes how to add the Fault and Performance 
Manager (FPM) to the Integrated EMS topology.

Prerequisites for adding FPM
To add an FPM, the corresponding MCS Manager must be added to the 
Integrated EMS topology.

Adding an FPM using Java Web Start client
The following list provides the operations available for FPM in 
Integrated EMS.

Tasks Supported in Integrated EMS for FPM

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No
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To add the FPM to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE dialog.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "FPM Mgr" from the Device Type list box.

6 Retain the version "8.0" in the Device Version list box.

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for FPM

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 From the MCS Managers list box, select the MCS Manager to 
which the FPM corresponds.

9 Select the mode of the device from the Mode list box.

If "Duplex" mode is selected, enter the primary IP address and 
secondary IP address in the Instance 0 and Instance 1 fields 
respectively.

10 Enter the user name of the device in the User Name field. 

11 Click the Next button.

12 Enter the port value "12517" (in which the EMS communicates 
with Integrated EMS) in the Port field.

13 Enter the community in the Community field.

14 Select the SNMP version "v2c" from the Version list box.

Note: The port value and SNMP version are dependent on 
the FPM configuration which is added.

15 Click the Next button.

16 In the Directory Name field, enter the directory name where the 
CSV file is present in the device.

Wildcard support is available for this field. In general, the FPM 
operational measurement (OM) files resides in 
“/var/mcp/oss/om/MCP_4.0/<fault-performance manager 
instance id>/<network element instance id>/<file format option 
name>” folder.

Example
“/var/mcp/oss/om/MCP_4.0/FPM1_0/*/csv-file" where * is a 
wildcard representing “network element instance ID”.

If the FPM is in duplex mode, then, the performance data 
collection jobs should continue and the OM files should be 
collected from the currently active physical unit IP. The OM 
directory path for the two physical units are different and hence 
when a SWACT takes place in the FPM host, the directory from 
which the OM files should be collected will differ. As only one 
path can be given when configuring the FPM, the wildcard * can 
be used when specifying the directory path so that the different 
directory paths in the units are handled. This way, collection of 
the OM files can happen even after a SWACT had taken place.

Example
“/var/mcp/oss/om/MCP_4.0/FPM1_*/*/csv-file”
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17 In the File Name field, enter the file mask of the CSV file present 
in the device.

Wildcard support is available for this field.

Example
If the file names start with "CSVOM" string, you can enter the 
value "CSVOM*.csv".

18 Enter the user name for FTP account in the User ID field.

19 Enter the corresponding password for FTP account in the 
Password field.

20 Click the Finish button to add the FPM.

Once the FPM is added, a message appears in the status bar of 
the wizard as in the following screen shot:

The FPM with the specified display name is added as a map 
symbol to the Element Managers topology panel.

A topology node named MCS_FPM with the parent MCS and 
FPM display name in brackets is added under the Element 
Managers topology node in the Integrated EMS tree. If the 
duplex mode is selected while adding the FPM, you can find the 
primary and secondary units added in this MCS_FPM(<MCS 
display name>:<FPM display name>) node similar to the 
following figure. 

Example
mcs8:fpm as in the following figure.

This also applies to the Web Client.
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The FPM can be added using Integrated EMS Web Client. For details, 
refer to "Adding an FPM".
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Adding a Gateway Controller Manager (GWC Manager)

Gateway Controller (GWC) Manager manages GWC NEs. This 
procedure describes how to add the GWC Manager to the topology. 
After an GWC Manager is added to the Integrated EMS topology, the 
respective NEs managed by that GWC Manager are discovered 
automatically and added under the Network Elements topology.

The following list provides the operations available for GWC Manager 
in Integrated EMS.

Tasks Supported in Integrated EMS for GWC Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security
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To add the GWC Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "GWC Mgr" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for GWC Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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8 Click the Next button.

The channel name and the administrator name are displayed in 
various fields.

9 Click the Next button.

A "No Performance Interface" message is displayed.

Note: The performance interface details for GWC NEs are 
taken by default in Integrated EMS. The default values are 
listed below:

• SNMP version = v2c

• SNMP community = public

• SNMP port = 161

10 Click the Finish button to add the GWC Manager.

Once the GWC Manager is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The GWC Manager with the specified name is added as a map 
symbol to the Element Managers topology panel. In addition, a 
topology node named GWC Manager with the specified display 
name in brackets is added under the Element Managers 
topology node in the Integrated EMS tree.

The GWC Manager can be added using Integrated EMS Web Client. 
For details, refer to Adding an GWC Manager procedure.
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Adding a Multi-Service Gateway 9000 Manager (MG 9000 Manager)

Multi-Service Gateway 9000 (MG 9000) Manager manages MG 9000 
NEs. This procedure describes how to add the MG 9000 Manager. After 
adding an MG 9000 Manager to the Integrated EMS topology, the NEs 
managed by the corresponding MG 9000 Manager are automatically 
discovered and added under the Network Elements topology.

The following list provides the operations available for MG 9000 
Manager in Integrated EMS.

Tasks Supported in Integrated EMS for MG 9000 Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security
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To add the MG 9000 Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tool-->Add-->EMS/NE menu command to invoke the 
Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "MG9K Mgr" from the Device Type list box.

6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

Centralized authentication and 
authorization (RADIUS client)

Yes (for 
version 7.0 
and 8.0)

No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for MG 9000 Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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7 Select the version of the device from the Device Version list 
box.

8 Enter the valid IP address in MG9K Mid Tier IP field. The IP 
address of the Mid Tier existing between Integrated EMS and 
MG 9000 Manager must be provided here.

9 Click the Next button.

The channel name and the administrator name are displayed in 
various fields.

10 Enter the valid subnet value with version in the Subnet (with 
version) field as in the following table:

11 Click the Next button.

For device version 6.2 or 7.0, a "No Performance Interface" 
message is displayed.

12 Enter the user name for SFTP-PULL in the User ID field.

13 Enter the password in the Password field.

14 Click the Finish button to add the MG 9000 Manager. 

Once the MG 9000 Manager is added, a message appears in 
the status bar of the wizard as in the following screen shot:

If the device version is Do

6.2 follow step 8 to step 11 and 
step 14

7.0 follow step 8 to step 11 and 
step 14

8.0 go to step 8

Subnet Value for MG 9000 Manager in Various Version of Carrier 
VoIP

MG 9000 Manager at Version Subnet Value

SN06.2 Subnet_062

SN07 Subnet_7

SN08 Subnet_7
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The MG 9000 Manager with the specified name is added as a 
map symbol to the Element Managers topology panel. In 
addition, a topology node named MG 9000 Manager with the 
specified display name in brackets is added under the Element 
Managers topology node in the Integrated EMS tree.

The MG 9000 Manager can be added using Integrated EMS Web 
Client. For details, refer to Adding an MG 9000 Manager procedure.
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Adding a Multi-Service Data Manager (MDM)

Multi-Service Data Manager (MDM) manages Packet Voice Gateway 
7480/15000 (PVG 7480/15000) and Multiservice Switch 15000 NEs. 
This procedure describes how to add an MDM and to configure the 
MDM manager to enable communication using SSH (Secure Shell). In 
the SSH mode of communication, data transfer is secured as it is 
transmitted through the SSH tunnel. 

When an MDM is added to the topology, the corresponding PVG 
7480/15000 and MSS 15000 NEs are discovered by Integrated EMS 
and added under the Network Elements topology. For MDM 8.0, the 
corresponding MDM platforms are automatically discovered and added 
under the MDM topology (present under the Platforms topology in the 
Integrated EMS tree).

Requirements for launching MDM
The requirements for launching the MDM are as follows:

• MDM launch on a UNIX platform requires the user to log in to the 
MDM GUI Server UNIX shell. For details on how to launch the client 
GUI, refer to MDM Installer Guide, 241-6001-100.

• MDM launch on a PC requires a UNIX emulation package such as 
Exceed. For information on installing and configuring Exceed refer 
to Exceed documentation. For details of the specific command used 
to launch via Exceed, refer to MDM Installer guide, NN2416001-100 
and MDM Customization Administrator guide, NN2416001-301.

• The X11 Client launch requires X server needs to be run in the client 
machine. In the case of Solaris/Linux, Xserver runs by default. In the 
case of Windows, Hummingbird or Exceed is used as Xserver.

• To launch MDM Manager or X11 Client, the client-server IP address 
must be provisioned. Refer to "Provisioning client-server IP address 
for MDM Manager" in Launching applications for MDM of Integrated 
EMS Basics, NN10329-111.
NN10330-511   (I)SN08   Standard 02.05 March 2006



Nortel Networks Confidential65Copyright © 2006, Nortel Networks
Adding MDM using Java Web Start Client
The following list provides the operations available for MDM in 
Integrated EMS.

Tasks Supported in Integrated EMS for MDM

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

Yes (only for 
version 8.0)

No

Other applications

Launching corresponding applications Yes No
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To add the MDM to the topology, follow these steps:

At the Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching the Integrated EMS Java Web Start Client" section 
of Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command. 

The Add EMS/NE wizard is launched similar to the following 
figure:
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3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "MDM" from the Device Type list box.

6 Select the version such as 8.0 of the device from the Device 
Version list box.

7 Check the Radius Secret field to enable the RADIUS secret 
password and enter RADIUS secret password in the Radius 
Secret field.

Note 1: If the Radius Secret field is checked and the 
password is not entered, the wizard displays "Enter the radius 
secret" error.

Note 2: For MDM 8.0, the RADIUS secret password must be 
enabled and entered before providing the user name and 
password in the Configure MDM Centralized Account screen. 
Changing the order of entering the RADIUS secret password 
and MDM Centralized account details results in improper 
function of the Centralized account.

8 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

Description of Properties in Add EMS/NE Wizard

Property Description

Host Name/IP Address The field for the host name or IP address of the Element 
Manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 

If version is Do

6.2 follow step 8 to step 18 and 
step 21

7.0 follow step 8 to step 18 and 
step 21

8.0 follow step 7 to step 21
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9 Select the manager unit mode from the Mode list box.  

There are two modes to be selected based on whether the MDM 
application is to run in a simplex or duplex mode. In the simplex 
mode, MDM application is configured in one machine while in 
the duplex mode the application is configured to run in two 
machines. In the duplex mode, when the current machine is 
down, the Integrated EMS switches over to the alternate or 
secondary machine. 

10 In the Inactive Unit IP field, enter the secondary machine IP 
address in which the MDM application has to run.

Note: Do not specify the IP address with an octet, which is 
prefixed with a "zero". An IP address whose octet ranges from 
0 to 255, when prefixed with zero, such as 010, is interpreted 
as an octal number and is passed as an "8", which results in 
an invalid IP address. 

11 Click the Next button. 

12 For MDM 8.0, configure the user name and password in the 
Configure MDM Centralized Account dialog as in the following 
figure for centralized account common to all MDM devices.

Note: The user name entered in Configure MDM Centralized 
Account dialog must be a user belonging to the "emsadm"  
group.

If Mode is Do

Simplex step 11

Duplex step 10
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13 Click the OK button.

The Fault Interface window is displayed.

Note: The centralized account screen is displayed only the 
first time an MDM device is added to the Integrated EMS.

To change the centralized account user name and password at 
any time, follow these steps:

a Select the required MDM 8.0 map symbol in the Integrated 
EMS display panel.

b Right-click the map symbol and select the Change MDM 
Centralized Account menu item.

The Configure MDM Centralized Account window is invoked.

c If required, change the user name in the UserName field. 

d Change the password in the Password field. 

e Click the OK button.

14 In the Port field of the Primary panel, enter the port through 
which log messages are sent by the MDM element manager.

15 Enter the user identification in the User ID field of the Primary 
panel.

16 In the Port field of the Secondary panel, enter the port through 
which log messages are sent by the MDM element manager.

17 Enter the user identification in the User ID field of the Secondary 
panel.

18 Click the Next button.

The Performance Interface window is displayed.

Note: For the correct operation of the OM feed between the 
MDM and the IEMS, a Performance Measurement Stream 
Processor (PMSP) server must already be configured on the 
MDM workstation, and the 5-minute and 30-minute TCP port 
values on the MDM’s PMSP server must match the 5-minute 
and 30-minute port value configured on the IEMS for the 
MDM. For more information on the PMSP, refer to section 
"Performance Measurement Stream Processor (PMSP)" of 
Nortel Networks Multiservice Data Manager Server 
Reference, 241-6001-310. 

If Mode is Do

Simplex step 18

Duplex step 16
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19 Enter the port number in the Five Min Collection Port field. The 
port configured in this field is scheduled to collect data every five 
minutes from the NEs managed by the MDM application. The 
port number must match the 5-minute TCP port number 
configured for the MDM’s PMSP server. The default port is 1646.

20 Enter the port in the Thirty Min Collection Port field. The port 
configured in this field is scheduled to collect data every thirty 
minutes from the NEs managed by the MDM application. The 
port number must match the 30-minute TCP port number 
configured for the MDM’s PMSP server. The default port is 1647. 

21 Click the Finish button. This adds the MDM with the provided 
details. 

Once the MDM is added, a message appears in the status bar 
of the wizard as in the following screen shot:

Note: After the MDM is added, provision the client-server IP 
address with the procedure explained in the "Launching 
applications for MDM" of the Integrated EMS Basics, 
NN10329-111. 

The MDM with the specified name is added as a map symbol to the 
Element Managers topology. In addition, a topology node named MDM 
with the specified display name in brackets is added under the Element 
Managers topology node in the Integrated EMS tree. 

If an MDM 8.0 is added in the duplex mode then, map symbols of both 
the primary and secondary units of the MDM are displayed in the 
corresponding MDM panel, which is displayed on selecting the MDM 
node under the Element Managers node (see the following screen 
shot). The added units can be identified by their display name 
appended with Unit-0  for the primary unit and Unit-1 for the secondary 
unit as in the following screen shot. 
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All the NEs managed by the added MDM application are added as map 
symbols in the Passports topology under the Network Elements 
topology node as shown in the following screen shot. Under the 
Passports topology, the MSS 15000 NEs are added in the MSS15K 
topology and MSS NEs unknown to MDM are added in the 
MSS-Unknown topology.
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Note: For the NEs and MDM automatically discovered by MDM, the 
display name of the map symbol is appended with the parent MDM 
name in brackets.

When MDM 8.0 is added to the Integrated EMS topology, the 
corresponding MDM platforms automatically discovered and added 
under the MDM topology (present under the Platforms topology in the 
Integrated EMS tree) as shown in the following screen shot:
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Adding an SAM21 Manager

SAM21 is the acronym for Services Application Module, 21 slot. SAM 
21 Manager manages SAM21 NEs. This procedure describes how to 
add the SAM21 Manager to the Integrated EMS topology. After an 
SAM21 Manager is added to the Integrated EMS topology, the 
corresponding NEs managed by that SAM21 Manager are discovered 
automatically and added under the Network Elements topology. Also, 
the SAM21 Cards are discovered automatically and added under the 
corresponding SAM21NEs. Refer to the Viewing the SAM21 Cards 
procedure to view the SAM21 cards.

The following list provides the operations available for SAM21 Manager 
in Integrated EMS.

Tasks Supported in Integrated EMS for SAM21 Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory Yes No

Performance Management

Data collection job No No

Report job No No
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To add the SAM21 Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "SAM21 Mgr" from the Device Type list box.

Transfer job No No

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for SAM21 Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Click the Next button.

In the Syslog Details panel, a list of fields is displayed showing 
the location of various log files such as Customer Log File, Audit 
Log File, and Security Log File.

9 Click the Next button.

A "No Performance Interface" message is displayed.

Note: The performance interface details for SAM21 NEs are 
taken by default in Integrated EMS. The default values are 
listed below:

• SNMP version = v2c

• SNMP community = public

• SNMP port = 161

10 Click the Finish button to add the SAM21 Manager.

Once the SAM21 Manager is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The SAM21 Manager with the specified name is added as a map 
symbol to the Element Managers topology panel. In addition, a 
topology node named SAM21 Manager with the specified 
display name in brackets is added under the Element Managers 
topology node in the Integrated EMS tree.

The SAM21 Manager can be added using Integrated EMS Web Client. 
For details, refer to Adding an SAM21 Manager procedure.
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Adding an Universal Audio Server Manager (UAS Manager)

Universal Audio Server (UAS) Manager manages UAS NEs. This 
procedure describes how to add the UAS Manager to the topology. 
After an UAS Manager is added to the Integrated EMS topology, the 
respective NEs managed by that UAS Manager are discovered 
automatically and added under the Network Elements topology.

The following list provides the operations available for UAS Manager in 
Integrated EMS.

Tasks Supported in Integrated EMS for UAS Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security
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To add the UAS Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE dialog.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "EMS" from the Type list box.

5 Select "UAS Mgr" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for UAS Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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8 Click the Next button.

The channel name and the administrator name are displayed in 
various fields.

9 Click the Next button.

A "No Performance Interface" message is displayed.

Note: The performance interface details for UAS NEs are 
taken by default in Integrated EMS. The default values are 
listed below:

• SNMP version = v3

• User name = v3admin

• Security level = noAuthnoPriv

10 Click the Finish button to add the UAS Manager.

Once the UAS Manager is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The UAS Manager with the specified name is added as a map 
symbol to the Element Managers topology panel. In addition, a 
topology node named UAS Manager with the specified display 
name in brackets is added under the Element Managers 
topology node in the Integrated EMS tree.

The UAS Manager can be added using Integrated EMS Web Client. For 
details, refer to Adding an UAS Manager procedure.
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Adding a Centrex IP Client Manager (CICM Manager)

Centrex IP Client Manager (CICM) manages CICM NEs. This 
procedure describes how to add the CICM Manager using Integrated 
EMS Java Web Start Client.

Note: Only a single pair of CICM Manager must be added per 
Carrier VoIP network.

Required prerequisites for Integrated EMS to receive CICM fault and 
performance data

CICM Manager must be configured to send fault data to Integrated 
EMS. The CICM has a script called snmpri_configure which is used 
to configure the CICM with Integrated EMS server virtual IP address 
and port for sending the fault data to Integrated EMS; without this 
configuration, Integrated EMS receives no faults from CICM.

Required prerequisites for launching CICM Manager
The prerequisites for launching the CICM Manager are:

• CICM Manager has to be configured using SSPFS CLI tool for 
launching CICM Manager from Integrated EMS Client. For details, 
refer to ATM/IP Solution-level Configuration Management, 
NN10409-500.

• CICM Manager can be launched only in Microsoft Windows with 
default browser configured as Microsoft Internet Explorer.

Adding CICM Manager using Java Web Start client
The following list provides the operations available for CICM Manager 
in Integrated EMS.

Tasks Supported in Integrated EMS for CICM Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes
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To add the CICM Manager to the topology, follow these steps:

At Integrated EMS workstation

1 Launch Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for CICM Manager

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

Note: The host name of CICM Manager must be same as the 
host name of SAM21 Element Manager. If incorrect CICM 
Manager host name is entered, the client launch for CICM 
Manager is not launched.

4 Select "EMS" from the Type list box.

5 Select "CICM Manager" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Select the manager unit mode from the Mode list box. If "Duplex" 
mode selected, follow these steps:

9 Enter the IP address of Card B host in the Card B IP Address 
field.

10 Enter the display name of Card B host in the Card B Display 
Name field.

11 Enter the card location in the Card Location field.

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Note: In the Carrier VoIP platform HA configuration

The host name or IP is the devices primary virtual host 
name or IP.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 

If mode selected is Do

Simplex follow step 11

Duplex follow step 9
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12 Enter the IP address of Card A host in the Card A IP Address 
field.

13 Follow the step 15.

14 Enter the card location in the Card Location field.

15 Click the Next button. 

16 Enter the port (in which the EMS communicates with Integrated 
EMS) in the Port field or retain the default value as "161".

17 Enter the community in the Community field.

18 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

19 Click the Next button.

20 Refer the step 16 to step 18.

21 Click the Finish button. 

Once the CICM Manager is added, a message in the status bar 
of the wizard is shown as in the following screen shot:
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The CICM Manager with the specified name is added as map 
symbol to the Element Managers topology panel. In addition, a 
topology node named CICM Manager with the specified display 
name in brackets is added under the Element Managers 
topology node in Integrated EMS tree.

The CICM Manager can be added using Integrated EMS Web Client. 
For details, refer to Adding an CICM Manager procedure.
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Adding EMS applications

EMS applications manage elements in a network. The following 
sections describe the procedure describes how to add the EMS 
applications to the Integrated EMS topology:

• Adding a Line Maintenance application (LMM application)

• Adding a Trunk Maintenance Manager application (TMM 
application)

• Adding an OSSGate application

• Adding a Network Patch Manager application (NPM application)

• Adding a QoS Collector application (QCA)

• Adding a Synchronized Backup Restore Manager application 
(SBRM application)

• Adding an Audio Provisioning Server application (APS application)

Note: Do not specify the IP address in the client GUI or the 
command prompt UI, with an octet which is prefixed with a "zero". An 
IP address whose octet ranges from 0 to 255, when prefixed with 
zero, such as 010, is interpreted as an octal number and is passed 
as an "8", which results in an invalid IP address.
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Adding a Line Maintenance application (LMM application)

The SSPFS platform is the parent platform for the Line Maintenance 
Manager (LMM). This procedure describes how to add the LMM 
application to the Integrated EMS topology. After a LMM application is 
added to the Integrated EMS topology, it is displayed as a map symbol 
in the EMS Applications topology panel and LMM topology panel 
(present under the EMS Applications node) in the Integrated EMS 
tree.

The following list provides the operations available for LMM application 
in Integrated EMS.

Tasks Supported in Integrated EMS for LMM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms No No

Clearing alarms No No

Deleting alarms No No

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No
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To add the LMM application to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->Application menu command to 
invoke the Add Application wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "LMM" from the Device Type list box.

5 Select the version of the device from the Device Version list 
box.

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for LMM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS Application Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

7 Click the Next button. 

A message stating no fault interface for LMM application is 
displayed.

8 Click the Next button. 

A message stating no performance interface for LMM application 
is displayed.

9 Click the Finish button to add the LMM application.

Once the LMM application is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The LMM application with the specified name is added as a map 
symbol to the EMS Applications topology panel. It is also added 
to the LMM topology under the EMS Applications topology 
node in the Integrated EMS tree.

The LMM application can be added using Integrated EMS Web Client. 
For details, refer to Adding an LMM application procedure.
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Adding a Trunk Maintenance Manager application (TMM application)

The SSPFS platform is the parent platform for the Trunk Maintenance 
Manager (TMM). This procedure describes how to add the TMM 
application to the Integrated EMS topology. After a TMM application is 
added to the Integrated EMS topology, it is displayed as a map symbol 
in the EMS Applications topology panel and TMM topology panel 
(present under the EMS Applications node) in the Integrated EMS 
tree.

The following list provides the operations available for TMM application 
in Integrated EMS.

Tasks Supported in Integrated EMS for TMM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms No No

Clearing alarms No No

Deleting alarms No No

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No
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To add the TMM application to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->Application menu command to 
invoke the Add EMS Application wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "TMM" from the Device Type list box.

5 Select the version of the device from the Device Version list 
box.

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for TMM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS Application Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

7 Click the Next button. 

A message stating no fault interface for TMM application is 
displayed.

8 Click the Next button. 

A message stating no performance interface for the TMM 
application is displayed.

9 Click the Finish button to add the TMM application.

Once the TMM application is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The TMM application with the specified name is added as a map 
symbol to the EMS Applications topology panel. It is also added 
to the TMM topology under the EMS Applications topology 
node in the Integrated EMS tree.

The TMM application can be added using Integrated EMS Web Client. 
For details, refer to Adding an TMM application procedure.
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Adding an OSSGate application

The SSPFS platform is the parent platform for the OSSGate 
application. This procedure describes how to add the OSSGate 
application to the topology. After a OSSGate application is added to the 
Integrated EMS topology, it is displayed as a map symbol in the EMS 
Applications topology panel and OSSGate topology panel (present 
under the EMS Applications node) in the Integrated EMS tree.

The following list provides the operations available for OSSGate 
application in Integrated EMS.

Tasks Supported in Integrated EMS for OSSGate Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms No No

Clearing alarms No No

Deleting alarms No No

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No
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To add the OSSGate application to the topology, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->Application menu command to 
invoke the Add EMS Application wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "OSSGate" from the Device Type list box.

5 Select the version of the device from the Device Version list 
box.

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for OSSGate Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS Application Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

7 Enter the OSSGate port in the OSSGate Port field or retain the 
default value as "10023".

Note: The OSSGate port must be configured to match the 
OSSGate port configured on the CMT platform.

8 Click the Next button. 

A message stating no fault interface for the OSSGate application 
is displayed.

9 Click the Next button. 

A message stating no performance interface for the OSSGate 
application is displayed.

10 Click the Finish button to add the OSSGate application.

Once the OSSGate application is added, a message appears in 
the status bar of the wizard as in the following screen shot:

The OSSGate application with the specified name is added as a 
map symbol to the EMS Applications topology panel. It is also 
added to the OSSGate topology under the EMS Applications 
topology node in the Integrated EMS tree.

The OSSGate application can be added using Integrated EMS Web 
Client. For details, refer to Adding an OSSGate application procedure.
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Adding a Network Patch Manager application (NPM application)

The SSPFS platform is the parent platform for the Network Patch 
Manager application. This procedure describes how to add the NPM 
application to the Integrated EMS topology. After a NPM application is 
added to the Integrated EMS topology, it is displayed as a map symbol 
in the EMS Applications topology panel and NPM topology panel 
(present under the EMS Applications node) in the Integrated EMS 
tree.

The following list provides the operations available for NPM Application 
in Integrated EMS.

Tasks Supported in Integrated EMS for NPM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No
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To add the NPM Application to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->Application menu command to 
invoke the Add EMS Application wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "NPM" from the Device Type list box.

5 Select the version of the device from the Device Version list 
box.

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for NPM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS Application Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform

7 Click the Next button.

In the Syslog Details panel, the fields displays the location of 
Customer Log File, Audit Log File, and Security Log File.

8 Click the Next button.

9 Click the Finish button to add the NPM.

Once the NPM is added, a message appears in the status bar of 
the wizard as in the following screen shot:

The NPM application with the specified name is added as a map 
symbol to the EMS Applications topology panel. It is also added 
to the NPM topology under the EMS Applications topology 
node in the Integrated EMS tree.

The NPM application can be added using Integrated EMS Web Client. 
For details, refer to Adding an NPM application procedure.
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Adding a QoS Collector application (QCA)

The SSPFS platform is the parent platform for the QoS Collector 
application. This procedure describes how to add the QoS Collector 
application to the Integrated EMS topology. After an QCA is added to 
the Integrated EMS topology, it is displayed as map symbol in the EMS 
Applications topology panel and QCA topology panel (present under 
the EMS Applications node) in the Integrated EMS tree.

The following list provides the operations available for QoS Collector 
application in Integrated EMS.

Tasks Supported in Integrated EMS for QoS Collector Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No
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To add the QoS Collector application to the topology, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->Application menu command to 
invoke the Add EMS Application wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "QoS Collector" from the Device Type list box.

5 Select the version of the device from the Device Version list 
box.

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for QoS Collector Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS Application Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform

7 Click the Next button. 

In the Syslog Details panel, the list of fields displays the location 
of various log files such as Customer Log File, Audit Log File, 
and Security Log File.

8 Click the Next button. 

A message stating no performance interface for QoS Collector 
application is displayed.

9 Click the Finish button to add the QoS Collector application.

Once the QoS Collector application is added, a message 
appears in the status bar of the wizard as in the following screen 
shot:

The QoS Collector application with the specified name is added 
as a map symbol to the EMS Applications topology panel. It is 
also added to the QoS Collector topology under the EMS 
Applications topology node in the Integrated EMS tree.

The QCA can be added using Integrated EMS Web Client. For details, 
refer to Adding an QCA procedure.
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Adding a Synchronized Backup Restore Manager application (SBRM 
application)

The SSPFS platform is the parent platform for the Synchronized 
Backup Restore Manager application. This procedure describes how to 
add the Synchronized Backup Restore Manager (SBRM) application to 
the Integrated EMS topology. After an SBRM is added to the Integrated 
EMS topology, it is displayed as a map symbol in the EMS 
Applications topology panel and the SBRM topology panel (present 
under the EMS Applications node) in the Integrated EMS tree.

The following list provides the operations available for SBRM 
application in Integrated EMS.

Tasks Supported in Integrated EMS for SBRM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events or alarms No No

Clearing alarms No No

Deleting alarms No No

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No
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To add the SBRM application to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->Application menu command to 
invoke the Add EMS Application wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "SBRM" from the Device Type list box.

5 Click the Next button. 

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for SBRM Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS Application Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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In the Syslog Details panel, the list of fields displays the location 
of various log files such as Customer Log File, Audit Log File, 
and Security Log File.

6 Click the Next button. 

A message is displayed stating that there is no performance 
interface.

7 Click the Finish button to add the SBRM application.

Once the SBRM application is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The SBRM application with the specified name is added as a 
map symbol to the EMS Applications topology panel. It is also 
added to the SBRM topology under the EMS Applications 
topology node in the Integrated EMS tree.

The SBRM can be added using Integrated EMS Web Client. For details, 
refer to Adding an SBRM application procedure.
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Adding an Audio Provisioning Server application (APS application)

Integrated EMS discovers the Audio Provisioning Server application 
automatically when its corresponding APS manager is added to the 
Integrated EMS topology. Refer to the Adding an Audio Provisioning 
Server Manager (APS Manager) procedure to add an APS manager. 
The APS application is added as a map symbol in the EMS 
Applications topology panel and APS topology panel under the EMS 
Application topology node in the Integrated EMS tree.

The following table provides the operations available for APS 
application in Integrated EMS.

Tasks Supported in Integrated EMS for APS Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job No No

Report job No No

Transfer job No No
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Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for APS Application

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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Adding network elements

Integrated EMS manages the fault domain and provides a centralized 
location to access the management interfaces for the following NEs:

• Universal Signaling Point

• Passport 8600

• MS 2000

• STORM

• MAS

• Session Server

• CICM

This following procedures describes how to add the above NEs to the 
topology.

• Adding an Universal Signaling Point (USP NE)

• Adding an Ethernet Routing Switch 8600 NE

• Adding a Media Server 2000 (MS 2000 NE)

• Adding a Storage Management NE (STORM NE)

• Adding a Media Application Server (MAS NE)

• Adding a Session Server NE

• Adding a Centrex IP Client NE (CICM NE)

Note: Do not specify the IP address in the client GUI or the 
command prompt UI, with an octet which is prefixed with a "zero". An 
IP address whose octet ranges from 0 to 255, when prefixed with 
zero, such as 010, is interpreted as an octal number and is passed 
as an "8", which results in an invalid IP address.

The following NEs are auto-discovered by their corresponding 
managers:

• CS 2000 Core (managed by CS 2000 Core Manager)

• Call Agent Core (managed by CS 2000 Core Manager)

• MCS (managed by MCS Manager)

• Media Proxy (managed by MCS Manager)

• PVG 7480/15000 (managed by MDM)

• Multiservice Switch 15000 (managed by MDM)
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• GWC (managed by GWC Manager)

• MG 9000 (managed by MG 9000 Manager)

• SAM21 (managed by SAM21 Manager)

• UAS (managed by UAS Manager)

• CICM SAM21 card view (managed by CICM Manager)

• MTX NE (managed by CEM Manager)

• MSC NE (managed by CEM Manager)

• HLR NE (managed by CEM Manager)

• TRI NE (managed by CEM Manager)
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Adding an Universal Signaling Point (USP NE)

This procedure describes how to add the Universal Signaling Point 
(USP) NE to the Integrated EMS topology using the Java Web Start 
Client. The USP NE is added as a map symbol in the Network 
Elements topology panel and USP topology panel under the Network 
Elements topology node in the Integrated EMS tree.

The following list provides the operations available for USP NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for USP NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes No

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Security
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To add the USP NE to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "NE" from the Type list box.

5 Select "USP" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

For the USP NEs with device version "6.2" the client launched 
from Integrated EMS is of the type Citrix and for device version 
"7.0" is of type Java Web Start. Refer to "Launching applications 

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for USP NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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from USP NEs" of Integrated EMS Basics, NN10329-111 for 
procedure to launch USP applications.

7 Enter the client server IP address in the Client Server IP field.

8 Enter the inactive agent IP address in the Unit1 field.

9 Click the Next button. 

Note: When adding a USP NE to the Integrated EMS 
inventory the SNMP attributes (refer to step 10 to step 14) 
must align with the configuration of the USP network element. 
In addition, the manager IP address in the USP must be 
configured to forward its SNMP traps to the Integrated EMS 
Server application (the Integrated EMS Virtual IP address). 
The configuration of the SNMP attributes in the USP are 
described in the USP Security and Administration guide, 
NN10159-611 and the USP Compact Security and 
Administration guide, NN10160-611. 

10 Enter the port value "161" (in which the NE agent communicates 
with Integrated EMS) in the Port field.

11 Select the SNMP version from the Version list box. 

Note: The SNMP version must align with the version 
configured in the USP Network Element. The default SNMP 
version in the USP is V3.  

12 Retain the value "NoAuthNoPriv" for the Security Level list box.

13 Enter the value for the User name field as specified in USP 
Security and Administration guide, NN10159-61.

Note: The value for the Context name field must be left 
blank.

14 Enter the community string in the Community field.

If the device version is Do

6.2 follow step 8 to step 17 and 
step 20

7.0 follow step 7 to step 17 and 
step 20

8.0 follow step 7 to step 20

If the SNMP version is Do

v3 follow step 12 to step 13 and 
proceed to step 15

v2 proceed to step 14
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15 Click the Next button to proceed to the Standby Fault Interface 
screen in the wizard.

16 Repeat step 10 to step 14.

17 Click the Next button.

The Performance Interface panel asking for performance 
interface details is displayed.

18 Type the user name for FTP PULL in the User ID field.

19 Type the password in the Password field.

20 Click the Finish button to add the USP NE.

Once the USP NE is added, a message appears in the status bar 
of the wizard as in the following screen shot:

The USP NE with the specified name is added as a map symbol 
to the Network Elements topology panel. It is also added to the 
USP topology panel under the Network Elements topology 
node in the Integrated EMS tree.

Note: Only the active USP unit object provides an interface to 
determine the fault state of the USP. The inactive USP unit 
object status is in unknown state (map symbol has gray 
background color). The Integrated EMS dynamically detects 
when the USP unit has been swacted. When this occurs, it 
initiates alarm resync with the newly active USP unit and 
updates the state of the USP unit objects in the Integrated 
EMS Client to reflect this change in activity. When this occurs, 
the previous active unit object map is changed to unknown 
state, and the new active unit is updated to reflect the highest 
alarm state of the USP device. For the color mapping of 
various object status, refer to Significance of map symbol 
background color table of "Updating status of objects 
manually".

The USP NE can be added using Integrated EMS Web Client. For 
details, refer to Adding an USP NE procedure.
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Adding an Ethernet Routing Switch 8600 NE

Application
Use this procedure to add the Ethernet Routing Switch (ERS) 8600 NE 
to the topology.

The ERS 8600 NE is added as a map symbol in the Network Elements 
topology panel and ERS 8600 topology panel under the Network 
Elements topology node in the IEMS tree.

Adding an ERS 8600 NE using Java Web Start client
The following list provides the operations available for ERS 8600 NE in 
IEMS.

         Tasks supported in IEMS for ERS 8600 NE

Task in IEMS

Availability 

Java Web Start 
Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No
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Prerequisites 
For IEMS to receive ERS 8600 fault and performance data

ERS 8600 NEs must be configured to send fault and performance data 
to IEMS; without this configuration, IEMS receives no fault and 
performance data from ERS 8600 NEs.

For launching ERS 8600 Device Manager
ERS 8600 Device Manager must be installed on the client machine in 
order to launch the GUI. For details of how to install the Device 
Manager, refer to Installing ERS 8600 Switch Modules 312749F. 

Action

At the IEMS workstation

1 Launch the IEMS Java Web Start Client (refer to "Launching 
IEMS Java Web Start Client" of the IEMS Basics, 
NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

Yes (for version 
8.0 and 7.0)

No

Others operations

Launching corresponding applications Yes No

         Tasks supported in IEMS for ERS 8600 NE

Task in IEMS

Availability 

Java Web Start 
Client Web Client
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3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select NE from the Type list box.

5 Select ERS 8600 from the Device Type list box.

6 Select the version of the device from the Device Version list box.

7 Check the Radius Secret field to enable the RADIUS secret 
password and enter RADIUS secret password in the Radius 
Secret field.

Note: If the Radius Secret field is checked and the password 
is not entered, the wizard displays "Enter the radius secret" 
error.

8 Click the Next button. 

9 Enter the port (in which the NE agent communicates with IEMS) 
in the Port field or retain the default value as "161".

10 Enter the community in the Community field.

Note: This field must be specified for SNMP versions v1 and 
v2 alone and not for SNMP v3. 

11 Select the SNMP version from the Version list box. If you select 
v3 from Version list box, select the security level from the 
SecurityLevel list box. 

If you select the value AuthPriv from Security Level list box, 
enter the following details:

• User name

• Authentication Protocol

• Authentication Password

• Privacy Password

Description of fields in the Add EMS/NE wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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Note: Value for the Context name field need not be specified 
as that is not used by the ERS 8600 device. 

12 Click the Next button.

13 Repeat step 9 to step 11.

14 Click the Finish button to add the ERS 8600.

Once the ERS 8600 NE is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The ERS 8600 NE with the specified name is added as a map 
symbol to the Network Elements topology panel. It is also added 
to the ERS 8600 topology panel under the Network Elements 
topology node in the IEMS tree.

15 You have completed this procedure.

The ERS 8600 NE can be added using IEMS Web Client. For details, 
refer to Adding an Ethernet Routing Switch 8600 NE.
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Configuring the ERS 8600 to send events and alarms to the IEMS

Use this procedure to add an SNMP trap destination address to the 
ERS 8600 to allow for events and alarms to be sent to the IEMS server, 
including Open Shortest Path First (OSPF) events and alarms if 
applicable to your office.

Prerequisites
None

Action
Perform the steps that follow to complete this procedure.

At a web browser

1 Launch the Integrated EMS Java Web Start Client. Refer to 
procedure "Launching Integrated EMS Java Web Start Client" in 
IEMS Overview, NN10329-111.

At the IEMS GUI

2 Click on Network Elements in the IEMS topology tree.

3 Right-click on an ERS8600 map symbol and select ERS8600 
Device Manager->Open.

Note: The first time you run the Device Manager, you will 
need to specify where the executable for the Device Manager 
is located. The file you need is jdm.exe. Use the Browse 
button to locate the file, then click OK.

The Device Manager opens as shown in the figure that follows.
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4 From the Device menu, select open.

5 Enter the following information:

• the IP address for the ERS 8600 in the Device Name field

• check the v3 Enabled box

• Enter initial in the User Name field

6 Click Open.

7 Click Edit->SNMPv3->Notify Table.

8 Verify the entries for Trap are as follows:

• Tag = trapTag

• type = trap

Note: If the entries are not present, create using Insert.

9 Close the Notify Table widow.

10 Click Edit->SNMPv3->Target Table.
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11 Select the Target Params Table tab.

12 Verify the entries for TparamV1 and TparamV2 are present.

Note: If the entries are not present, create using Insert.

13 Select the Target Table tab.

The Target Table tab is displayed.

14 Click Insert.

15 Enter the following information:

• Name = <a unique name>

• TAddress = <IEMS IP Address:162>

For example 10.10.10.10:162

• TagList = trapTag

• Params = TparamV2

Note: TparamV2 must be set if you want to use V2C traps. 
You must use TparamV2 on ERS8600 3.7.0 loads and 
higher.

16 Click Insert.

17 Click Close.

18 Click Device->Exit.

19 Repeat step 3 to step 18 for each ERS 8600.
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At the ERS 8600

20 Determine if OSPF is enabled on the ERS 8600 by typing

show ip ospf info 

and pressing the Enter key.

Example response

Ospf General
RouterId: 1.1.1.2
AdminStat: enabled
VersionNumber: 2
AreaBdrRtrStatus: true
ASBdrRtrStatus: false
ExternLsaCount: 1
ExterLsaCksumSum: 29660(0x73dc)
TOSSupport: 0
OriginateNewLsas: 270
RxNewLsas: 1047
TrapEnable: false
AutoVirtLinkEnable: false
SpfHoldDownTime: 10

When the value for TrapEnable is false, OSPF events will not be 
sent to the IEMS. The value for TrapEnable must be true for 
OSPF events to be sent to the IEMS.

Note: OSPF routing must already be configured and 
enabled. If required, refer to Configuring IP Routing 
Operations, 314720-d.

21 Use the following table to determine your next step.

22 Enable OSPF by typing

config ip ospf trap enable 

and pressing the Enter key.

If the value for TrapEnable 
is

Do

false step 22

true you have completed this 
procedure
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23 Ensure OSPF is enabled on the ERS 8600 by typing

show ip ospf info 

and pressing the Enter key.

Example response

Ospf General
RouterId: 1.1.1.2
AdminStat: enabled
VersionNumber: 2
AreaBdrRtrStatus: true
ASBdrRtrStatus: false
ExternLsaCount: 1
ExterLsaCksumSum: 29660(0x73dc)
TOSSupport: 0
OriginateNewLsas: 270
RxNewLsas: 1047
TrapEnable: true
AutoVirtLinkEnable: false
SpfHoldDownTime: 10

24 Repeat step 20 to step 23 for each ERS 8600.

You have completed this procedure.
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Configuring Passport 8600 for Integrated EMS

The Passport 8600 device must be configured to establish 
communication with Integrated EMS and other management 
applications. This procedure describes how to configure the Passport 
8600 device, and is made up of the following basic steps:

At the Integrated EMS server

1 Telnet to PP860 and login.

2 Load encryption modules.

3 Configure SNMP -v3.

4 Enable SSH.

5 Disable Non-secure services.

6 Verify SSH is working and disable telnet.

7 Disable SNMPv1/v2c.

8 Change default SNMPv1 community strings.

9 Change the login passwords.

10 Save the configuration.

11 Configure Passport RADIUS.

Telnet to PP8600 and login
Telnet to login to PP8600 configuration console to configure the device. 
If the PP8600 is contained in a VLAN, telnet must be performed from 
workstation such as the Integrated EMS server.The default userid and 
password are rwa and rwa,respectively. The following configuration 
steps must be performed on the PP8600.

At the Integrated EMS server

1 Telnet the device 

telnet 47.142.126.223

**********************************************
* Copyright (c) 2004 Nortel Networks, Inc.       
*
* All Rights Reserved                            *
* Passport 8010                                  *
* Software Release 3.7.0.0                       *
**********************************************

2 Login to the device with the given userid and password.

Login: rwa
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Password:***

Note: The software release level must be 3.7 or greater. After 
successful login the prompt appears as 

PP8600:5#

3 The string shown as a prefix (in this case, PP8600) is the mib-2 
object, SNMPv2-MIB:sysName.0.It can be changed with the 
following command:

config cli prompt <new-prompt>

4 Display a list of commands that are available at the current 
context by entering: 

?

It also displays a list of sub-contexts that can be entered through 
the sub-context name. This is similar to traversing a hierarchy of 
commands.The command info displays the state of current 
context and lists the available sub-contexts.The command info 
displays the state of the current context and lists the available 
sub-contexts. The state of a context is a list of attributes and 
corresponding values. Configuration is performed through the 
config context. Enter the context name

PP8600:5# config

5 Change the prompt to the following: 

PP8600:5/config#

Notes on shell cursor movement and editing

• Left and right arrow keys move the cursor backward and forward on 
the command line. 

• Up and down arrow keys moves backward and forward in the 
command stack.

• Ctrl-a moves the cursor to the beginning of the command line.

• Ctrl-e moves the cursor to the end of the command line.

• Ctrl-h is a destructive backspace.The Backspace key does nothing.

• You are always in insert mode.

• Ctrl-d is passed to telnet/ssh and closes the session.

Load encryption modules 
From the config context, enter the commands,

load-encryption-module DES
load-encryption-module 3DES
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Encryption modules must be loaded onto the PP8600 flash using ftp or 
tftp or by use of PCMCIA slot. Refer to the applicable installation guide 
for Passport 8600 Routing Switch.

If the DES encryption module is not available, then SNMPv3 –USM can 
not be configured.This means that authenticated and encrypted 
communications between OAM applications and the PP8600 are not 
available. SNMP communications can only made be through v1 or v2c 
protocols. There is no additional configuration required to get or set 
communications through v1 or v2c.

If the Triple DES (3DES) encryption module is not available, then SSH 
cannot be configured. Telnet is the only available communications 
protocol for accessing the PP8600 command line.

Configure SNMP -v3
The following tables are used to configure SNMPv3 authentication and 
privacy.

• USM table defines users, authentication/privacy protocols, and 
passwords.

• Group-Member table defines to which groups each USM user 
belongs.

• Group-Access table defines the access rights that each user has to 
the objects in the MIB tree.

• Notify table defines the types of notifications (TRAP or INFORM) 
that are sent.

• Target-Parm table defines which USM user receives a notification.

• Target-Address table defines the network managers that receive 
notifications.Each row denotes a unique manager. It has one or 
more references into the Notify table to determine the notification 
type. It also has one reference into the Target-Parm table to 
determine the user credentials used to send the notification.

• Community Table contains the Read and Write community strings 
for SNMPv1/v2c. 

Note: The Target-Param table references the CommunityTable 
for sending v1/v2c traps. 

Configure SNMP -v3

Change into the snmp-v3 context by entering the context name. 
NN10330-511   (I)SN08   Standard 02.05 March 2006



Nortel Networks Confidential125Copyright © 2006, Nortel Networks
The new prompt is displayed as

PP8600:5/config/snmp-v3#

1 Add users iems and jdm. Create a different user for each 
application such that a password change made using the JDM 
does not break the IEMS application. The SNMPv3-USM uses 
an authentication protocol and password and also a privacy 
protocol and password. Entering the command, the command 
syntax is:

usm create <user> <auth_prot> auth <pw1> priv 
<pw2>

where <auth_prot> is one of: sha | md5

a Enter the commands,

usm create iems sha auth iemspass1 priv 
iemspass2
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usm create jdm sha auth jdmpass1 priv 
jdmpass2

These two commands create the 2 users: iems and jdm with:

• authentication protocol of SHA-1 and authentication 
password of iemspass1 and jdmpass1

• privacy password of iemspass2 and jdmpass2. The 
privacy encryption protocol is DES. This is the only one 
supported by the PP8600.

The information above must be noted as it is used to 
configure both the IEMS and JDM.

Enter the command 

usm info

The current context is displayed:

User/Sec Name    Engine Id   Protocol
--------------------------------------------
iems    800008E00300E07BA7B400   HMAC_SHA, DES 
PRIVACY
initial 800008E00300E07BA7B400   NO AUTH, NO 
PRIVACY
jdm     800008E00300E07BA7B400   HMAC_SHA, DES 
PRIVACY

The user name initial is a pre-configured value for SNMPv1.

2 Add user iems to vacm. This creates the group iemsgrp and 
adds the users iems and jdm to it.The command syntax is:

group-member create <user_name> <model> 
<group_name>
where <model> is one of: snmpv1 | snmpv2c | usm

Attribute Value

User Name iems

Authentication Protocol sha

Authentication Password <user specified>

Privacy Protocol DES (only allowed value on 
PP8600)

Privacy Password <user specified>
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Enter the commands,

group-member create iems usm iemsgrp
group-member create jdm usm iemsgrp

3 Create an access control list for the iemsgrp. The empty double 
quoted string is the context name. This is equivalent to a null 
context. It is not used and not supported by the PP8600.The 
command syntax is,

group-access create <group_name> <prefix> 
<model> <level>

where:

<model> is one of: snmpv1 | snmpv2c | usm

<level> is one of: noAuthNoPriv | authNoPriv | authPriv

Enter the command,

group-access create iemsgrp “” usm authPriv 

Note: The <prefix> is saved as the context name but is not 
used in the current level of firmware.

4 Indicate the branches of the mib tree that iemsgrp is allowed to 
access.The command syntax is,

group-access view <group_name> <prefix> <level> 
read <view_name> write <view_name> notify 
<view_name>

Enter the command,

group-access view iemsgrp “” usm authPriv read 
org      write org notify org

Values for <view_name> can be seen with the command,

mib-view info

This defines the part of the mib tree that can be accessed. The 
value org specifies every object under the prefix .iso.org.

5 Add or verify the available notification types.There must be two 
pre-configured types.These can not be altered or deleted and is 
sufficient for our needs. Enter the command:

notify info

The Notify Table is displayed:

----------------------------------------------
Notify Name          Tag                 Type
----------------------------------------------
inform              informTag          inform
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Trap                 trapTag           trap

If this is not correct, then add the information using the following 
command syntax:

notify create <notify_name> tag <value> type 
<type>

where:<type> is one of: trap | inform

Enter the command,

notify create tag Inform informTag type inform
notify create tag Trap   trapTag   type trap

6 Add target address for traps. First, we must add an entry into 
target-parm.The command syntax is,

target-param create <tparm_name> mp-model 
<value> sec-level <value> sec-name <value>

where the value for:

mp-model is one of: snmpv1 | snmpv2c | usm

sec_level is one of: noAuthNoPriv | authNoPriv | authPriv

sec-name is the usm user entered in step 1. either iems or jdm

Enter the commands,

target-param create TparamV3iems mp-model usm 
sec-level authPriv sec-name iems
target-param create TparamV3jdm mp-model usm 
sec-level authPriv sec-name jdm

This creates a new row in the table with name TparmsV3iems 
referencing our iems user in the USM table. Enter the command:

target-param info

 The Notify Table is displayed:

----------------------------------------------
Target Name   MP Model Security Name   Sec Level
----------------------------------------------
TparamV1       snmpv1   readview noAuthNoPriv   
TparamV2          snmpv2c   readview noAuthNoPriv        
TparamV3iems      usm      iems    authPriv
TparamV3jdm       usm       jdm    authPriv

TparamV1 and TparamV2 are pre-configured default entries for 
SNMP v1 and v2c.They must not be deleted. 
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7 Add the ip-address of the IEMS that receives the traps. Repeat 
for each IEMS.The command syntax is,

target-addr create <target_name> <ip_addr> 
<target_parm> taglist <value>

Enter the command,

target-addr create bumrot 47.142.94.68:162 
TparamV3iems taglist    trapTag

…or…
target-addr create bumrot 47.142.94.68:162 
TparamV3jdm taglist    trapTag

This creates an entry for

• A host called bumrot.This is an arbitrary string and does not 
match the real host name. The PP8600 does not use a DNS 
to resolve the ip-address.This must be an unique value in the 
table.

• The ip-address port to receive the trap. This must also be an 
unique value in the table.

• A reference to the user who receives the trap at the specified 
ip-address.This is designated through the target-parm name 
of TparamV3iems or TparmV3jdm.

• A reference to the kind of notification to be sent. This is 
designated through the notify name of the trapTag and points 
back to the Notify Table.

Note: The <ip_addr> is the primary key in this table. A 
trap can be sent to only one user (one target_parm) on the 
specified address.This means, one cannot issue both the 
commands listed above.The second is an error indicating 
a duplicate ip address

If SNMP v1/v2c traps are being configured, enter the command 
above but specify either TparamV1 or TparamV2 as the 
<target_parm>. For example, target-addr create bumrot 
47.142.94.68:162 TparamV1 taglist trapTag

Enable SSH
Enter the config sub-context. From the config/snmp-v3 sub-context you 
can enter the context name, config, to jump to the correct context or 
enter a single period (.) to move up one context level. The new prompt 
is displayed as,

PP8600:5/config#
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Enter the following command,

bootconfig flags sshd true

sys set ssh action dsa-keygen 1024

sys set ssh action rsa-keygen 1024

sys set ssh enable

Disable Non-secure Services
From the config sub-context, enter the following commands,

bootconfig flags ftpd    false

bootconfig flags tftpd   false

bootconfig flags rlogind false

web-server disable 

Verify SSH is working and Disable telnet
Login using SSH and from the config sub-context enter,

bootconfig flags telnetd false

save bootconfig

Disable SNMPv1/v2c
Access through SNMPv1 and v2c is controlled using community 
strings. From the config/snmp-v3 context enter the command, 
community info, to display the current table.The pre-configured values 
for public and private community names are contained in the Security 
Names readview and initialview, respectively. The column designated 
as, name, is the community name string and is shown as a list of 
asterisks. The pre-configured values are “public” and “private”.

IndexName    Security Name   Transport Tag

---------------------------------------------------

first        ********        readview

second       ********        initialview
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The PP8600 does not allow pre-configured values to be deleted in most 
of the tables. It does not allow either row shown above to be deleted. It 
does, however, allow the Name field to be changed. We can change the 
public community string to some real long value, but the PP8600 is 
subjected to brute force attacks as the community name string is part 
of the SNMP PDU. 

Alternatively, if the Security Name field is altered, it can effectively 
disable SNMPv1/v2c.The Security Name field is used to access the 
GroupMember table to determine authority to access various elements 
of the MIB tree.To change the sec-name enter the commands,

snmp-v3 community secname first new-secname was 
readview

snmp-v3 community secname second new-secname 
was_initialview

Now, all v1/v2c get and set requests fail VACM access checks due to 
inability to find the Security Name in the GroupMember table.The 
PP8600 is not subjected to disruption as the Security Name is not 
included in the SNMP PDU.

Change default SNMPv1 community strings
This section is included if the DES encryption module cannot be loaded 
and SNMPv3 cannot be enabled. 

The read and write community name strings of public and private must 
be changed. From the config/snmp-v3 context enter the command, 
community info, to display the current table.The pre-configured values 
for public and private community names are contained in the Security 
Names readview and initialview, respectively.The column designated 
as, name, is the community name string and is shown as a list of 
asterisks.

Index Name    Security Name   Transport Tag

---------------------------------------------------

first        ********        readview

second       ********        initialview

To change community strings, enter the commands:

snmp-v3 community commname first new-commname 
<publicvalue>
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snmp-v3 community commname second new-commname 
<privatevalue>

Change the login passwords
Passwords are changed through the configuration context,

cli password. 

It is recommended that the passwords for the rwa and rw be changed. 
Enter the following commands and follow the prompts:

cli password rw rw

cli password rwa rwa

Save the configuration
Enter the following commands,

save bootconfig

save config

Configure Passport RADIUS
RADIUS (Remote Authentication Dial-in User Service) provides a high 
degree of security against unauthorized access to the Passport 8600 
switch. It is based on a client- server architecture allowing a number of 
communication servers and clients to authenticate users identity 
through a central database.

The Passport 8600 switch operates as a client of RADIUS.The switch 
is responsible for passing user information to the designated RADIUS 
servers. Since the Passport switch operates in a LAN environment, 
user access is allowed via Telnet, Rlogin, and Console log-in. When the 
Passport switch is configured with radius enable, any user of the switch 
presents an authentication information in the form of customized login 
prompt and password. Once authentication process meets all the 
criteria set in the radius server and switch configuration, the user is 
permitted to access the switch. If there’s no match in any part of the 
criteria, then the user is rejected and denied access to the switch.

To enable RADIUS on Passport switch

1 From the CLI, type

config radius enable 

2 From JDM, from the pull down menu, click on Edit ->security -> 
radius global -> enable.
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To create a RADIUS server entry

1 From CLI, type 

config radius server create <ip address of the 
radius server> secret <the shared secret defined 
in the server for this switch> port <what udp 
port will be used, matching the radius server’s 
udp port configuration> 

2 From JDM, from the pull down menu, click on Edit -> security -> 
radius server -> insert. You can just fill in the blanks with the 
necessary information like the IP address of the radius server 
and secret key.

To assign the order of which radius server will authenticate the 
client first:

1 From CLI, type 

set <IP address of the server> priority <choose 
a value from 1 to 10> 

The set value of 1 in the priority filed defines the first server to 
provide authentication.

Other default radius server parameters can be change by using 
the “set” command:

1 From CLI, type  

config radius server set <ip of server> field to 
be changed <value>

2 From JDM, click on Edit -> security -> radius server -> then edit 
the desired parameter.

An Example:

RTPU_PP8600:6/config/radius/server# create 
47.142.106.225 secret nortelnetworks port 1812

RTPU_PP8600:6/config/radius/server# info Sub-Context:

Sub-Context:
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Current Context:

delete : N/A

set : N/A        

RTPU_PP8600:6/config/radius/server# set 
47.142.106.225 usedby cli priority 1 

RTPU_PP8600:6/config/radius/server# info            

Sub-Context:

Current Context:

delete : N/A

set : N/A

RTPU_PP8600:6//config/radius# enable true

create:

Name Used by  Secret Port Prio Retry Timeout Enabled

Acct-port
47.142.10

6.225

Acct-enabled
cli

source-ipno
rtelnetwork

s

1812 10 1 3 true

create:

Name Used by  Secret   Port Prio Retry Timeout Enabled

Acct-port4
7.142.106

.225

Acct-ena
bledcli

source-ipno
rtelnetwork

s

1812 10 1 3 true
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Adding a Media Server 2000 (MS 2000 NE)

The Media Server 2000 NE can be managed using Integrated EMS by 
adding them to the Integrated EMS topology. The MS 2000 NE includes 
the MS 2010 and MS 2020 NEs. The MS 2000 NE is added as a map 
symbol in the Network Elements topology panel and MS2000 topology 
panel under the Network Elements topology node in the Integrated 
EMS tree.

The following list provides the operations available for MS 2000 NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for MS 2000 NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms (incremental 
resync supported)

Yes No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No
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To add the MS 2000 NE to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "NE" from the Type list box.

5 Select "MS2000" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for MS 2000 NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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7 Enter the Web server user name in the User Name field.

8 Enter the Web server password in the Web Password field.

9 Click the Next button. 

10 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

11 Enter the community in the Community field.

12 Enter the write community in the Write Community field.

13 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

14 Click the Next button to proceed to the Performance Interface 
screen in the wizard.

15 Repeat step 10 to step 13 excluding the step 12.

16 Click the Finish button to add the MS 2000 NE. 

Once the MS 2000 is added, a message appears in the status 
bar of the wizard as in the following screen shot:
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The MS 2000 NE with the specified name is added as a map 
symbol to the Network Elements topology panel. It is also 
added to the MS2000 topology panel under the Network 
Elements topology node in the Integrated EMS tree.

The MS 2000 can be added using Integrated EMS Web Client. For 
details, refer to Adding an MS 2000 NE procedure.
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Adding a Storage Management NE (STORM NE)

STORM is the acronym for STORage Management Card. STORM NEs 
can be managed using Integrated EMS by adding them to the 
Integrated EMS topology. This procedure describes how to add the 
STORM NE to the topology.

Note: STORM-Integrated EMS integration is not supported with the 
STORM dotHill configuration. The dotHill version of the STORM 
device does not have an SNMP agent to forward or read the faults 
from the STORM device. Integrated EMS integration is only 
supported with the new STORM-XTS configuration.

Required prerequisites for Integrated EMS to receive STORM fault 
and performance data

STORM must be configured to send fault data to Integrated EMS. The 
STORM has a tool called commish which is used to configure the 
STORM with Integrated EMS server virtual IP address and port for 
sending the fault data to Integrated EMS; without this configuration, 
Integrated EMS receives no fault data from STORM. For details, refer 
to Configuring STORM for Integrated EMS procedure.

Required prerequisites for launching STORM Manager
STORM has to be configured using SSPFS CLI tool for launching 
STORM manager from Integrated EMS Client. For details, refer to 
ATM/IP Solution-level Configuration Management, NN10409-500.

Adding STORM NE using Java Web Start Client
The following list provides the operations available for STORM NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for STORM NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes
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To add the STORM NE to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms Yes Yes

Deleting alarms Yes Yes

Resynchronizing alarms (incremental 
resync supported)

Yes No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for STORM NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "NE" from the Type list box.

5 Select "STORM" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Click the Next button. 

8 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

9 Select the SNMP version "v3" from the Version list box.

10 Select the security level from SecurityLevel list box. If the value 
"NoAuthNoPriv" is selected from the SecurityLevel list box, enter 
the following details:

• User name (default STORM user name is v3admin)

• Context name

If the value "AuthNoPriv" is selected from SecurityLevel list box, 
enter the following details:

• User name (default STORM user name is v3admin)

• Context name

• Authentication Protocol

If the value "AuthPriv" is selected from SecurityLevel list box, 
enter the following details:

• User name (default STORM user name is v3admin)

• Context name

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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• Authentication Protocol

• Privacy Password

11 Click the Next button to proceed to the Performance Interface 
screen in the wizard.

12 Repeat step 8 to step 9.

13 Click the Finish button to add the STORM. 

Once the STORM is added, a message appears in the status bar 
of the wizard as in the following screen shot:

The STORM NE with the specified name is added as a map 
symbol to the Network Elements topology panel. It is also 
added to the STORM topology panel under the Network 
Elements topology node in the Integrated EMS tree.

The STORM can be added using Integrated EMS Web Client. For 
details, refer to Adding a STORM NE procedure.
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Configuring STORM for Integrated EMS

Use this procedure to configure a STORM SAM-XTS unit to forward 
STORM fault information to an Integrated EMS. This procedure 
requires administrator privilege.

At Integrated EMS workstation

1 Log in to the STORM SAM-XTS unit as the root user by right 
clicking on the STORM icon and selecting Launch Command 
Line from the context menu.

A console window opens and prompts for a user name. Enter 
root and press the Return key. Enter the root user password at 
the next prompt, and press the Return key.

2 Start the commissioning shell:

> commish 

The screen clears and a console menu application starts.

Note: If the screen is garbled, press Ctrl+c to exit the 
application, enter export TERM=vt100, press Return, and 
start the commish tool again.

       System Setup, Copyright 2002 Nortel Networks, All Rights Reserved
------------------------------------------------------------------------
Setup Stages  |
              | Introduction to System Setup
 Introduction |---------------------------------------------------------
 Hostname     |
 IPAddress    |    Welcome to the system setup tool.
 Netmask      |
 Gateway      |
 Timezone     |
 NTP          |
 Logs         |
 SNMP         |
 Applications |
 Summary      |
              |
              |     ---------                                    ----------
              |     | Abort |                                    | Next>> |
              |     ---------                                    ----------
              
|-----------------------------------------------------------------
              |This tool will help you to bring this server into service.
              |Use the <TAB> key to move and select fields
              |and the <ENTER> key to confirm the selection
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3 Press the Return key to accept the existing datafill until the menu 
advances to the SNMP menu option.

4 On the SNMP menu screen, enter the IP address and port 
number of Integrated EMS server application and the SNMP 
user name provisioned at Integrated EMS server application.

SNMP menu option screen

Note: Trap destination should be set to the Integrated EMS 
virtual IP address. The default trap destination port is 162.

5 Press the Return key to accept the SNMP provisioning, and 
continue pressing the Return key to advance to the Summary 
menu option screen.

6 On the Summary option menu screen, use the tab key to position 
the cursor on the Finish button and then press the Return key to 
commit the provisioning. A reboot is not required.

       System Setup, Copyright 2002 Nortel Networks, All Rights Reserved
-------------------------------------------------------------------------
Setup Stages  |
              | Configure the SNMP Trap destinations (optional)
 Introduction |----------------------------------------------------------
 Hostname     |
 IPAddress    |    Please enter up to 2 SNMP trap destinations 
'ipaddr<:port>'
 Netmask      |
 Gateway      |     Trap destination 1
 Timezone     |       []                 
 NTP          |     Trap destination 2
 Logs         |       []                
 SNMP         |     SNMPv3 User Name (eg: v3admin)
 Applications |       []       
 Summary      |
              |
              |     ----------                                   ----------
              |     | <<Back |                                   | Next>> |
              |     ----------                                   ----------
              
|-----------------------------------------------------------------
              | Please specify up to 2 destination IP addresses and ports
              | which you want receive SNMP traps. eg: 192.168.5.4:9999
              | Also specify the SNMPv3 user name to use for traps/gets
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Adding a Media Application Server (MAS NE)

This procedure describes how to add the Media Application Server 
(MAS) NE to the Integrated EMS topology. The MAS NE is added as a 
map symbol in the Network Elements topology panel and MAS 
topology panel under the Network Elements topology node in the 
Integrated EMS tree.

Required prerequisites for Integrated EMS to receive MAS fault and 
performance data 

MAS must be configured to send fault data to Integrated EMS; without 
this configuration, Integrated EMS receives no fault and performance 
data from MAS NEs.

Adding an MAS NE using Java Web Start client
The following list provides the operations available for MAS NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for MAS NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes No

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory No No

Performance Management
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To add the MAS NE to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for MAS NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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4 Select "NE" from the Type list box.

5 Select "MAS" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Click the Next button. 

8 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

9 Enter the community in the Community field.

10 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

11 Click the Next button to proceed to the Performance Interface 
screen in the wizard.

12 Enter the directory name where the CSV file is getting pushed in 
Integrated EMS Server from the device in the Directory Name 
field.

13 Enter the file mask of the CSV file getting pushed in the File 
Name field.

Wildcard support is available for this field.

Example
If the file names starts with "SystemOMs" string, user can 
enter the value "SystemOMs*.csv".
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Note: It must be ensured while configuring each MAS device 
that the operational measurement (OM) file names are 
unique. This is useful to differentiate data transmitted from 
each of the devices. 

14 Click the Finish button to add the MAS NE.

Once the MAS NE is added, a message appears in the status 
bar of the wizard as in the following screen shot:

The MAS NE with the specified name is added as a map symbol 
to the Network Elements topology panel. It is also added to the 
MAS topology panel under the Network Elements topology 
node in the Integrated EMS tree.

The MAS NE can be added using Integrated EMS Web Client. For 
details, refer to Adding an MAS NE procedure.
NN10330-511   (I)SN08   Standard 02.05 March 2006



Nortel Networks Confidential149Copyright © 2006, Nortel Networks
Adding a Session Server NE

This procedure describes how to add the Session Server NE to the 
Integrated EMS topology. The Session Server NE is added as a map 
symbol in the Network Elements topology panel and Session Server 
topology panel under the Network Elements topology node in the 
Integrated EMS tree.

Required prerequisites for Session Server to receive fault and 
performance data

Session Server NE must be configured to send fault and performance 
data to Integrated EMS; without this configuration, Integrated EMS 
receives no fault and performance data from Session Server NEs.

Required prerequisites for launching Session Server
Session Server NE has to be configured using SSPFS CLI tool for 
launching Session Server from Integrated EMS Client. For details, refer 
to ATM/IP Solution-level Configuration Management, NN10409-500.

Adding a Session Server NE using Java Web Start client.
The following list provides the operations available for Session Server 
NE in Integrated EMS.

Tasks Supported in Integrated EMS for Session Server NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management

Viewing associated events or alarms Yes No

Clearing alarms No No

Deleting alarms Yes Yes
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To add the Session Server NE to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

Resynchronizing alarms Yes No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for Session Server NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "NE" from the Type list box.

5 Select "Session Server" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the device mode from the Mode list box.

8 Click the Next button to proceed to the Fault Interface screen in 
the wizard. 

9 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

10 Enter the community in the Community field.

11 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
Integrated EMS Configuration Management



Nortel Networks Confidential152Copyright © 2006, Nortel Networks
If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

12 Click the Next button to proceed to the Performance Interface 
screen in the wizard.

13 Repeat step 9 to step 11.

14 Click the Finish button to add the Session Server.

Once the Session Server is added, a message appears in the 
status bar of the wizard as in the following screen shot:

The Session Server NE with the specified name is added as a 
map symbol to the Network Elements topology panel. It is also 
added to the Session Server topology panel under the Network 
Elements topology node in the Integrated EMS tree.

The Session Server NE can be added using Integrated EMS Web 
Client. For details, refer to Adding a Session Server NE procedure.
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Adding a Centrex IP Client NE (CICM NE)

Centrex IP Client NE (CICM NE) is managed by CICM Manager. This 
procedure describes how to add the CICM NE. The CICM NE is added 
as a map symbol in the Network Elements topology panel and CICM 
topology panel under the Network Elements topology node in the 
Integrated EMS tree.

Required prerequisites for Integrated EMS to receive CICM fault and 
performance data

CICM Manager must be configured to send fault data to Integrated 
EMS. The CICM has a script called snmpri_configure which is used 
to configure the CICM with Integrated EMS server virtual IP address 
and port for sending the fault data to Integrated EMS; without this 
configuration, Integrated EMS receives no faults from CICM.

Required prerequisites for launching CICM Manager
The prerequisites for launching the CICM Manager are:

• CICM Manager has to be configured using SSPFS CLI tool for 
launching CICM Manager from Integrated EMS Client. For details, 
refer to ATM/IP Solution-level Configuration Management, 
NN10409-500.

• CICM Manager can be launched only in Microsoft Windows with 
default browser configured as Microsoft Internet Explorer.

Adding CICM NE using Java Web Start Client 
The following list provides the operations available for CICM NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for CICM NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status Yes No

Managing or unmanaging the object Yes Yes

Fault Management
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To add the CICM NE to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Tools-->Add-->EMS/NE menu command to invoke 
the Add EMS/NE wizard.

Viewing associated events or alarms Yes No

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms Yes No

Resynchronizing inventory Yes No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Others operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for CICM NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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3 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

4 Select "NE" from the Type list box.

5 Select "CICM" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the NE unit mode from the Mode list box. If "Duplex" 
mode selected, follow these steps:

a Enter the inactive unit IP in the Inactive Unit IP field,

b Enter the Card B IP address in the Card B IP Address field.

c Enter the Card B display name in the Card B Display Name 
field.

8 Enter the card location in the Card Location field.

Note: The card location entered while adding the 
corresponding CICM Manager must be provided in the Card 
Location field for CICM NE.

9 Click the Next button to proceed to the Fault Interface screen in 
the wizard. 

10 Enter the port (in which the EMS communicates with Integrated 
EMS) in the Port field or retain the default value as "161".

11 Enter the community in the Community field.

12 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 

Description of fields in Add EMS/NE Wizard

Field Description

Host Name/IP Address The field for the host name or IP address of the Element 
NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

13 Click the Next button to proceed to the Performance Interface 
screen in the wizard.

14 Repeat step 10 to step 12.

15 Click the Finish button to add the CICM NE. 

Once the CICM NE is added, a message appears in the status 
bar of the wizard as in the following screen shot:

The CICM NE with the specified name is added as a map symbol 
to the Network Elements topology panel. In addition, a topology 
node named CICM NE with the specified display name in 
brackets is added under the Network Elements topology node 
in the Integrated EMS tree.

The CICM NE can be added using Integrated EMS Web Client. For 
details, refer to Adding an CICM NE procedure.
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Adding CS 2000 Core and Call Agent Core NEs

Integrated EMS discovers the CS 2000 Core and Call Agent Core NEs 
automatically when its corresponding CS 2000 Core manager is added 
to the Integrated EMS topology. Refer to Adding a Communication 
Server 2000 Core Manager (CS 2000 Core Manager) procedure to add 
a CS 2000 Core Manager. The CS 2000 Core and Call Agent Core NEs 
are added as map symbol in the Network Elements topology panel. 
Also, CS 2000 Core and Call Agent Core NEs are added as map 
symbol in CS 2000 Core and Call Agent Core topology panel 
respectively under the Network Elements topology node in the 
Integrated EMS tree. When the Call Agent Core NE is added, the 
corresponding Call Agent platform is discovered automatically. The Call 
Agent platform is added in the Call Agent Platform topology node 
(under the Networks Elements-->Call Agent Core node) in the 
Integrated EMS tree.

Note: As CS 2000 Core and Call Agent Core are managed by CS 
2000 Core manager, the CS 2000 Core and call agent core event 
correlation is against the cs2k core manager.

The following list provides the operations available for CS 2000 Core 
and Call Agent Core NEs in Integrated EMS.

Tasks Supported in Integrated EMS for CS 2000 Core and Call Agent Core NEs

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events No No

Clearing alarms No No

Deleting alarms No No
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Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for CS 2000 Core and Call Agent Core NEs

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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Adding MCS and Media Proxy NEs

Integrated EMS discovers the MCS (or MCS/CSE) and Media Proxy 
NEs automatically when its corresponding MCS manager is added to 
the Integrated EMS topology. Refer to Adding a Multimedia 
Communication Server Manager (MCS Manager) procedure to add an 
MCS Manager. The MCS or Media Proxy NEs are added as a map 
symbols in the Network Elements topology panel. Also, MCS or Media 
Proxy NEs are added as a map symbols in MCS/CSE IX or Media 
Proxy topology panel respectively under the Network Elements 
topology node in the Integrated EMS tree.

Prerequisites for Integrated EMS to receive MCS fault and 
performance data

MCS must be configured to send fault and performance data to 
Integrated EMS. Without this configuration, Integrated EMS receives no 
fault and performance data from Session Server NEs.

Tasks supported by Integrated EMS for MCS and Media Proxy NE 
objects.

The following list provides the operations available for MCS and Media 
Proxy NEs in Integrated EMS.

Tasks Supported in Integrated EMS for MCS and Media Proxy NEs

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes
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Note: The resync of alarms is supported through the MCS manager.

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for MCS and Media Proxy NEs

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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Adding an GWC NE

Integrated EMS discovers the GWC NE automatically when its 
corresponding GWC manager is added to the Integrated EMS topology. 
Refer to Adding a Gateway Controller Manager (GWC Manager) 
procedure to add a GWC manager. The GWC NE are added as map 
symbols in the Network Elements topology panel. Also, GWC NE are 
added as map symbols in GWC topology panel under the Network 
Elements topology node in the Integrated EMS tree.

The following list provides the operations available for GWC NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for GWC NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No
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Note: The resync of alarms is supported through the GWC 
manager.

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for GWC NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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Adding an MG 9000 NE

Integrated EMS discovers the MG 9000 NE automatically when its 
corresponding MG 9000 manager is added to the Integrated EMS 
topology. Refer to the Adding a Multi-Service Gateway 9000 Manager 
(MG 9000 Manager) procedure to add a MG 9000 manager. The MG 
9000 NE are added as map symbols in the Network Elements 
topology panel. Also, MG 9000 NE are added as map symbols in MG 
9000 topology panel under the Network Elements topology node in the 
Integrated EMS tree.

The following list provides the operations available for MG 9000 NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for MG 9000 NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No
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Note: The resync of alarms is supported through the MG 9000 
manager.

Updating RADIUS secret password

To update the RADIUS secret password for MG 9000 NE objects 
8.0, follow these steps:

At Integrated EMS workstation

1 Select the Network Elements topology panel in the Integrated 
EMS tree. 

2 Right-click the Passport 8600 map symbol and select Update 
Radius secret menu item.

The Radius Secret Configuration window is invoked.

3 Enable the Radius Secret field and type the RADIUS secret 
password in the text field.

4 Click the Modify button.

5 Click the Close button to close the Radius Secret Configuration 
window.

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

Yes (only for 
version 8.0)

No

Other operations

Launching corresponding applications No No

Tasks Supported in Integrated EMS for MG 9000 NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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Adding PVG 7480/15000 and MSS 15000 NEs

Integrated EMS discovers the Passport NEs (such as PVG 7480/15000 
and MSS 15000 NEs) automatically when its corresponding MDM is 
added to the Integrated EMS topology. To add an MDM, refer to Adding 
a Multi-Service Data Manager (MDM) procedure. The Passport NEs 
are added as map symbols in the Network Elements topology panel. 
Also, Passport NEs are added as map symbols in PVG 7480/15000 and 
MSS 15000 topology panel respectively under the Passports node of 
Network Elements topology node in the Integrated EMS tree as in the 
following screen shot. Under the Passports topology, the MSS 15000 
NEs are added in the MSS15K topology and MSS NEs unknown to 
MDM are added in the MSS-Unknown topology.

Note: For the NEs and MDM automatically discovered by MDM, the 
display name of the map symbol is appended with the parent MDM 
name in brackets.
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The following list provides the operations available for PVG 7480/15000 
and MSS 15000 NEs in Integrated EMS.

Note: The resync of alarms is supported through the MDM.

Tasks Supported in Integrated EMS for PVG 7480/15000 and MSS 15000 NEs

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job No No

Report job No No

Transfer job No No

Configuring thresholds No No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No
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Adding an SAM21 NE

Integrated EMS discovers the SAM21 NE automatically when its 
corresponding SAM21 manager is added to the Integrated EMS 
topology. Refer to Adding an SAM21 Manager procedure to add a 
SAM21 manager. The SAM21 NEs are added as map symbols in the 
Network Elements topology panel. Also, SAM21 NEs are added as 
map symbols in SAM21 topology panel under the Network Elements 
topology node in the Integrated EMS tree.

The following list provides the operations available for SAM21 NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for SAM21 NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No
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Note: The resync of inventory is supported through the SAM21 
manager.

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for SAM21 NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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Adding an UAS NE

Integrated EMS discovers the UAS NE automatically when its 
corresponding UAS manager is added to the Integrated EMS topology. 
Refer to Adding an Universal Audio Server Manager (UAS Manager) 
procedure to add a UAS manager. The UAS NEs are added as map 
symbols in the Network Elements topology panel. Also, UAS NEs are 
added as map symbols in UAS topology panel under the Network 
Elements topology node in the Integrated EMS tree.

The following list provides the operations available for UAS NE in 
Integrated EMS.

Tasks Supported in Integrated EMS for UAS NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client

Configuration Management

Editing object properties Yes Yes

Updating status No No

Managing or unmanaging the object No No

Fault Management

Viewing associated events or alarms Yes Yes

Clearing alarms No No

Deleting alarms Yes Yes

Resynchronizing alarms No No

Resynchronizing inventory No No

Performance Management

Data collection job Yes No

Report job Yes No

Transfer job Yes No
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Note: The resync of alarms is supported through the UAS manager.

Configuring thresholds Yes No

Security

Centralized authentication and 
authorization (RADIUS client)

No No

Other operations

Launching corresponding applications Yes No

Tasks Supported in Integrated EMS for UAS NE

Task in Integrated EMS

Availability 

Java Web 
Start Client Web Client
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Editing properties of objects

The following properties of an object can be modified after they are 
added to the topology.

• Display name

• Managed or Unmanaged

• Time zone

• Poll interval

• Fault interface and performance interface details, such as port, user 
ID, community (only applicable to the element manager and NE 
objects).

The following procedures describe how to edit the above properties for 
an object in Integrated EMS Client. 

• Editing platform object properties

• Editing element manager object properties

• Editing EMS application object properties

• Editing NE object properties

To edit the properties of an object, follow these steps:

At a topology screen of Integrated EMS Client

1 Launch the Object Properties wizard.

2 Edit the EMS/NE details listed below

• Display name

• Managed/Unmanaged

• Time zone

• Poll interval

Note: step 3 to step 6 are applicable only to element 
managers and NEs.

3 Click the Next button.

4 Modify the fault interface details if required.

5 Click the Next button.

6 Modify the performance interface details if required.

7 Click the Modify button to modify the object properties.
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When successfully updated, the status bar of Integrated EMS 
Client main screen displays “Successfully updated to database”.

If the EMS/NE details are not updated in the topology, a 
message appears in the status bar of the wizard as shown in the 
following screen shot. 

Note: The modified or deleted object name and its IP address 
can be viewed in the log messages displayed in the Security 
Log window invoked through the Tools menu command.
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Editing platform object properties

After adding an EMS platform to Integrated EMS, the added EMS 
platform object properties can be modified. This procedure describes 
how to edit the properties of the following EMS platforms:

• SSPFS

• MDM

Note: Only the Display Name property for the SDM platform can be 
modified. To edit the display name, double-click the required SDM 
platform map symbol and change the name and click the Modify 
button.

Editing platform object properties

To edit the platform object properties in Integrated EMS, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the EMS Platforms panel under the Integrated EMS tree 
in which the required map symbol is shown.

3 Select the required platform map symbol in the EMS Platforms 
panel and double-click to launch the Object Properties wizard.

4 Edit the following properties if required. For description of the 
properties, refer to the following table:

Description of fields in Object Properties Wizard for platform objects

Field Description

Display Name The name displayed in the topology for the map symbol.

Managed Indicates whether the object is managed or unmanaged.

IP-Address The IP address of the platform host.

Note: If the IP address is modified and updated, Integrated 
EMS deletes the existing details of the platform object and 
adds new object with details provided in the Object Properties 
wizard screen.
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5 Click the Modify button to modify the platform object properties. 

Once the platform object properties is updated in topology, a 
message appears in the status bar of the wizard as in the 
following screen shot:

Up-versioning the platform objects
The platform objects can be upgraded to higher versions using the 
following procedure. For platforms supporting the Centralized 
authentication and authorization (RADIUS client), the following 
procedure explains the steps for up-versioning.

To upgrade platform managed objects to a higher version, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the EMS Platforms topology panel in the Integrated EMS 
tree. 

3 Select the required map symbol and double-click to invoke the 
Managed Object Properties Wizard.

4 Change the version of the platform to a higher version from the 
Version list box. 

Time Zone The time zone associated with the Host Name or IP Address 
provided.

Device Version The version of platform.

Poll Interval The Poll Interval for status updates and the interval to check 
whether the host is active or not. This field not editable for 
SN06.2 SSPFS platform objects. The poll interval value must 
be in the range 30 to 3600 or 0. If the value 0 is specified, the 
polling is disabled, and the status of the object can be updated 
using Updating status of objects manually.

Description of fields in Object Properties Wizard for platform objects

Field Description
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5 Click the Modify button to modify the manager object properties. 

After upgrading the version of SSPFS objects from 6.2 or 7.0 to 8.0, 
follow these steps:

At Integrated EMS workstation

1 Select the EMS Platforms topology panel in the Integrated EMS 
tree. 

2 Right-click the SSPFS map symbol and select Update Radius 
secret menu item.

The Radius Secret Configuration window is invoked.

3 Enable the Radius Secret field and type the RADIUS secret 
password in the text field.

4 Click the Modify button.

5 Click the Close button to close the Radius Secret Configuration 
window.
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Editing element manager object properties

After adding a Nortel Networks Element Manager to Integrated EMS, 
you can modify the Element Manager object properties. This procedure 
describes the how to edit the Element Manager object properties of the 
following element managers:

• APS manager

• CS 2000 Core Manager

• CEM

• MCS Manager

• FPM

• GWC Manager

• MG 9000 Manager

• MDM

• SAM21 Manager

• UAS Manager

• CICM Manager

Note 1: step 5 and step 6 in the following procedure are applicable 
to following element manager objects.

• CS 2000 Core Manager

• MG 9000 Manager

• MDM

step 7 and step 8 are applicable only to MG 9000 Manager and 
MDM.

Note 2: The version of MCS Manager 8.0 cannot be modified to 7.0 
or the other way round. If you want to upgrade the version of MCS 
Manager 7.0 to 8.0, delete the MCS Manager 7.0 and add a MCS 
Manager 8.0 with the same details.

Note 3: After adding an MCS Manager, the fault interface and 
performance details are associated to corresponding physical SM 
servers which are added in the MCS SM(XXX) node (MCS SM node 
with the parent MCS Manager display name) under the Element 
Managers topology. Hence the fault interface and performance 
details cannot be modified for MCS Manager map symbol in the 
Element Managers topology. It can be modified only for 
corresponding physical SM servers in MCS SM(XXX) node. If you try 
NN10330-511   (I)SN08   Standard 02.05 March 2006



Nortel Networks Confidential177Copyright © 2006, Nortel Networks
to edit the managed object properties of an MCS Manager, the Next 
button is disabled in Object Properties wizard.

Editing the element manager managed object properties

To edit an element manager object properties in Integrated EMS, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Element Managers topology panel in the Integrated 
EMS tree. 

Note: For FPM or MCS Manager, select the corresponding 
node (MCS_FPM(<parent MCS display name>:<FPM display 
name>)  or MCS SM(XXX) node, where XXX is the display 
name) under the Element Managers topology.

3 Select the required map symbol and double-click to invoke the 
Managed Object Properties Wizard.

4 Edit the following properties if required. The description of the 
properties is shown in the following table.

Field Description

Display Name The name displayed in the topology for the map symbol. 

Managed Indicates whether the object is managed or unmanaged

Platform Indicates the element manager to which the object belongs.

IP-Address The IP address of the element manager host.

Note: If the IP address is modified and updated, Integrated EMS 
deletes the existing details of the element manager object and 
adds a new object with details provided in the Object Properties 
wizard screen. This is not applicable for MCS Manager objects as 
only the details are updated for MCS Manager objects.

Time Zone The time zone associated with the Host Name or IP Address 
provided.
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5 Click the Next button.

6 Modify the fault interface details if required.

7 Click the Next button.

8 Modify the performance interface details if required.

9 Click the Modify button to modify the manager object properties. 

Once the manager object is updated with the provided details in 
the topology, a message appears in the status bar of the wizard 
as in the following screen shot:

Up-versioning the element manager objects
The element manager objects can be upgraded to higher versions 
using the following procedure. For element managers supporting the 
Centralized authentication and authorization (RADIUS client), the 
following procedure explains the steps for up-versioning.

To upgrade element manager managed objects to higher version, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Element Managers topology panel in the Integrated 
EMS tree.

Note: For FPM or MCS Manager, select the corresponding 
node (MCS_FPM(<parent MCS display name>:<FPM display 
name>)  or MCS_SM(XXX) node, where XXX is the display 
name) under the Element Managers topology.

Device Version The version of element manager.

Poll Interval The Poll Interval for status updates, and the interval for checking 
the connection to determine whether the host is active. If the value 
0 is specified, the polling is disabled and the status of the object 
can be updated using Updating status of objects manually.

Field Description
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3 Select the required map symbol and double-click to invoke the 
Managed Object Properties Wizard.

4 Change the version of element manager to higher version from 
the Version list box. 

5 Click the Modify button to modify the manager object properties. 

After upgrading the version of MDM or CS 2000 Manager objects from 
6.2 or 7.0 to 8.0, follow these steps:

At Integrated EMS workstation

1 Select the Element Managers topology panel in the Integrated 
EMS tree. 

2 Right-click the map symbol and select Update Radius secret 
menu item.

The Radius Secret Configuration window is invoked.

3 Enable the Radius Secret field and type the RADIUS secret 
password in the text field.

4 Click the Modify button.

5 Click the Close button to close the Radius Secret Configuration 
window.

6 Right-click the map symbol and select Change MDM 
Centralized Account menu item.

The Configure MDM Centralized Account window is invoked.

7 Type the user name in the UserName field.

Note: The user name entered in Configure MDM Centrailed 
Account window must be an user belonging to the "emsadm"  
group.

8 Type the password in the Password field.

9 Click the OK button.

If Do

MDM follow step 2 to step 9.

CS 2000 Manager follow step 2 to step 5.
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Editing EMS application object properties

After adding EMS applications to Integrated EMS, the added EMS 
application object properties can be modified. This procedure 
describes how to edit the EMS application object properties for the 
following objects:

• LMM

• TMM

• OSSGate

• NPM

• QCA

• APS

To edit an EMS application object properties in Integrated EMS, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the EMS Applications topology panel in the Integrated 
EMS tree in which the required map symbol is shown.

3 Select the required EMS application map symbol and 
double-click to invoke the Object Properties window.

4 Edit the following properties if required. 

Field Description

Display Name The name displayed in the topology for the map symbol. 

Managed Indicates whether the object is managed or unmanaged

Platform The EMS application to which the object belongs.

IP-Address The IP address of the EMS application host.

Note: If the IP address is modified and updated, Integrated EMS 
deletes the existing details of the element manager object and 
adds the new object with details provided in the Object Properties 
wizard screen.
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Note: For all EMS application type objects, the interval 
provided in the Poll Interval field is not used. 

5 Click the Modify button to modify the EMS application object 
properties. 

Once the EMS application details are updated in the topology, 
"Done" appears in the status bar of the wizard.

Time Zone The time zone associated with the Host Name or IP Address 
provided.

Device Version The version of EMS application.

Field Description
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Editing NE object properties

After adding an NE to Integrated EMS, the added NE objects properties 
can be changed. This procedure describes how to edit the properties of 
following NE objects:

• USP

• Passport 8600

• MS 2000

• STORM

• MAS

• Session Server

• CICM

Note: Only the poll interval, managed, and IP address values can be 
modified for the following automatically discovered NEs.

• CS 2000 Core

• Call Agent Core

— Call Agent Platform

• MCS

• Media Proxy 

• PVG 7480/15000

• MS 15000

• GWC 

• MG 9000

• SAM21

• UAS

Editing the NE managed object properties

To edit the NE object properties in Integrated EMS, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).
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2 Select the Network Elements topology panel in the Integrated 
EMS tree in which the required map symbol is shown.

3 Select the required NE map symbol and double-click to invoke 
the Object Properties Wizard.

4 Edit the following properties if required.

5 Click the Next button.

6 Modify the fault interface details if required.

7 Click the Next button.

8 Modify the performance interface details if required.

9 Click the Modify button to modify the NE object properties. 

Once the NE object properties is updated in topology, a 
message appears in the status bar of the wizard as in the 
following screen shot:

Field Description

Display Name The name displayed in the topology for the map symbol

Managed It indicates whether the object is managed or unmanaged

Platform The NE to which the object belongs

IP-Address The IP address of the NE host.

Note: If the IP address is modified and updated, Integrated EMS 
deletes the existing details of the NE object and adds the new 
object with details provided in the Object Properties wizard screen

Time Zone The time zone associated with the Host Name or IP Address 
provided

Device 
Version

The version of NE

Poll Interval The Poll Interval for status updates, and the interval for checking 
the connection to know whether the host is active or not. If the 
value 0 is specified, the polling is disabled, the status of the object 
can be updated using Updating status of objects manually
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Up-versioning the NE objects
The NE objects can be upgraded to higher versions using the following 
procedure. For NEs supporting the Centralized authentication and 
authorization (RADIUS client), the following procedure explains the 
steps for up-versioning.

To upgrade NE managed objects to a higher version, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Network Elements topology panel in the Integrated 
EMS tree. 

3 Select the required map symbol and double-click to invoke the 
Managed Object Properties Wizard.

4 Change the version of the NE to a higher version from the 
Version list box. 

5 Click the Modify button to modify the manager object properties. 

After upgrading the version of Passport 8600 objects from 6.2 or 7.0 to 
8.0, follow these steps:

Note: MG 9000 NE is automatically discovered by MG 9000 
Manager. When the parent MG 9000 Manager is up-versioned, the 
corresponding MG 9000 NEs are automatically updated with default 
RADIUS secret password.

At Integrated EMS workstation

1 Select the Network Elements topology panel in the Integrated 
EMS tree. 

2 Right-click the Passport 8600 map symbol and select Update 
Radius secret menu item.

The Radius Secret Configuration window is invoked.

3 Enable the Radius Secret field and type the RADIUS secret 
password in the text field.

4 Click the Modify button.

5 Click the Close button to close the Radius Secret Configuration 
window.
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Configuring and maintaining MS 2000 
devices

The MS2000 Configuration and Maintenance tool is used to configure 
and perform some configuration and maintenance activities on an MS 
2010 or MS 2020 NE. It automatically adjusts the display components, 
behavior, and configuration options based on the NE type (MS 2010 or 
MS 2020). This section describes configuration and maintenance 
operations for MS 2000 NEs:

• Configuration

— Configuring general parameters for MS 2000 NEs

— Configuring SNMP setup for MS 2000 NEs

— Configuring the passwords for the MS 2000 NEs

— Configuring automated backup of the INI file

• Maintenance

— Locking or unlocking the MS 2000 node

— Backing up the INI file

— Uploading the load files to the Integrated EMS Server

— Resetting the MS 2000 NE

User access privileges for MS 2000 NE
The user authorization required for each function is given in the 
following table:

Access Function

mg groups with any 
access

List of any configuration

mgsprov, mgrw, mgadm Change configuration

mgmtc, mgrw, mgadm Lock or unlock of device

mgmtc, mgrw, mgadm Backup of INI file

mgmtc, mgrw, mgadm Upload of load files (CMP, INI, DAT, 
XML)

mgmtc, mgrw, mgadm Soft reset of NE
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Launching the Maintenance and Configuration tool

To launch the Maintenance and Configuration tool from the 
Integrated EMS Java Web Start Client, follow these steps:

At the Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the MS 2000 topology panel under the Network 
Elements in the Integrated EMS tree in which the required map 
symbol is shown.

3 Right-click a map symbol and select the Config and 
Maintenance tool.

The Maintenance and Configuration tool is launched.

mgadm, mgrw Change SNMP passwords

mgadm, mgrw Change web interface passwords

Access Function
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Configuring general parameters for MS 2000 NEs

This procedure describes how to configure the general parameters for 
basic setup of the MS 2000 node. 

To configure the general parameters, follow these steps:

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched.

2 Click the General Configuration tab in the right side of the 
Maintenance and Configuration tool, as shown in the following 
figure.
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3 Modify the Megaco Call Agent IP address in the Megaco Call 
Agent IP Address field.

4 To indicate whether Megaco Call Agent is used, select "yes" or 
"no" from the Is Megaco Call Agent Used field.

5 Enter the number of conference ports in the Number of 
Conference Ports field.

6 Enter the number of test trunk ports in the Number of TestTrunk 
Ports field.

7 Enter the number of lawful intercept ports in the Number of 
Lawful Ports field.

8 Enter the number of announcement ports in the Number of 
Announcement Ports field.

9 Enter the APS IP address in the APS IP Address field.

10 Select the primary language from the Primary Language list 
box.

11 Select the secondary language from the Secondary Language 
list box.

12 Enter the SYSLOG Server IP address in the Syslog Server IP 
Address field.

13 Select the ATM default application type from the ATM Default 
Application Type list box.

14 Select the transmission mode from the Transmission mode list 
box.

15 Click the Set button to save the configuration changes.

If valid data is entered in the each of fields, then you are 
prompted to save the configuration changes made by backing up 
the INI file. 

If invalid data is entered, a message is displayed similar to the 
following screen shot:
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16 Click the Backup to tftp server button or Backup to IEMS 
server button. You can back up either to the Integrated EMS 
Server or to the tftp server.

Once the INI backup is done, you are prompted to perform a soft 
reset on the node to save the configuration changes to flash 
memory.

17 Click the Perform Soft Reset button.
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Configuring SNMP setup for MS 2000 NEs

This section describes the following procedures to configure the SNMP 
setup for the MS 2000 node. Once performed, the procedure allows you 
to manage the Trusted Managers table and the Trap Destination Table. 
The MS 2000 node can handle up to five entries in each of these tables. 
This section consists of two procedures:

• Configuring Trusted Managers table

• Configuring Trap Destinations table

Configuring Trusted Managers table

To configure the Trusted Managers table for MS 2000 node, follow 
these steps:

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched. 

2 Click the SNMP Setup tab in the right side of the screen.

3 Click the Trusted Managers tab. 

The Trusted Managers tab is displayed as in the following figure.
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4 Enter the manager IPs in the rows under the Trusted Managers 
column.

5 Repeat step 4 to add more trusted managers.

6 Click the Add button.

To remove a trusted manager, enter the trusted manager IP and 
click the Delete button.

Configuring Trap Destinations table

Adding trap destination

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched.

2 Click the SNMP Setup tab in the right side of the screen.

3 Click the Trap Destinations tab.

The Trap Destination tab is displayed as in the following figure.
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4 Enter the trap destination IP in the rows under the Trap 
Destinations column.

5 Enter the SNMP trap port for the corresponding trap destination 
under the Port column. 

6 Repeat step 4 and step 5 to add more trap destinations.

7 Click the Add button.

Deleting trap destination

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched.

2 Click the SNMP Setup tab in the right side of the screen.

3 Click the Trap Destinations tab. 

4 Enter the trap destination IPs in the row under the Trap 
Destinations column.

5 Enter the SNMP trap port for the corresponding trap destination 
under the Port column. 
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6 Repeat step 4 and step 5 to delete more trap destinations.

7 Click the Delete button.
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Configuring the passwords for the MS 2000 NEs

This section describes the following procedures to configure the SNMP 
read and write community strings for the MS 2000 node and the Web 
server user name and password for MS 20000 node. This section 
consists of two procedures:

• Configuring SNMP community strings

• Configuring Web server password

Configuring SNMP community strings
To configure the SNMP community strings for MS 2000 node, refer to 
the following procedures:

Configuring read community string

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched.

2 Click the Password Management tab in the right side of the 
screen.

3 Click the SNMP tab. 

The SNMP tab is displayed as shown in the following figure.
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4 Enter the same read community string in the Read String field.

5 Enter the same read community string in the Confirm field in the 
Read Community String panel.

6 Click the Change Read String button.

The read community string is updated.

Configuring write community string

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched.

2 Click the Password Management tab in the right-side of the 
screen.

3 Click the SNMP tab. 

4 Enter the write community string in the Write String field.

5 Enter the same write community string again to confirm in the 
Confirm field in the Read Community String panel.

6 Click the Change Write String button.
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The write community string is updated.

Configuring Web server password

To configure the Web server password, follow these steps:

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched.

2 Click the Password Management tab in the right side of the 
screen.

3 Click the Web Server tab. 

The Web Server tab is displayed as in the following figure.

4 Enter the login name in the Login Name field.

5 Enter the password in the Password field in the Read 
Community String panel.

6 Enter the same password in the Confirm field.
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7 Click the Change User and Password button.

The password is updated.
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Configuring automated backup of the INI file

The initialization file is a configuration data file used by the MS 2000 
system to set up the node in event of a reboot. The automated backup 
of the INI file can be configured using the Automated INI File Backup 
Configuration GUI. The INI file backup is configured based on the time 
and day you specify in the Automated INI File Backup Configuration 
tool.

Note: If the proper communication is not setup between the 
Integrated EMS and the tftp server (SDM or CBM) then the backup 
of the INI file to the tftp server fails. If file backup failures to the tftp 
server are seen and you suspect this communication has not been 
setup, refer to the "Setting up the BootP file on SSPFS".

To configure the automated backup of the initialization file, follow 
these steps:

At the Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the MS 2000 topology panel under the Network Elements 
in the Integrated EMS tree in which the required map symbol is 
shown.

3 Right-click a map symbol and select the Configure MS2000 
Automated INI Backup tool.

The Automated INI File Backup Configuration tool is launched, 
which is similar to the following figure.
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4 Check the Enable Automated INI file backup: check box to 
enable the automated INI file backup.

5 Select the start time for backup from the Automated INI Backup 
Start Time: list box.

6 Select the Daily option under Recurrence for daily backup.

OR

Select the Weekly option and select the days of the week in 
which the backup must occur.

7 Click the OK button.
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Locking or unlocking the MS 2000 node

The lock function is to prevent any audio resources from being allocated 
on the node.

 To lock the MS 2000 node, follow these steps:

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched. The 
Maintenance panel in the left side of the Maintenance and 
Configuration appears similar to the following figure:

2 Select the Graceful Lock option to lock the MS 2000 node with 
graceful lock.
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Graceful lock
A graceful lock signals to the node that a lock has been 
requested. The node then stops allocating new audio 
resources and waits for the last resource to be freed before 
actually locking the node.

OR

Select the Forced Lock option to lock the MS 2000 node with 
forced lock.

Forced lock
A forced lock causes the node to immediately free up any 
resources in use and lock the node.

3 Click the Lock button to lock the MS 2000 node.

To unlock the MS 2000 node, click the Unlock button.
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Backing up the INI file

The initialization file is a configuration data file used by the MS 2000 
system to set up the node in event of a reboot. The file contains all of 
the user-defined configuration changes. The Maintenance and 
Configuration tool allows you to save the initialization file back to the 
Integrated EMS server or to the tftp server (the SDM or CBM). By 
saving the INI file in the Integrated EMS server, you have simply saved 
a backup copy of the configuration changes for later use. The 
Maintenance and Configuration tool saves up to five initialization files 
for each node, deleting the oldest file once the maximum number of files 
have been saved. By saving the file to the tftp server, this updates the 
initialization file that the MS 2000 node retrieves and a hard reset 
occurs.

To back up the initialization file, follow these steps:

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched. The 
Maintenance panel in the left-side of the Maintenance and 
Configuration appears similar to the following figure:
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2 Select the Backup INI to IEMS Server option to save the INI file 
to the Integrated EMS server.

OR

Select the Backup INI to tftp Server option to save the INI file 
to the TFTP server.

Note: It is recommended that whenever configuration 
changes are made, back up the latest settings in an INI file to 
the tftp server.

3 Click the INI Backup button.
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Resetting the MS 2000 NE

A soft reset of the node is reinitialization of the software running on the 
MS 2000 NE. You can select either to burn configuration settings or to 
re-initialize with the previous burned settings. When a soft reset is done 
on the node with the burn option, the existing configuration settings are 
burned into flash memory and then the NE goes through an initialization 
cycle. This takes the MS 2000 NE out of service for a short period of 
time and drops any resources in use.

To reset the MS 2000 NE, follow these steps:

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched. The 
Maintenance panel in the left side of the Maintenance and 
Configuration appears similar to the following figure:
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2 Select the Burn Flash option to reset the MS 2000 NE with the 
burn option.

OR

Select the Don’t Burn Flash option to reset the MS 2000 NE 
without the burn option.

3 Click the Reset button.
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Uploading the load files to the Integrated EMS Server

The MS2000 Configuration and Maintenance tool lets the user to 
upload some of the file types used by the MS 2000 node. The files 
displayed in the tool are uploaded from the /data/loads/audiocodes 
folder of the Integrated EMS Server. The Maintenance and 
Configuration tool provides an option to remotely reload the device by 
downloading a CMP load file and an INI initialization file.

To upload the selected files to the Integrated EMS Server, follow 
these steps:

At the Integrated EMS workstation

1 Launch the Maintenance and Configuration tool. For details, 
refer to Launching the Maintenance and Configuration tool of 
Configuring and maintaining MS 2000 devices.

The Maintenance and Configuration tool is launched.

2 Click the Load Management tab in the right-side of the screen 
similar to the following figure:
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3 Select the CMP file to be reloaded and INI file which has to be 
uploaded from the first panel.

4 Click the Send Files button in the first panel.

The following dialog is displayed when you select this option:

5 Click the Yes button to reload the CMP and INI files.

6 In other panels, select the files to be uploaded from the list box 
and click the Send Files button against the list box.
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Working with CEM managed node

This section explains the following procedure to add and delete the 
CEM managed node. Refer to following procedures for details:

• Creating a CEM managed node instance

• Deleting a CEM managed node instance
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Creating a CEM managed node instance 

Application
Use this procedure to set up a managed node instance of CEM in order 
to manage network elements. Use the Commissioning Manager to 
configure CEM managed node instances. After installing the CEM 
package onto a Sun server, users need to set up managed node 
instances in order to manage network elements. The Commissioning 
Manager is used to configure coreEMS managed node instances, such 
as to create, reconfigure and delete a managed node instance. Users 
should only use the Commissioning Manager to configure managed 
node instances. Manually editing configuration files is highly 
discouraged unless the user is absolutely sure of the effect of their 
action.

Prerequisites
This procedure has the following prerequisites:

• The DMS needs an SDM/CBM with a CEM installed.

• The version of CEM on the SDM/CBM must be the same as the 
target CEM version on the Integrated EMS server.

• You must know the target SDM/CBM IP address. 

Action
Perform the following steps to complete this procedure.

At your workstation

1 Launch the CEM Commissioning Manager. See “Launching 
CEM Commissioning Manager” ofthe Integrated EMS Basics, 
NN10329-111 the Integrated EMS Basics, NN10329-111the 
Integrated EMS Basics, NN10329-111NN10329-111the 
Integrated EMS Basics, NN10329-111the Integrated EMS 
Basics, NN10329-111the Integrated EMS Basics, 
NN10329-111the Integrated EMS Basics, 
NN10329-111Integrated EMS Basics, 
NN10329-111.NN10329-111

NN10329-111
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2 Click the Node Configuration tab in the coreEMS 
Commissioning Manager window.

3 Select Create from the Command drop-down list.

4 Select the DMS device type for the new instance from the Device 
Type drop-down list.

Note: DMS is the only supported option in this configuration.

5 Enter the name of the new instance in the Element Name field.

Note: The name can be a string of up to 15 alphanumeric 
characters and the minus sign (-). The first character must be 
alphanumeric and the last character must not be a minus sign. 
The element name cannot be server, localhost, loghost, or the 
hostname of the local host.

6 Enter the target IP address in the Target SDM IP Address field. 

7 Select GEM18 from the Software Release drop-down list.
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8 Select No in the Enable Call Trace drop-down list.

Note: No is the only supported option in this configuration.

9 Select No in the Install Billing Manager drop-down list.

Note: No is the only supported option in this configuration.

10 Select No in the Does This DMS Have USP field.

Note: No is the only supported option in this configuration.

11 Click the Submit button. 

The following confirmation dialog box opens.

12 Click Yes in the confirmation dialog box. 

The following confirmation dialog box opens.

13 Click OK in the confirmation message box.

14 Click Yes.

The following dialog box opens.

15 Click Yes to start all applications of the node.

The following dialog box opens.
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16 Click OK in the confirmation dialog box.

17 Select Exit from the Exit menu to close the CEM Commissioning 
Manager window.

18 You have completed this procedure. 
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Deleting a CEM managed node instance 

Application
Use this procedure to delete a managed node instance of CEM. 

Action
Perform the following steps to complete this procedure.

At your workstation

1 Launch the CEM Commissioning Manager. See “Launching 
CEM Commissioning Manager” ofthe Integrated EMS Basics, 
NN10329-111 the Integrated EMS Basics, NN10329-111the 
Integrated EMS Basics, NN10329-111NN10329-111the 
Integrated EMS Basics, NN10329-111the Integrated EMS 
Basics, NN10329-111the Integrated EMS Basics, 
NN10329-111the Integrated EMS Basics, 
NN10329-111Integrated EMS Basics guide, 
NN10329-111.NN10329-111

NN10329-111

2 Click the Node Configuration tab in the coreEMS 
Commissioning Manager window.

3 Select Delete from the Command drop-down list.

4 Select the node to be deleted from the Element Name 
drop-down list.

5 Click the Submit button.

The following confirmation dialog box opens.

6 Click OK in the confirmation dialog box.

The following information dialog box appears.
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7 Wait until the command has completed successfully. 

The following dialog box appears.

8 Click OK in the confirmation dialog box.

The following dialog box appears.

9 Click OK to clear the message. 

10 Select Exit from the Exit menu to close the CEM Commissioning 
Manager window. 

11 You have completed this procedure. 
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Using the topology operations

This section explains the following procedures to use the various 
operations in topology GUIs of Integrated EMS Java Web Start Client. 

• Editing and viewing object properties using Java Web Client

• Updating status of objects manually

• Managing objects

• Unmanaging objects

• Adding custom topology node

• Searching objects in topology view

• Viewing the SAM21 Cards

• Partitioning the NEs discovered by MDM

• Zooming the topology view

• Using toolbars in topology view

• Grouping and ordering map symbols

• Deleting object and traces

• Changing topology layout

• Changing topology background
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Editing and viewing object properties using Java Web Client

Application
Use this procedure to edit or view the properties of objects that are 
displayed in the IEMS topology using Java Web Client.

Prerequisites
None

Action

At the IEMS workstation

1 Launch the IEMS Java Web Start Client. Refer to Launching 
IEMS Java Web Start Client in Integrated EMS Basics, 
NN10329-111.

2 Select the required object in the Integrated EMS Topologies tree 
under Applications.

Note: The properties of an object from the Inventory panel of 
Integrated EMS tree can also be viewed. To view the Inventory 
object properties, select the object in the Integrated 
Topologies tree under Applications to open the Inventory view. 
Double-click the required row in the Inventory view. 

3 Right-click the map symbol and select the Managed Object 
Properties menu item or double-click the map symbol to open 
the Object Properties window. 

Note: The object properties displayed can differ for each 
component. 

A window similar to the following figure opens. 
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4 Modify the object properties listed in the table below if required.

Managed object properties in Java Web Client

Field Description

Name Displays a unique name for the object

Display Name Edit the name displayed in the topology for 
the object

Type Displays the type of object (element manager, 
EMS, EMS platform or NE)

Status Displays the status of the object

IP-Address Edit the IP address of the object
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5 Select your next step.

6 Click the Modify button to update the changes. 

7 Go to step 16.

8 Click the Next button to proceed to the Fault Interface window.

A window similar to the following figure opens. 

Platform Select the platform where the object resides 
from the drop-down list

Managed Indicates whether the object is managed or 
unmanaged

Time Zone Select the time zone of the geographical 
location where the object exists from the 
drop-down list

Device Version Select the device version of the managed 
object from the drop-down list

Enable System 
Unmanage

Enable or disable the System_Unmanaged 
state. Refer to the System_Unmanaged state 
section of Configuring the Message Overload 
Controller parameters in Integrated EMS 
Fault Management, NN10334-911.

Poll Interval Edit the Poll Interval for status updates

Status Change Time Displays the last status change time of the 
object

Note: For the following objects, only the Display Name and the 
Managed field can be modified.

• SDM platform, APS EMS application, CS 2000 Core, Call Agent 
Core, IMX/CSE MX, Media Proxy, Media Gateway 7480/15000, 
MSS 15000

If Do

you do not want to modify any 
other properties

go to step 6

you want to view or modify the fault 
interface or performance interface 
properties

go to step 8

Managed object properties in Java Web Client

Field Description
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9 Edit or view the fault interface properties of the object as 
required.

Note: The Details panel dynamically changes according to 
the fault interface of the EMS/NE.

10 Select your next step.

11 Click the Modify button to update the changes. 

If Do

you do not want to modify any 
other properties

step 11

you want to view or modify the 
performance interface properties

step 13
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12 Go to step 16.

13 Click the Next button to proceed to the Performance Interface 
window.

A window similar to the following figure opens. 

14 Edit or view the performance interface properties of the object as 
required.

15 Click the Modify button to update the changes. 

16 You have completed this procedure.
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Updating status of objects manually

This procedure describes the steps to update the status of managed 
objects. Integrated EMS updates the status of managed objects in 
regular intervals (status polling), but it is possible to update the status 
of the managed objects manually which interrupts the regular polling. 
SNMP and CORBA-based devices communicate to Integrated EMS 
through unreliable streams (without establishing connections). When 
manually triggering updates for the SNMP or CORBA-based devices is 
done, Integrated EMS checks whether the communication with the 
device is active. The color of the map symbols background indicates the 
severity levels as tabulated below:

Significance of map symbol background color

Background color
Severity level or 
status

Critical

Major

Minor

Warning

Clear

Unmanaged or 
unknown object 
status
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Note: For USP NEs, only the active USP unit object provides an 
interface to determine the fault state of the USP. The inactive USP 
unit object status is in unknown state (map symbol has gray 
background color). The Integrated EMS dynamically detects when 
the USP unit has been swacted. When this occurs, it initiates alarm 
resync with the newly active USP unit and update the state of the 
USP unit objects in the Integrated EMS Client to reflect this change 
in activity. When this occurs, the previous active unit object map is 
changed to unknown state, and new active unit is updated to reflect 
the highest alarm state of the USP device. For the color mapping of 
various object status, refer to Significance of map symbol 
background color table of "Updating status of objects manually".

To manually update the status for a objects, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the required topology panel in the Integrated EMS tree. 
The tree shows the EMSs discovered or added for that type of 
EMS.

3 Select the map symbol for which the update status is required.

4 Right-click the selected map symbol and select the Update 
Status menu item. 

Progress of update is shown in the status bar. After the status 
update is complete, a "Status update over" message is displayed 
in the status bar.

The above procedure can be used to manually trigger updates for NE, 
EMS application, or platform objects.
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Managing objects

Using Integrated EMS Client, a provisioned EMS, NE, application, or 
platform can be managed or unmanaged. When a provisioned (or 
discovered) object is being managed, the state of the object is actively 
updated to reflect the current alarm status. When a device is 
unmanaged, the state of the device is no longer updated.

Note: When an object is unmanaged, Integrated EMS does not 
status poll the corresponding object. Also, Integrated EMS does not 
receive the events and alarms from the unmanaged object and does 
not forward the events to northbound.

To manage a unmanaged object, follow these steps:

At the Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select a topology panel in the Integrated EMS tree in which the 
required map symbol is displayed.

3 Right-click the required symbol (that needs to be managed) in 
the topology panel and select the Manage menu item.

Managing an object: example

To manage a Core Element Manager (in unmanaged state), follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Element Managers topology panel in the Integrated 
EMS tree in which the required map symbol is displayed.

3 Right-click the required CEM map symbol (that needs to be 
managed) in the Element Managers topology panel and select 
the Manage menu item.

Once a selected map symbol is set to be managed, an icon is 
displayed against the selected map symbol indicating the 
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severity status of the device. The following figure shows the 
difference between managed and unmanaged objects.

Note: The objects in unknown state and unmanaged state 
have the same map symbol background color.

Difference between Managed and Unmanaged NE

Managed CEM NE Unmanaged CEM NE
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Unmanaging objects

Application
Use this procedure to unmanage an object.

Unmanaging an object stops Integrated EMS from monitoring the 
object.

Note: When an object is unmanaged, Integrated EMS does not 
status poll the corresponding object. Also, Integrated EMS does not 
receive the events and alarms from the unmanaged object and does 
not forward the events to a northbound interface.

Action

At the Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select a topology panel in the Integrated EMS tree in which the 
required map symbol is displayed.

3 Right-click the required symbol (that needs to be managed) in 
the topology panel and select the UnManage menu item.

The following warning message is displayed:

4 Click the Yes button to unmanage the object.

5 You have completed this procedure.

Example of unmanaging an object

At the Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).
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2 Select the Element Managers topology panel in the Integrated 
EMS tree in which the required map symbol is displayed.

3 Right-click the required CEM map symbol (that needs to be 
unmanaged) in the Element Managers topology panel and 
select the UnManage menu item.

4 Right-click the required symbol (that needs to be managed) in 
the topology panel and select the UnManage menu item.

The following warning message is displayed:

5 Click the Yes button to unmanage the object.

Once a selected map symbol is unmanaged, the status icon in 
the map symbol becomes gray. The following figure shows the 
difference between a managed and an unmanaged object.

Note: The objects in an unknown state and unmanaged state 
have the same map symbol background color.

Difference between a managed and an unmanaged NE

Managed CEM NE Unmanaged CEM NE
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Adding custom topology node

This procedure describes how to add a topology tree node in the 
Integrated EMS tree. It also describes the custom topology tree node 
and how it is different from the default topology tree node. Custom 
topology nodes are useful to filter the map symbols based on specified 
criterion and have a customized view.

Custom Topology Tree Node: Custom tree topology nodes have 
some specific criteria, which must be met for the map objects or 
symbols to be displayed. 

Default Topology Tree Node: Default topology tree nodes are those 
provided automatically by the objects (for example, NEs, element 
managers, EMS platforms, and EMS applications). Unlike the custom 
topology node, where map symbols must satisfy certain criterion, the 
default topology node does not require the map symbols to satisfy any 
criterion. Any object can be added to a default topology. 

To add a custom topology node, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select a topology node in the Integrated EMS tree in which the 
required map symbol is shown.

3 Select the Custom Views-->Add New Map to invoke the Add 
Topology Properties window.

4 Enter the details for various fields in the window.

5 Specify the criteria (if the topology node is a custom topology 
node).

6 Click the Add Map button to add the topology node.

The details to be provided in the View/Modify Properties window 
are tabulated in the "Description of fields Add Map Properties 
Window" table.
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The properties window can be displayed; use any one of the 
methods detailed below.

The screen shot of the Add Topology Properties window is 
shown in following figure:

Various methods to launch Add Topology Properties window

From Toolbar From Menu bar Using Shortcut Keys

Custom Views-->Add New Map Ctrl+N
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7 In the Add Topology Properties window, specify the set of 
map-related information before adding the topology. The 
following table provides a description of the fields that need to be 
completed in the Add Topology Properties window:

Description of fields Add Map Properties Window

Field Description

name The name of the topology node that is to be added

label The display name or label of the topology node. This name 
is displayed in the tree.

topology The permissible layouts for the topology. 
Comma-separated values are permitted. 

Example
grid, star, ring, flow.

imageName The image file which appears as the background of the 
topology. The images can be in JPEG or PNG format. The 
images must be placed under the <Integrated EMS 
Home>/images directory.

Example
images/networkmapmain.png

autoplacement Specifies whether the map symbols in the topology must be 
arranged according to layout or the default layout. The 
default value is "true".

menuname The panel-specific menu file for this topology. The menu 
files are available under the <Integrated EMS 
Home>/mapdata/menus directory.

Example: mapmenu.xml, nodemenu.xml
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Note: For the imageName fields listed in the above table, the 
images in the /opt/nortel/iems/current/images directory 
(where Integrated EMS server is installed) can be used. If 
required, the images can be copied to the above location and 
used.

8 Completing the criteria (This step is required if the topology is 
a custom topology and demands certain criteria to be matched 
for the objects to be displayed.): Once the topology properties is 

mapSymbolRenderer The renderer that paints the map symbols in the topology 
canvas. By default, there are 3 map symbol renderers 
bundled with the product. 

Symbol Renderers:

mapSymbolRendererImpl: On selection of a map symbol, 
four dark squares appear on the edges of the symbol.

mapSymbolRendererImpl_2: On selection of a map 
symbol, a square box is painted over the symbol.

mapSymbolRendererImpl_3: Status of the objects is 
represented in a small box on the top corner of the symbol. 
On selection of the symbol, a square box is painted over the 
symbol. This is the default map symbol renderer used in 
Integrated EMS Client.

anchored Specifies whether the anchor property of the topology is 
"true" or "false".

If the anchor property is set to "true", the topology becomes 
a non-editable topology. That is, the topology components 
that are added to the topology are not editable.

If the anchor property is set to "false", the Topology is a 
normal editable topology.

The default value is "false"

treeIconFileName The name of the icon file that appears in the client tree 
against the topology node. The images must be placed 
under the <Integrated EMS Home>/images directory.

Example
images/pp8600_tree.png

ParentNode The parent node in the tree is selected from the list box. If 
the Fault Management node is selected, the topology is 
added under the Fault Management node in the client tree.

Description of fields Add Map Properties Window

Field Description
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entered, click the More button to launch the GUI. In this GUI, 
specify the match criteria. Note that the match criteria can only 
be any of the properties of the managed object

9 Choosing the Save to Server option: Once all the map-related 
properties have been specified and the match criteria specified, 
select the Save to Server check box to save the topology. 
Enabling this option saves the topology in the corresponding 
table in the database.

10 Adding the Topology Node: Finally, click the Add Map button 
to add the topology. 
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Searching objects in topology view

It is possible to navigate through Integrated EMS topology tree to locate 
a specific object or to search is done using the Find window in 
Integrated EMS client. This procedure describes how to search map 
symbols in the topology.

To search for an object map symbol in the Integrated EMS tree, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Navigate to the Integrated EMS Topologies node in the 
Integrated EMS tree.

3 Select a topology panel under the Integrated EMS Topologies 
node.

4 Launch the Find dialog using the Edit-->Search menu 
command or using the Find button in the toolbar.

The search screen is similar to the following screen shot:

5 Enter the label name (part or whole label of the map symbol) in 
the Symbol label field.

6 Click the Find next button to search for the map symbol with the 
specified label name. 
NN10330-511   (I)SN08   Standard 02.05 March 2006



Nortel Networks Confidential233Copyright © 2006, Nortel Networks
A particular topology can be skipped by clicking the Next Map 
button, which moves to the next topology node available in the 
tree.

The Up and Down radio buttons are used to specify the direction 
in which the search is to be performed. Use the Ignore case 
option and Match whole word option for an easy search. The 
New search button resets the values to the default. The Close 
button closes the find window and the Help button displays this 
help section.
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Viewing the SAM21 Cards

After an SAM21 Manager is added, the corresponding SAM21 NEs are 
automatically discovered. The SAM21 NE objects are added in 
Networks Elements topology and also in SAM21 topology under the 
Network Elements topology. The SAM21 card arrangement for a 
SAM21 NE is displayed in the sub-node SAM21_1 under the SAM21 
topology node as in the following figure.

To view the SAM21 cards, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Expand the Networks Elements node in the Integrated EMS 
tree.

3 Select the SAM21_1 sub node under the SAM21 node.
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The SAM21 cards are displayed as in the following figure. The 
cards arrangement in the SAM21 device is displayed. 
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Partitioning the NEs discovered by MDM

When an MDM is added to the topology, the corresponding PVG 
7480/15000 and MSS 15000 NEs are discovered by Integrated EMS. 
These NEs can be unmanaged or made invisible to all the users in the 
various topologies such as Network Elements, Passports, MSS15K, 
and MSS-Unknown. This is achieved by partitioning the NEs as 
managed, unmanaged, or invisible devices in the Partition NEs GUI.

Note: NEs are invisible to all the users in the various topologies, that 
is, NEs do not appear in the topologies but the details of these NEs 
are present in the database.

To partition the NEs discovered by MDM, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Element Managers topology in the Integrated EMS 
tree.

3 Right-click the MDM map symbol for which the NEs must be 
partitioned and select Partition NE’s menu item.

The Partition NEs GUI is launched similar to the following screen 
shot.
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4 Select the NE to be unmanaged from the Managed Devices list 
and move it to Unmanaged Devices list by clicking the >> 
button (present next to Managed Devices list).

To move the NE from Unmanaged Devices list to Managed 
Devices list, select the NE and click the << button (present next 
to Managed Devices list).

Note: When an object is unmanaged, Integrated EMS does 
not status poll the corresponding object. Also, Integrated EMS 
does not receive the events and alarms from the unmanaged 
objects and does not forward events to northbound.

5 Select the NE to be made invisible in the topologies from the 
Unmanaged Devices list and add it to Invisible Devices list by 
clicking the >> button (present between Unmanaged Devices 
and Invisible Devices list).

Note: You must move the NE to Unmanaged Devices list from 
Managed Devices and then add it to Invisible Devices list.
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Zooming the topology view

The zooming function in the topology of Integrated EMS Client displays 
an enlarged view of the topology and its components. Map symbols can 
be zoomed using the Zoom button in the Map toolbar.

To locate the Integrated EMS Topologies node in the Integrated 
EMS tree, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Navigate to the Integrated EMS Topologies node in the 
Integrated EMS tree.

3 Select a topology panel in the Integrated EMS Topologies 
node.

The zoom functionality can be achieved by accessing the zoom tool 
buttons of the topology toolbar as tabulated below.

Zoom tool buttons

Zoom Tool button Name Zoom Tool button

Zoom Mode

Zoom In
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Zoom mode: The Zoom Mode tool button enables the zooming of one 
or more map symbols. To have to select one symbol at a time for 
zooming, use the Selection tool. Otherwise, select more than one 
symbol over a given area in the topology and click the Zoom Mode tool. 
Symbols in the topology cannot be selected when the Zoom Mode tool 
is enabled.

Zoom in mode: To zoom in on the entire displayed topology, access the 
corresponding button in the Map toolbar. On clicking the button, the 
Map zooms in at the center. 

Zoom out mode: Zoom out to view the entire topology at its default size 
by accessing the corresponding button of the Map Toolbar. On clicking 
the button, the topology back to its original size. 

Zoom overview: To view the exact region, which is currently being 
zoomed in or zoomed out, access the Zoom Overview tool button of the 
Map Toolbar. On clicking this button, a separate Map Overview window 
pops up at the left corner of the window, highlighting the area of the Map 
(with red bars), which is being zoomed. This is useful for locating the 
exact positions of the map symbols in a Map. In this window, zooming 
can be adjusted by varying the size of the zoom overview. When the 
zoom overview window is changed, the zoom overview also varies 
proportionately. 

Zoom Out

Zoom Overview

Zoom tool buttons

Zoom Tool button Name Zoom Tool button
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Using toolbars in topology view

When a topology is selected, two toolbars can be found in Integrated 
EMS Client, the panel-specific toolbar and the topology toolbar. This 
procedure describes how to the use of each tool button in the toolbar.

Using panel-specific toolbar
There are a few other options in the main toolbar, which are specific to 
topologies. These options are called "panel-specific toolbar options" 
and they are placed between the frame-specific toolbar buttons.If the 
topology panels, such as Element Managers, EMS Applications, EMS 
Platforms or Network Elements are selected, the topology toolbar is 
displayed. For descriptions of panel-specific toolbar options specific to 
the topology, refer to the following table:

Panel-specific Toolbar Buttons Description

Tool button 
Name

Tool 
button

Menu 
Command

Shortcut 
Key Description

Relayout 
Topology

Custom 
Views 
-->Relayout 
Map

Ctrl+R When the symbols are 
moved on the topology 
canvas, their anchor 
properties are set to "true". 
By default, layout does not 
handle objects whose 
anchor properties are 
"true". But if you want to re 
layout the entire set of 
objects, including those 
with anchor properties as 
"true", then you do a re 
layout. The relayout action 
sets the anchor properties 
of all the symbols to" false" 
and it repositions them 
according to the layout 
calculations.

Undo Edit-->Undo 
Add/Delete

Ctrl+Shift+
Z

Used to undo the last 
action.
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Using topology toolbar
Each topology has a toolbar available at the top of the view. This toolbar 
is used to maintain the managed nodes that are in the context of this 
view.

To locate the topology toolbar in a topology panel, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of Integrated 
EMS Basics, NN10329-111).

2 Navigate to the Integrated EMS Topologies node in the 
Integrated EMS tree.

3 Select a topology panel in the Integrated EMS Topologies 
node, for example: the Network Elements topology node. 

The topology toolbar is displayed at the top of the selected 
topology panel.

Delete Map Custom 
Views-->Dele
teMap

Ctrl+D Deletes selected topology.

Save Map Custom 
Views-->Sav
e Map

Ctrl+S Saves the topology 
properties and map symbol 
properties (if symbols are 
present) to the respective 
database tables.

Refresh 
Map

View-->Refre
sh

F5 Reloads the topology with 
the previously saved 
information. If you do some 
changes on a Topology 
and then do a refresh, the 
topology is loaded with the 
lastly saved information.

Panel-specific Toolbar Buttons Description

Tool button 
Name

Tool 
button

Menu 
Command

Shortcut 
Key Description
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The topology toolbar icons and their descriptions are in the following 
table.

Description of tool buttons in topology toolbar

Toolbar Button 
Name

Toolbar 
Button Description

Select
Selects a map symbol in the topology, (indicated by 
being enclosed within four blocks). Only one map 
symbol can be selected at a time.

Zoom Overview 
Window

Displays the Zoom Overview window. First select a 
map symbol and then click this Zoom Window 
button. The Zoom Overview window displays the 
exact location of the selected map symbol in the 
topology. This option is very useful to find the exact 
location of the map symbol within the topology.

Zoom Mode Enables selection of one or more map symbols for 
zooming.

Zoom In

Obtains an enlarged view of the selected topology. 
The topology is zoomed from the center of the 
selection. This button can be selected multiple times 
to perform multiple zooms.

Zoom Out Zooms out of the topology view. This button can be 
selected multiple times to zoom out further.

Cut Cut any map symbol in the topology view. 
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Copy
Copies a map symbol from a topology view ready for 
pasting to an existing or to a newly created topology 
view. 

Paste
Pastes any map symbol previously cut or copied 
from a view to an existing topology or to a newly 
created topology. 

Undo Performs an undo of the most recent action. 

Group View Displays the topology in its default state with map 
symbols, container, and groups. 

Expand Selected 
Groups

Expands an existing group, displaying all the map 
symbols within the group.

Group Selected 
Symbols Groups the selected map symbols.

Description of tool buttons in topology toolbar

Toolbar Button 
Name

Toolbar 
Button Description
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Grouping and ordering map symbols

Map symbols are the distinct icons displayed for different object types. 
The objects can be grouped or ordered. The following procedure 
describes how to group or order map symbols. A group of map symbols 
is represented as in following figure.

Grouping map symbols
Grouping map symbols helps to view map symbols representing 
managed objects connected within a local vicinity or managed objects 
which share a logical connection.

Grouping based on number of map symbols per group: Open a 
topology and select the Edit-->No Of Symbols Per Group menu 
command, to group map symbols as per the specified number.

Note: After creating a group, save the map using the Custom 
Views-->Save Map menu command to maintain the state of group. 

Grouping based on user preference: To group the map symbols 
based on user preferences, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the required topology panel in the Integrated EMS tree.
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3 Select a set of map symbols with combination of Ctrl key and 
mouse click.

4 Group them using the Group Selected symbols tool button in the 
topology toolbar. A group symbol is displayed in place of the 
selected symbols. The remaining map symbols remain 
unaffected.

Flexibility in ungrouping the groups to view map symbols: To view 
map symbols within a group, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of Integrated 
EMS Basics, NN10329-111).

2 Select the required topology panel in the Integrated EMS tree.

3 Select one or more group symbols.

4 Select the Expand Selected (or all) Groups tool button in the 
topology toolbar to view the symbols in the selected groups in 
one view (or) double-click on a group symbol to view the map 
symbols in that group.

The map with group symbols can be saved for future use.

Disabling groups: To disable grouping, select the Edit-->Disable 
Grouping menu command.

Opening a group: To open a group symbol and view the map symbols 
of a Group, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of Integrated 
EMS Basics, NN10329-111).

2 Select the required topology panel in the Integrated EMS tree.

3 Select one of the grouped map symbol.

4 Select the menu Group-->Open Group from the menu bar [or] 
right-click the group symbol and select the context-sensitive 
menu option OpenGroup. Double-clicking the group symbol can 
also open the group.

Save Changes On Server Option: The Save Changes On Server 
option in the group symbol property form, saves only the group 
properties in the server. Consequently the server is not aware of the 
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symbols present inside the group. After saving the group, and 
performing a refresh (or when the client is next started), the group is 
present but none of the symbols are shown. 

To retain the symbols inside the group, the symbols' groupName 
property must be updated with the respective group name. This can be 
performed by either:

• saving the map using the Custom Views-->Save Map menu 
command

OR

• using the Save Changes On Server option for every map symbol 
present inside the group.

Ordering map symbols
The map symbols can be sorted in an orderly manner by using the 
Edit-->Order By menu option. The map symbols can be sorted based 
on the criteria shown in the following table.

Various Criteria Attributes for Ordering Map Symbol

Criteria 
Attribute Description

name Sorts the map symbols based on their names. Order of sorting is 
A-Z.

label Sorts the map symbols based on the symbols' label values. Order 
of sorting is A-Z.

objName Sorts the map symbols based on the name of the managed object 
that is represented by the symbol.

status Sorts the map symbols based on the status of the managed 
objects represented by the symbols. Order of sorting is from critical 
to clear.

groupName Sorts the map symbols based on the name of the group to which 
they belong.

objType Sorts the map symbols based on the type of the managed object 
represented by the symbols.
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Deleting object and traces

This procedure describes how to delete and object and traces from the 
topology.

To remove an object from topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the required topology panel.

3 Right-click the required object or map symbol in the topology and 
select the Delete Object and Traces menu item.

Note: Deleting object and traces from the topology does not remove 
the events associated with the object. Deleting an object only 
removes it from the topology and its associated alarms.
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Changing topology layout

The topology layout can be changed to grid, star, ring, or flow layout. 
This procedure describes how to change the topology layout.

To change the topology layout, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the required topology. For example, the Network 
Elements topology panel.

3 Double-click on the background of the topology. 

The Map Properties dialog is displayed.

4 Select the required layout in the CurrentTopology list box.

5 Click the Modify button to save the selection.

6 Click the Close button to close the Map Properties dialog.
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Changing topology background

The background displayed for each of the topology can be changed. 
The backgrounds are images in either PNG or JPEG format. This 
procedure describes how to change the topology background.

To change the topology background, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the required topology panel. For example, Network 
Elements topology panel.

3 Double-click on the background of the topology. The Map 
Properties dialog box is displayed.

4 Using the file chooser button next to the ImageName field, 
Select the required image.

5 Click the Modify button to save the selection.

6 Click Close button to close the Map Properties dialog.

Note: For the ImageName field specified above, the images in the 
/opt/nortel/iems/current/images directory is used. If required, the 
user-defined image files can be copied here and subsequently used.
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Working with inventory panel

The Inventory maintains the properties of all Managed objects of a 
network. These managed objects and their object properties are listed 
in the Inventory panel. The Inventory panel can be selected from 
Integrated EMS Tree. You can navigate through the displayed Inventory 
panel by accessing the navigating buttons, thereby sorting the listed 
Managed Objects. The property details of these Managed Objects can 
be accessed through the menu specific for the selected object. The 
Inventory panel operations are triggered on accessing the menus that 
are specific for the panel. Refer to the following procedures that 
describes the various operations in Integrated EMS Inventory.

• Navigating inventory panel

• Searching EMS/NE from inventory panel

• Resynchronizing inventory for element managers

• Identifying problems of objects from inventory panel

• Dumping inventory details of Integrated EMS

• Creating a custom view for the inventory panel

— Custom views for inventory: matching criteria

— Example for creating custom view for inventory
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Navigating inventory panel

The inventory can be navigated with the help of navigation tools such 
as view range, navigator buttons and column reordering. You can 
navigate the inventory for an easy and understandable view or sort out 
the database based on your requirements. The various ways in which 
the Inventory can be navigated are listed below: 

To locate the Navigation toolbar in Inventory, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Navigate to the Inventory panel in the Integrated EMS tree. You 
can find the Navigation toolbar in the top part of the Inventory 
panel in the right-hand side of Integrated EMS Client.

View Range: The range of rows that are displayed in the table. It is 
placed on top of the Inventory window. User can also use the default 
page lengths available in the list box.

Note: In the Inventory panel, the objects being viewed take 
precedence over the updates received (for example, when new 
managed objects are added into the database). This is unlike objects 
displayed in the Events or Alarms browser. In Events or Alarms 
browser, the latest objects added are displayed in the beginning of 
the browser followed by the already added objects (for example, 
updates get precedence over the objects being viewed). In the 
Inventory panel, the latest objects added are displayed at the end, 
wherein you need to scroll through to view the latest managed 
objects that were added. 

Navigator Buttons: The Inventory panel contains four navigator buttons 
on the right top. They are First, Previous, Next, and Last. The 
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description of the buttons as according to the order they are displayed 
is as follows.

• First button: This button is used to view the first page of the internal 
frame, which displays data retrieved from the database. 

• Previous button: This button is used to view the previously viewed 
page of the internal frame, which displays data retrieved from the 
database.

• Next button: This button is used to view the next page of the 
internal frame, which displays data retrieved from the database.

• Last button: This button is used to view the last page of the internal 
frame, which displays data retrieved from the database.

Sort: You can sort the data based on the column type and the details 
can be viewed either in ascending order or descending order. For 
details, refer to "Understanding sorting of data" of Integrated EMS 
Basics, NN10329-111. 

Both server-side and client-side sorting can be done for one column as 
required. These sorting are also indicated by the combination of the 
above indicators.

Column reordering: For an easy view of the data, you can reorder the 
columns by just dragging the column header and moving it to the 
required place in the table.

Search: One can find the required device of a particular criteria or on a 
general condition. Search dialog can be launched from the Edit menu 
or through the Find option in the toolbar or by pressing Ctrl+F. For more 
details refer to searching devices.
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Searching EMS/NE from inventory panel

This function enables you to search one or more related events from the 
inventory. The search operation is performed on the entire database. 
You can find the required network using a particular criteria or a general 
condition. To invoke the Search dialog, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Inventory panel in the Integrated EMS tree.

3 Launch the Search dialog using the Edit-->Search menu 
command.

The search is made on the server side, which means that the search is 
done on the entire database and is not restricted to the displayed page 
alone. More flexibility has been provided in the search feature so that 
you can search on a particular property or on a general condition.

The Search dialog can be launched using the Edit-->Search menu 
command or using the find button in the toolbar, or by pressing Ctrl+F 
keys.

You have an option to select whether all the criteria or any of the criteria 
given has to be satisfied. This option can be set by selecting the Match 
any of the following option or Match all of the following option.

The search can be on one or more criteria using the "More" and "Fewer" 
buttons. You can add any criterion on which you have to go for search. 
The first option in the screen pop up is a list box, it lists the existing 
column headers in the Inventory table of the Inventory panel. The 
second option has two different sets of search criteria a normal set of 
criteria, and a date/time criteria:

The normal set of criteria consists of:

• starts with

• doesn't start with

• ends with

• doesn't end with

• contains

• doesn’t contain
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• equals

• not equals

The Date/Time criteria consists of:

• is before

• is after

• equals

• not equals

The third option is a data field or Date/Time component for entering 
your specific argument. By default, the Date/Time component shows 
the current date and time in the order of month, date, year, hour, minute, 
second, and AM/PM, which can be chosen by using the up and down 
arrows. The following figure shows the search window search for a 
specific object: 
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Resynchronizing inventory for element managers

Managed Objects (MOs) are added to the Integrated EMS topology 
either by explicitly adding them through the "Add EMS/NE" wizards or 
they can be auto discovered. For example, when provisioning an 
Element Manager in Integrated EMS the associated Element Manager 
will be added to "Element Managers" node in the topology tree. In 
addition, Integrated EMS will discover the sub-tending devices 
managed by the Element Manager and propagate these discovered 
devices into "Network Elements" branch in the topology tree. Auto 
discovery is performed when provisioning the following element 
managers to the Integrated EMS topology.

• APS Manager

• GWC Manager

• MG 9000 Manager

• Multi-Service Data Manager

• SAM21 Manager

• UAS Manager

After Integrated EMS Server is started, some of the managed element 
managers intimate the dynamic change of their properties to Integrated 
EMS in order to update the Inventory. The above element managers do 
not have this capability to intimate dynamic change of properties, such 
element managers need to manually resynchronize to update 
Integrated EMS Inventory. The element managers details can be 
resynchronized using one of the following GUIs:

• Topology

• Inventory

Resynchronizing Inventory for Element Managers topology GUI

To resynchronize the Inventory details for an Element Manager in 
the corresponding topology GUI, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Navigate to the Element Managers topology panel under the 
Integrated EMS Topologies node in the Integrated EMS tree.
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3 Select the required Element Manager map symbol in the 
selected topology node for which resynchronizing inventory 
details is required.

4 Right-click the map symbol and select the Resynchronize 
Inventory menu item from the popup menu to resynchronize the 
Inventory

OR

Select the <Object-specific menu>-->Resynchronize 
Inventory, where the <Object-specific menu> menu indicates 
the dynamic menu for the selected EMS/NE in the topology.

Note: The element manager objects (listed above) that have 
inventory details in Integrated EMS database in sync with the 
corresponding element manager properties cannot be 
resynchronized. Hence those element manager map symbols do not 
have the Resynchronize Inventory menu item in the popup menu 
(launched from map symbol) or <Object-specific menu>.

Resynchronizing Inventory in Inventory GUI

To resynchronize the inventory details for an Element Manager in 
Inventory GUI, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Navigate to the Inventory panel in the Integrated EMS tree. 

3 Select a row of required NE in the Inventory table for which 
resynchronizing alarms is required.

4 Right-click any part of the row and select the Resynchronize 
Inventory menu item to resynchronize the Inventory.

OR

Select the <Object-specific menu>-->Resynchronize 
Inventory, where <Object-specific menu> menu indicates the 
dynamic menu for the selected EMS/NE row in Inventory table.

Note: The Element Manager objects (listed above) inventory details 
in Integrated EMS database in sync with the corresponding element 
manager properties cannot be resynchronized. Hence those rows in 
Inventory table does not have the Resynchronize Inventory menu 
item in the popup menu (launched from map symbol) or 
<Object-specific menu>.
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Identifying problems of objects from inventory panel

In the domain of Network Management Systems, it is imperative that 
the Manager (Integrated EMS) is informed about the state of every 
network element (NE). The Manager receives network notifications 
about the state of every managed NE. These notifications are 
unsolicited messages sent by either the agent in the NE or through 
status polling techniques adopted by the Manager. These malfunctions 
or faults are acknowledged by Integrated EMS as generated events and 
alarms. You can view the generated events and alarms for a device 
selected from the displayed list of the Inventory panel. This can be 
accomplished by accessing the panel-specific menu View. On clicking 
the required menu item, that is, events or alarms of the panel-specific 
menu, the corresponding panel gets displayed in the Client with the 
display of the generated events or alarms of the selected device.

To navigate to Inventory node, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Navigate to the Inventory panel in the Integrated EMS tree. 

Note: You can only access alarms or events for the following types 
of objects:

• element managers

• NEs

• EMS platforms

Accessing Alarms for selected EMS/NE
You can view the alarms generated for the EMS/NE selected in the list 
view of the Inventory panel by accessing the panel-specific menu 
option View-->Alarms. On choosing this menu option, the Alarms panel 
(under the Fault Management node) of Integrated EMS Tree gets 
selected, displaying the last generated alarm and its severity status for 
the selected device.
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The alarms associated with the managed object can be view from the 
topology node by selecting the managed object in the topology and 
select View-->Alarms menu command.

Note: All the events from the CS 2000 Core Manager are added as 
stateless events in Integrated EMS. These events are not correlated 
to alarms.

Accessing Events
: You can view the events generated for the device selected in the list 
view of the Inventory panel, by accessing the panel-specific menu 
option View-->Events. On choosing this menu option, the Network 
Events panel (under the Fault Management node) of Integrated EMS 
Tree gets selected, displaying the list of generated events over a period 
of time for the selected device. 

The events associated with the managed object can be view from the 
topology node by selecting the managed object in the topology and 
select View-->Events menu command.

Updating the Status
: Whenever the status of a selected object is to be updated, the 
Object-specific menu Update Status menu item can be used from the 
corresponding map symbol. This menu item enables the user to view 
the latest status of the selected device, instantaneously. This means, 
irrespective of the configured polling period, Integrated EMS fetches for 
the current status of the selected device. For example, if you have to 
retrieve the status of a particular selected node of the displayed list of 
the Inventory panel, select the menu command Node-->Update Status.
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Dumping inventory details of Integrated EMS

The inventory details of Integrated EMS can be dumped to a text file 
from various GUIs in Integrated EMS Web Start Client. This section 
describe the following:

• Dumping inventory details from Integrated EMS object

• Dumping inventory details from Inventory GUI

• Dumping inventory details from topology GUI

• Understanding dumped inventory details

Dumping inventory details from Integrated EMS object

To dump the inventory details from Integrated EMS object, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select Integrated EMS map symbol in the Element Managers 
topology panel in the Integrated EMS tree.

3 Right-click Integrated EMS map symbol and select the Dump 
Inventory Details menu item from the popup menu.

OR

Select the IEMS Mgr-->Dump Inventory Details menu 
command.

A dialog is launched and displays the message that is dumped 
in the file inventoryData.txt present under 
/opt/nortel/iems/current/logs. 

Dumping inventory details from Inventory GUI

To dump the inventory details from Inventory GUI, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of Integrated 
EMS Basics, NN10329-111).

2 Select the Inventory panel in the Integrated EMS tree.
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3 Select the Tools-->Dump Inventory Details menu command. 

A dialog is launched and displays the message that is dumped 
in the file inventoryData.txt present under  
/opt/nortel/iems/current/logs. 

Dumping inventory details from topology GUI

To dump the inventory details from topology GUI, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of Integrated 
EMS Basics, NN10329-111).

2 Select a topology panel in the Integrated EMS tree.

3 Select the Tools-->Dump Inventory Details menu command. 

A dialog is launched and displays the message that is dumped 
in the file inventoryData.txt present under 
/opt/nortel/iems/current/logs. 

Understanding dumped inventory details
The inventory details are dumped in a text file as mentioned in the table 
below. This section describes how the information is stored in this file 
and details of various properties. These details are helpful to parse the 
information stored in the text file.

File Details
The details of the file in which the inventory details are dumped is listed 
in the table below.

Field Value

File name inventoryDetails.txt

File location /opt/nortel/iems/current/logs

Field delimiters Comma (separated by ",")

Record 
separator

Next line (Enter)
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Details of properties
The details of properties are displayed in the table below.

End of file 
marker

-1 (when read byte-by-byte as in Sun Java 
terminology)

Maximum file 
size

No limit

Field Value

Field

Data type 
in 
database

Column 
Size Description

Possible 
values

Name Varchar2 100 A unique name for the 
map symbol

Not 
Applicable

ParentName Varchar2 100 The host name of the 
parent if present. This 
field is filled only for 
sub-units, NEs or EMS 
applications objects 
which are discovered 
automatically with 
corresponding platforms 
or element managers.

Example
succession-sol1-SSP
FS-Unit-0 is sub-unit 
of 
succession-sol1-SSP
FS platform object.

null or parent 
name

IPAddress Varchar2 100 The IP address of the 
object

Not 
Applicable

Type Varchar2 100 The type of object Name of 
EMS 
application, 
element 
manager, 
platform or 
NE.

Version Varchar2 25 The version of the object. 6.2 or 7.0. 
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Note: The data type for the property Status is "Number" since the 
status of object is stored in numeric format. For example, an object 
with status "Critical" is stored with the value "1" in Status column.

A sample text from the inventoryDetails.txt file is given below. The 
commas together(,,) indicates the null value in the corresponding field.

Name,ParentName,IPAddress,Type,Version,Status,Manag
ed,InterfaceDetails

umanand-USP,,192.168.9.97,USP,6.2,Unknown,true,SNMP
:public:v1:161

succession-sol1-SSPFS,,192.168.4.176,SSPFS,6.2,Clea
r,true,SYSLOG:/var/log/customerlog:/var/log/securit
ylog:/var/log/auditlog

succession-sol1-SSPFS-Unit-0,succession-sol1-SSPFS,
192.168.4.176,SSPFS,6.2,Clear,true,SYSLOG:/var/log/
customerlog:/var/log/securitylog:/var/log/auditlog

Status Number 22 The status of the object. Unknown, 
Clear, 
Critical, 
Major, Minor, 
or Warning

Managed Varchar2 10 Indicates whether the 
object is managed or 
unmanaged.

true or false

InterfaceDetail
s

Varchar2 200 Displays the location of 
files with file names in 
which the interface 
details are stored. The 
interface name and each 
file location are 
separated by ":"(colon)

Example
SYSLOG:/var/log/cus
tomerlog:/var/log/sec
uritylog:/var/log/auditl
og

null or 
location of 
interface 
details

Field

Data type 
in 
database

Column 
Size Description

Possible 
values
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succession-sol1-SSPFS-Unit-0,succession-sol1-SSPFS,
192.168.4.176,SSPFS,6.2,Clear,true,SYSLOG:/var/log/
customerlog:/var/log/securitylog:/var/log/auditlog

raghuram-LMM,,192.168.9.105,LMM,6.2,Clear,true,,

kashok-PP8600,,192.168.1.98,PP8600,7.0,Clear,true,S
NMP:public:v1:161

mvivekanandan-STORM,,192.168.9.97,STORM,6.2,Clear,t
rue,SNMP:public:v2c:161

saranganj-NPM,,192.168.9.243,NPM,6.2,Clear,true,SYS
LOG:/var/log/customerlog:/var/log/securitylog:/var/
log/auditlog
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Creating a custom view for the inventory 
panel

By creating custom views, you can easily find or filter out the required 
output in the screen by sorting through large amount of data from the 
Integrated EMS. A custom view is basically a set of objects or data, 
which are subsets of a complete set of data or objects, satisfying a 
given criteria. 

Using Features in custom view
The various features in custom view are listed below

• The inventory of a specific criteria can be viewed.

• The updates of data are Dynamic.

• Same custom view name can be used at different levels.

• The column (properties to view) is customizable.

• You can change the column order, sort the data, and save the states 
of custom view. 

• Custom view can be modified.

• Custom view can be renamed.

To perform various custom view operations for Inventory node, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).
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2 Select the Inventory node in the Integrated EMS tree and 
proceed with the menu bar options in the following table to utilize 
the features listed above.

Add or Modify custom a view
This option adds a new custom view with the given criteria. When this 
option of adding a new custom view is chosen, a custom view property 
window is displayed. After the form is filled with the necessary criteria 
and submitted, the new custom view is created and you can see the 
difference in the tree on the left.

When the modify custom view option is selected, the custom view 
property window is displayed. After the necessary changes are done 
and submitted, the existing custom view is updated.

Remove custom view
This option removes the currently selected custom view. If a custom 
view has one or more custom views (as child view), the complete set 
(parent and child) are removed. The main parent custom view (default 

Features in custom views for Inventory

Menu Bar Option

Tool 
button in 
Toolbar Shortcut Description

Custom Views--> 
Add Custom View

Ctrl+N To add a new custom view with 
specific criteria.

Custom Views--> 
Remove Custom 
View

Ctrl+R To remove a custom view. The 
parent custom view (Inventory) 
cannot be removed.

Custom Views--> 
Modify Custom 
View

Ctrl+M To modify any custom view.

Custom Views--> 
Save Custom 
View

Ctrl+S To save the current state of the 
custom view, such as column order, 
sort order, and others.

Custom Views--> 
Rename Custom 
View

Alt+F2 To rename any custom view
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- Inventory) cannot be removed. Selecting the Remove Custom View 
option asks for a confirmation.

Save custom view
This option saves the current state of the custom view such as order of 
the column, the sort order, and the displayed data.

Rename custom view
This option helps you rename the current custom view as required. 
While renaming the custom view name, if you wish to have the same 
old name, then the user must press Esc key before completing it.
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Custom views for inventory: matching criteria

By creating custom views, you can find out the required output on the 
screen, from a large collection of data of Integrated EMS. You can set 
the match criteria by using the Object Properties form, which is 
retrieved by accessing the Custom Views (panel-specific menu) -->Add 
Custom Views menu command. The properties form can contain 
details such as filter view name, parent name, class name, IP address, 
and other properties.

To select the Inventory node, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select to the Inventory node in the Integrated EMS tree.

Matching criteria
This sub-section describes how the match criteria can be set using the 
Object Properties form. The Object Properties window is launched 
using the Custom Views-->Add Custom Views menu command. 
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Refer to the following table for the properties in the property sheet, for 
filling in the fields, and for other information.

Field Description

Filter View Name Specify name for the particular custom view.

ParentName In the drop-down list, select the object in the tree list box 
under which this custom view is to be added. The default is 
Inventory node.

Name Specify the unique name of the EMS/NE.

ipAddress Specify the unique address assigned to each device.

Note: Do not specify the IP address in the client GUI or the 
command prompt UI, with an octet which is prefixed with a 
"zero". An IP address whose octet ranges from 0 to 255, 
when prefixed with zero, such as 010, is interpreted as an 
octal number and is passed as an "8", which results in an 
invalid IP address.

Managed Specify whether the devices are managed.

True: Includes all managed devices.

False: Excludes all managed devices.

All: Includes all devices.

Type Specify the type of EMS/NE, such as network, map symbol, 
or an interface.

isSNMP This field must not be used.

Classname Specify the class name of the managed device. For 
example, the class name for a node object (map symbol) is 
the value "Node".

Netmask Specify the net mask assigned to the managed device.

PollInterval Specify the poll interval (the time gap between two 
successive status polling of a managed device).

Status Specify the status (severity) of the device in the inventory 
that indicates the criticality. The severity of the device to be 
filtered can be assigned here.
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Note: If all the parameters (except filter view name) are left blank, 
then the default value "all" is assigned.

Tree node properties
Besides the Object Properties, you can specify other properties such 
as Tree Node properties. This is achieved in the Tree Node Properties 
tab of the GUI. The Tree Node properties can include properties such 
as Frame Title, Menu File Name, Icon File, and others.

The Tree Node Properties tab is as in the following figure.

StatusChangeTime Specify the time at which the status of the device changed. 
The time is represented as the number of milliseconds.

Tester Specify the class used for the status polling of the selected 
managed devices.

Uclass Specify the class to be launched for status polling. Use this 
field only if the value in the Tested field is "usertest".

Field Description
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The description of the fields in the Tree Node Properties tab is listed in 
the following table:

Description of fields in Tree Node Properties tab of Custom View GUI for 
Inventory

Field Description

Frame Title Specify the name to be displayed on the title bar of the custom 
view's internal frame.

Menu File Name The panel-specific menu file name for the Inventory panel. Do 
not modify this field.

Icon File Indicate which icon you want to use for the custom view. This 
icon is visible in the tree as well as in the title bar of the internal 
frame. The image must be in PNG format. The icon file must be 
present under the /opt/nortel/iems/current/ folder or any sub 
folder under the /opt/nortel/iems/current/ folder. The 
/opt/nortel/iems/current/ folder is the folder under which the 
Integrated EMS Server is installed.
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Table Popup 
Menu

The file name of the menu used to display a contextual menu for 
the objects displayed in the table of the Inventory table. Do not 
modify this field.

Tree Popup 
Menu

The file name of the menu used to display a contextual menu for 
the Inventory node in the Integrated EMS tree. Do not modify 
this field.

Node Specify the position of the custom view in relation to previously 
added views. If this field is left blank, the view is appended to the 
end of the current list of custom views.

Description of fields in Tree Node Properties tab of Custom View GUI for 
Inventory

Field Description
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Example for creating custom view for inventory

You can create custom views for viewing the inventory details for the 
given criteria. In the Matching Criteria section, you can find the various 
properties with which you can filter events. This procedure describes 
how to create custom view to view the inventory details of all the CS 
2000 Manager with "Critical" status.

Creating custom view for inventory details of CS 2000 Core Manager

To create custom view for Inventory details of CS 2000 Core 
Manager, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Java Web Start Client (refer to 
"Launching Integrated EMS Java Web Start Client" of the 
Integrated EMS Basics, NN10329-111).

2 Select the Inventory node in the Integrated EMS tree.

3 Right-click the Inventory node and select Custom Views-->Add 
Custom Views menu item. 

The Object Properties form is displayed.

4 Enter the value "CS2K Devices" in Filter Value Name field. 

5 Enter the value "EMS-CS2K-Mgr" in Type field, since the device 
with type "CS2K" is filtered and displayed in custom view.

6 Select the "Critical" value from the Status editable list box.

A GUI similar to the following screen shot is displayed.
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7 Click the Next button to proceed to next screen of the wizard.

8 Click the Select Props To View button.

The Select Table Columns window  is displayed.

9 Select the following text boxes with the text

• Name

• Type

• Last Changed Time

• Managed
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10 Click the OK button to apply the changes and close the Nortel 
Select Table Columns window.

11 Click the Apply Filter button to create a custom view for events 
from CS 2000 devices.

Note: The match criteria for a custom view can be modified after 
they are created. This is achieved by right-clicking the custom view 
and select the Custom Views-->Modify Custom View. This invokes 
the Object Properties form. You can also remove a custom view by 
right-clicking the custom view and selecting the Custom 
Views-->Remove Custom View.
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Working with topologies in Web Client

Topology user interface displays a set of related objects, symbols, and 
sub-nodes that provide a graphical and hierarchical representation of 
element managers, network elements, EMS applications, and 
platforms. The topology nodes of Web Client provides the user 
interface, a view of the networks and systems using Web Client. The 
topology is displayed on the right-side frame. The left-side frame 
contains the tree view to navigate between different topology views. 
This section describes on how to add the various objects such as 
element managers, network elements, EMS applications and 
platforms. In addition, this section provides procedures on how to see 
the map details, manage or unmanage and perform other operations. 
Refer to the following sections for details:

• Adding objects to topology in Web Client

— Adding platforms using Web Client

— Adding element managers in Web Client

— Adding EMS applications in Web Client

— Adding network elements in Web Client

• Editing and viewing object properties using Web Client

• Using other operations in topology of Web Client
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Adding objects to topology in Web 
Client

This section describes the procedures how to add the objects to the 
Integrated EMS topology using Web Client. A map symbol is associated 
with a managed object representing its status. When you add an object 
to the Integrated EMS topology, the corresponding map symbol is 
added to the associated topology. This section explains the procedure 
describes how to add various objects in the following sub-sections:

• Adding platforms using Web Client

• Adding element managers in Web Client

• Adding EMS applications in Web Client

• Adding network elements in Web Client

Note: Do not specify the IP address in the client GUI or the 
command prompt UI, with an octet which is prefixed with a "zero". 
An IP address whose octet ranges from 0 to 255, when prefixed 
with zero, such as 010, is interpreted as an octal number and is 
passed as an "8", which results in an invalid IP address.
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Adding platforms using Web Client

This section provides the procedures how to add SSPFS and MDM 
platforms to the Integrated EMS topology using Web Client. For 
detailed explanation, follow these procedures:

• Adding an SSPFS platform

• Adding an MDM platform

Note: The SDM platforms are automatically discovered by 
Integrated EMS and added to the topology. The discovered SDM 
platform map symbols can be viewed under the EMS Platforms 
topology node in the Module tree of Web Client.
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Adding an SSPFS platform

This procedure describes how to add the SSPFS platform to the 
topology using Web Client.

To add the SSPFS platform to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add Platform node under the Network Admin tree. 
This invoke the Add Platform page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "SSPFS" from the Device Type list box.

6 Select the mode from the Mode list box. If "Simplex" item is 
selected from Mode list box, follow step a and proceed to step 7. 
If "Duplex" item is selected from the Mode list box, follow these 
steps:

a Enter the IP address of the active unit in the Unit-0 IP 
Address field.

b Enter the IP address of the inactive unit in the Unit-1 IP 
Address field.

7 Select the version of the device from the Device Version list 
box.

Description of fields in Add Platform page

Field Description

Host Name/IP Address The field for the host name or IP address of the platform.

Time Zone A list box to select the time zone associated with the 
object.

If selected device version 
is

Do

6.2 Got steps step 17
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8 Check the Radius Secret field to enable the RADIUS secret 
password and enter RADIUS secret password in the Radius 
Secret field.

Note: If the Radius Secret field is checked and the password 
is not entered, the wizard displays "Enter the radius secret" 
error.

9 Select the Fault Interface from the vertical button.

10 Enter the port value "2222" (in which the SSPFS communicates 
with Integrated EMS) in the Port field.

11 Enter the community in the Community field.

12 Select the SNMP version "v2c" from the Version list box.

13 Click the Performance Interface from the vertical tab.

14 Enter the port value "1161" in the Port field.

15 Enter the community in the Community field.

16 Select the SNMP version "v1" from the Version list box.

17 Click the Add Platform button to add the SSPFS platform. 

Once the SSPFS platform is added, "Successfully added to the 
database" message is displayed. The SSPFS platform with the 
specified name is added as a map symbol to the EMS Platforms 
topology. It is also added to the SSPFS topology under the EMS 
Platforms topology node in the Module tree.

Note: Integrated EMS correlates events received only from 
the SSPFS SNMP interface. The non-SNMP interfaces such 
as SYSLOG must be disabled using the "disable local logging" 
option from CLI. For details, refer to "Disabling local logging of 
SSPFS platform faults" section of ATM/IP Solution-level Fault 
Management, NN10408-900.

7.0 Go to step 8

8.0 Go to step 8

If selected device version 
is

Do
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Adding an MDM platform

The MDM platform is the runtime environment for various Nortel 
Networks EMSs and applications. Integrated EMS adds the MDM 
platform 8.0 automatically when adding the MDM 8.0 to the Integrated 
EMS topology. This procedure describes how to add the MDM platform 
version 6.2 or 7.0 to the topology in the Web Client.

To add the MDM platform to the topology using Web Client, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add Platform node under the Network Admin tree 
to invoke the Add Platform page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "MDM" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Click the Add Platform button to add the MDM platform.

Once the MDM platform is added, "Successfully added to the 
database" message is displayed. The MDM platform with the 
specified name is added as a map symbol to the EMS Platforms 
topology. It is also added to the MDM topology under the EMS 
Platforms topology node in the Module tree of Web Client.

Description of fields in Add Platform page

Field Description

Host Name/IP Address The field for the host name or IP address of the platform.

Time Zone A list box to select the time zone associated with the 
object.
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Adding element managers in Web Client

Integrated EMS provides an integration point for the various element 
managers. It allows a centralized point to launch the various element 
managers and the ability to view the faults from these systems in a 
common graphical interface. This section describes the procedure on 
how to add an Element Manager to the Integrated EMS topology using 
Web Client. The following sections explains the procedure describes 
how to add the element manager objects in the Integrated EMS 
topology:

• Adding an APS Manager

• Adding an CS 2000 Core Manager

• Adding an CEM

• Adding an MCS Manager

• Adding an GWC Manager

• Adding an MG 9000 Manager

• Adding an MDM

• Adding an SAM21 Manager

• Adding an UAS Manager

• Adding an CICM Manager

Note 1: When the above Element Manager Systems are added to 
the Integrated EMS topology, the network elements managed by 
these element managers are discovered automatically and added to 
the Integrated EMS topology.

Note 2: Integrated EMS supports dynamic updates for some of the 
element managers. Integrated EMS topology is updated based on 
the objects managed by the corresponding element managers. 
Integrated EMS supports dynamic topology updates for the following 
element managers:

• Audio Provisioning Server Manager

• Universal Audio Server Manager

• GWC Manager
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Adding an APS Manager

This procedure describes how to add the Audio Provisioning Server 
Manager to the Integrated EMS topology using Web Client.

To add the APS Manager to the topology using Web Client, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields in the Add EMS/NE page. For details on these fields, refer 
to the following table:

5 Select "EMS" from the Type list box.

6 Select "APS Mgr" from the Device Type list box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Select the version of the device from the Device Version list 
box.

9 Click the Add EMS/NE button to add the APS Manager.

Once the APS Manager is added, "Successfully added to the 
database" message is displayed. The APS Manager with the 
specified name is added as a map symbol to the Element 
Managers topology. In addition, a topology node named APS 
Manager with the specified display name in brackets is added 

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.
Integrated EMS Configuration Management
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under the Element Managers topology node in the Integrated 
EMS tree.
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Adding an CS 2000 Core Manager

This procedure describes how to add CS 2000 Manager in Integrated 
EMS topology using Web Client.

Note 1: While configuring the CS 2000 Core Manager logroute, 
ensure the following:

• Logroute on the associated SDM must be configured for TCPIN.

• Logroute on the associated SDM must be configured with 
ECORE set to OFF.

• Logroute on a CS 2000 Core Manager with a pre SDM20 software 
load version: the associated SDM log format must be set to STD 
or SCC2.

• Logroute on a CS 2000 Core Manager with a SDM20 or greater 
software load version: the associated SDM log format must be set 
to STD_OLD or SCC2_OLD.

Note 2: The end of log format for the NTSTD and SCC2 feeds can 
be configured in Integrated EMS by modifying the 
MLDefaultParams.xml file under the /opt/nortel/iems/current/conf 
folder. The SCC2 end of log format is specified in "SCC2_MESSAGE 
ENDOFLOG" parameter and NTSTD end of log format is specified in 
"NTSTD_MESSAGE ENDOFLOG" parameter. The end of log format 
must be using the X character format and be separated with colon 
(":"). The default end of log format values in MLDefaultParams.xml 
file are:

SCC2_MESSAGE ENDOFLOG="0A:0D:20:0A:0D"

NTSTD_MESSAGE ENDOFLOG="0A:19:0A:0D"

If the end of log format is changed in the MLDefaultParams.conf, the 
Integrated EMS Server requires restart to reflect the changes. 

Note 3: Integrated EMS polls periodically to check the CS 2000 
platform object status. If the data is not received between two status 
polls, Integrated EMS disconnects and reconnects the CS 2000 Core 
Manager. If the reconnect attempt throws an error, the CS 2000 Core 
Manager and its corresponding components turn to an unknown 
object status in Integrated EMS. In other words, the map symbols of 
these objects will turn to a gray background. For details on color for 
various severity levels, refer to the table in the Updating status of 
objects manually.

It is suggested that the polling interval for the CS 2000 Core Manager 
object in Integrated EMS retain (or be left near) the default value (300 
seconds). Reducing this significantly can result in frequent and 
Integrated EMS Configuration Management
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unnecessary attempts to reconnect to the CS 2000 Core Manager 
fault feed.

Note 4: All the events from the CS 2000 Core Manager are added 
as stateless events in Integrated EMS. These events are not 
correlated to alarms.

Note 5: The CS 2000 Core Manager residing on SSPFS platform is 
known as Core Billing Manager.

To add the CS 2000 Manager to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "EMS" from the Type list box.

6 Select "CS2K Core Mgr" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

8 Select the associated platform from the Platform list box or 
retain the default value "SDM" if it belongs to SDM platform.

Note: When the CS 2000 Core Manager version 7.0 is added 
with associated platform as "SSPFS", it implied that CS 2000 
Core Manager is a Core Billing Manager(CBM). 

9 Select the NE type "CS 2000 Core" or "Call Agent Core" from the 
Managing NE Type list box. By default, "CS 2000 Core" is 
selected in the list box. If you select "Call Agent Core" from the 

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.
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Managing NE Type list box, select the mode from the Mode list 
box and enter the valid IP address in the Active Unit IP field

10 Select the Fault Interface from the vertical tab.

11 Select the log format"SCC2" or "NTSTD" from the Log Format 
list box.

12 Enter the port in the Port field.

Note: The CS 2000 Core Manager sends log messages 
either through the NTSTD interface or through the SCC2 
interface. Select the applicable interface fields and enter the 
port (if different from default value).

13 Click the Add EMS/NE button to add the CS 2000 Core 
Manager.

Once the CS 2000 Core Manager is added, "Successfully added 
to the database" message is displayed. The CS 2000 Core 
Manager with the specified name is added as a map symbol to 
the Element Managers topology. In addition, a topology node 
named CS 2000 Manager with the specified display name in 
brackets is added under the Element Managers topology node 
in the Integrated EMS tree.
Integrated EMS Configuration Management
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Adding an CEM

This procedure describes how to add the Core Element Manager 8.0 to 
the Integrated EMS topology using Web Client.

Note: The Core Element Manager is available with selected 
versions of Carrier VoIP platforms. Hence, Core Element Manager is 
available in selected sites of Carrier VoIP platforms.

To add the Core Element Manager to the topology using Integrated 
Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

5 Select "EMS" from the Type list box.

6 Select "CEM Mgr" from the Device Type list box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Click the Add EMS/NE button to add the Core Element 
Manager.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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Once the Core Element Manager is added, "Successfully added 
to the database" message is displayed. The Core Element 
Manager with the specified name is added as a map symbol to 
the Element Managers topology.
Integrated EMS Configuration Management
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Adding an MCS Manager

This procedure describes how to add the MCS Manager to the 
Integrated EMS topology using Web Client.

Note 1: When adding MCS Manager of SSPFS HA configuration in 
Integrated EMS, both the active and inactive MCS Manager must be 
added as separate objects in Integrated EMS topology. The physical 
IP address of active or inactive MCS Manager host must be entered 
in the Host Name/IP Address of Add EMS/NE wizard. If the events 
are received from MCS Manager with virtual IP address, the events 
received from corresponding MCS Manager are correlated as events 
from unknown device.

Note 2: In the HA configuration, the standby MCS Manager is 
always in an "unknown" state and it raises the unable to 
communicate with device alarm. This alarm cannot be cleared in 
Integrated EMS.

Note 3: The MCS system manager (MCS SM) is also known as 
MCS Manager.

Required prerequisites for Integrated EMS to receive MCS fault and 
performance data

MCS must be configured to send fault and performance data to 
Integrated EMS; without this configuration, Integrated EMS receives no 
fault and performance data from Session Server NEs.

Required Prerequisites for launching MCS Client
MCS client launch is available only on a PC that has MCS software 
installed. For details of how to install the software refer to MCS System 
Management Console User Guide, NN10247-111. MCS Client 
software can be launched only in Microsoft Windows platforms.

Adding an MCS Manager using Web Client

To add the MCS Manager to the topology using Web Client, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.
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3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table.

5 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

6 Select "EMS" from the Type list box.

7 Select "MCS 5200 Mgr" from the Device Type list box.

8 Select the version of the device from the Device Version list 
box. 

9 Enter the user name of the device in the User Name field. 

10 Select the mode of the device from the Mode list box.

If "Duplex" mode is selected, enter the primary IP address and 
secondary IP address in the Instance 0 and Instance 1 fields 
respectively.

11 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belongs to any 
platform.

12 Select the NE type "MCS/CSE MX" or "Media Proxy" from the 
Managing NE Type list box. By default, "MCS/CSE MX" is 
selected in the list box.

13 Select the Fault Interface from the vertical tab.

14 In the Port field, enter the port value (in which the EMS 
communicates with Integrated EMS).

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address Enter the host name or IP address of the element 
manager in this field.

Time Zone Select the time zone from the Time Zone list box 
associated with the host name or IP address provided.

If the selected version is Do

6.2 steps 11 to 16 and step 23

7.0 steps 11 to 23

8.0 steps 9 to 23
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15 Enter the community in the Community field.

16 Select the SNMP version "v2c" from the Version list box.

Note: The port value and SNMP version are dependent on 
the MCS Manager configuration that is added.

17 Select the Performance Interface from the vertical tab.

18 Enter the directory name where the CSV file (is present in the 
device) in the Directory Name field.

19 Enter the file mask of the CSV file (present in the device) in the 
File Name field.

Wildcard support is available for this field.

Example
If the file names starts with "CSVOM" string, user can enter 
the value "CSVOM*.closed".

20 Retain the "SFTP" mode of file transfer selected in the Mode list 
box.

Note: In the Mode list box, the SFTP mode of file transfer 
must be selected.

21 Enter the user name for FTP account in the User ID field.

22 Enter the corresponding password for FTP account in the 
Password field.

23 Click the Add EMS/NE button to add the MCS Manager.

Once the MCS Manager is added, the "Successfully added to 
the database" message is displayed in the status bar. The MCS 
Manager with the specified name is added as a map symbol to 
the Element Managers topology.
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Adding an FPM

This procedure describes how to add the FPM to the Integrated EMS 
topology using Web Client.

Prerequisites for adding FPM
To add an FPM, the corresponding MCS must be added to the 
Integrated EMS topology.

Adding an FPM using Web Client

To add the FPM to the topology using Web Client, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table.

4 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

5 Select "EMS" from the Type list box.

6 Select "MCS 5200 Mgr" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

8 Retain the version "8.0" in the Device Version list box.

9 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belongs to any 
platform.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address Enter the host name or IP address of the element 
manager in this field.

Time Zone Select the time zone from the Time Zone list box 
associated with the host name or IP address provided.
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10 Select the MCS Manager to which the FPM corresponds to from 
the MCS Managers list box.

11 Enter the user name of the device in the User Name field. 

12 Select the mode in the Mode list box.

13 Enter the secondary IP address in the Secondary field.

14 Enter the primary IP address in the Primary field.

15 Select the Fault Interface from the vertical tab.

16 Enter the port value "9961" (in which the EMS communicates 
with Integrated EMS) in the Port field.

17 Enter the community in the Community field.

18 Select the SNMP version "v2c" from the Version list box.

Note: The port value and SNMP version are dependent on 
the MCS Manager configuration which is added.

19 Select the Performance Interface from the vertical tab.

20 Enter the directory name where the CSV file (is present in the 
device) in the Directory Name field.

21 Enter the file mask of the CSV file (present in the device) in the 
File Name field.

Wildcard support is available for this field.

Example
If the file names starts with "CSVOM" string, user can enter 
the value "CSVOM*.closed".

22 Retain the "SFTP" mode of file transfer selected in the Mode list 
box.

Note: In the Mode list box, the SFTP mode of file transfer 
must be selected.

23 Enter the user name for FTP account in the User ID field.

24 Enter the corresponding password for FTP account in the 
Password field.

25 Click the Add EMS/NE button to add the FPM.

Once the FPM is added, the "Successfully added to the 
database" message is displayed in the status bar. The details on 

If mode is Do

Simplex go to step 14

Duplex go to step 13
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how the map symbol and FPM node is added under Element 
Managers node, refer to Adding a Fault and Performance 
Manager (FPM).
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Adding an GWC Manager

Gateway Controller Manager manages Gateway Controller NEs. This 
procedure describes how to add the Gateway Controller (GWC) 
Manager to the Integrated EMS topology using Web Client. 

To add the GWC Manager to the topology using Web Client, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "EMS" from the Type list box.

6 Select "GWC Mgr" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

8 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform

9 Click the Add EMS/NE button to add the GWC Manager.

Once the GWC Manager is added, "Successfully added to the 
database" message is displayed. The GWC Manager with the 
specified name is added as a map symbol to the Element 
Managers topology. In addition, a topology node named GWC 
Manager with the specified display name in brackets is added 

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.
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under the Element Managers topology node in the Integrated 
EMS tree.
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Adding an MG 9000 Manager

MG9K is the abbreviation for Multi-Service Gateway 9000. MG 9000 
Manager manages MG 9000 NEs. MG 9000 Manager is also known as 
MG9K Manager since 9K stands for 9000. This procedure describes 
how to add the MG 9000 Manager using Web Client. 

To add the MG 9000 Manager to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "EMS" from the Type list box.

6 Select "MG9K Mgr" from the Device Type list box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Select the version of the device from the Device Version list 
box.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

If the device version is Do

6.2 follow step 9 to step 11 and 
step 15

7.0 follow step 9 to step 11 and 
step 15
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9 Enter the valid IP address in MG9K Mid Tier IP field. The IP 
address of the Mid Tier existing between Integrated EMS and 
MG 9000 Manager must be provided here.

10 Select the Fault Interface from the vertical tab.

11 Enter the valid subnet value with version in Subnet (with 
version) field as in following table:

12 Select the Performance Interface from the vertical tab.

For device version 6.2 or 7.0, a "No Performance Interface" 
message is displayed.

13 Enter the user name for SFTP-PULL in the User ID field.

14 Enter the password in the Password field.

15 Click the Add EMS/NE button to add the MG 9000 Manager. 

Once the MG 9000 Manager is added, "Successfully added to 
the database" message is displayed. The MG 9000 Manager 
with the specified name is added as a map symbol to the 
Element Managers topology. In addition, a topology node 
named MG 9000 Manager with the specified display name in 
brackets is added under the Element Managers topology node 
in the Integrated EMS tree.

8.0 go to step 9

Subnet Value for MG 9000 Manager in Various Version of 
Succession

MG 9000 Manager at Version Subnet Value

SN06.2 Subnet_062

SN07 Subnet_7

SN08 Subnet_7

If the device version is Do
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Adding an MDM

Multi-Service Data Manager manages Packet Voice Gateway 
7480/15000 (PVG 7480/15000) and Multiservice Switch 15000 
(MSS15K) NEs. This procedure describes how to add the Multi-Service 
Data Manager to the Integrated EMS topology using Web Client. 

To add the Multi-Service Data Manager to the topology using Web 
Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "EMS" from the Type list box.

6 Select "MDM" from the Device Type list box.

7 Select the version such as 8.0 of the device from the Device 
Version list box.

8 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.
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9 Select the manager unit mode from the Mode list box. There are 
two modes to be selected based on whether the MDM 
application is to run in a simplex or duplex mode. In the simplex 
mode, the MDM application is configured in one machine while 
in the duplex mode the application is configured to run in two 
machines. In the duplex mode configuration, the Integrated EMS 
switches over to the alternate (or secondary) machine in which 
the MDM application is executing, when the current (or primary) 
machine is down. 

10 Enter the secondary machine IP address in which the MDM 
application is to run, for the Inactive Unit IP field.

Note: Do not specify the IP address with an octet, which is 
prefixed with a "zero". An IP address whose octet ranges from 
0 to 255, when prefixed with zero, such as 010, is interpreted 
as an octal number and is passed as an "8", which results in 
an invalid IP address. 

11 Configure the user name and password under the MDM 
Account Details section for centralized account common to all 
MDM devices.Changing the user name or password for any 
MDM device is reflected for all MDM devices. 

Note: The MDM Account Details section is displayed only 
for the first time an MDM device is added to the Integrated 
EMS.

12 Select the Fault Interface from the vertical tab.

13 In the Port field of the Primary panel, enter the port in which log 
messages are sent by the MDM element manager.

14 Enter the user identification in the User ID field of the Primary 
panel.

15 In the Port field of the Secondary panel, enter the port in which 
log messages are sent by MDM element manager.

16 Enter the user identification in the User ID field of the Secondary 
panel.

If Mode is Do

Simplex follow step 11 to step 14 and proceed 
to step 17

Duplex follow step 10 to step 20
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17 Select the Performance Interface from the vertical tab.

Note: For the correct operation of the OM feed between the 
MDM and the IEMS, a Performance Measurement Stream 
Processor (PMSP) server must already be configured on the 
MDM workstation, and the 5-minute and 30-minute TCP port 
values on the MDM’s PMSP server must match the 5-minute 
and 30-minute port value configured on the IEMS for the 
MDM. For more information on the PMSP, refer to section 
"Performance Measurement Stream Processor (PMSP)" of 
Nortel Networks Multiservice Data Manager Server 
Reference, 241-6001-310.   

18 Enter the port number in the Five Min Collection Port field. The 
port configured in this field is scheduled to collect data every five 
minutes from the NEs managed by the MDM application. The 
port number must match the 5-minute TCP port number 
configured for the MDM’s PMSP server. The default port is 1646. 

19 Enter the port in the Thirty Min Collection Port field. The port 
configured in this field is scheduled to collect data every thirty 
minutes from the NEs managed by the MDM application. The 
port number must match the 30-minute TCP port number 
configured for the MDM’s PMSP server. The default port is 1647. 

20 Click the Add EMS/NE button to add the Multi-Service Data 
Manager.

Note: After the Multi-Service Data Manager is added, 
provision the client-server IP address with the procedure 
explained in the "Launching Multi-Service Data Manager" of 
Integrated EMS Basics, NN10329-111. 

Once the MDM is added, "Successfully added to the database" 
message is displayed. The MDM with the specified name is 
added as a map symbol to the Element Managers topology. In 
addition, a topology node named MDM with the specified display 
name in brackets is added under the Element Managers 
topology node in the Integrated EMS tree.
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Adding an SAM21 Manager

SAM21 is the acronym for Services Application Module, 21 slot. SAM 
21 Manager manages SAM21 NEs. This procedure describes how to 
add the SAM21 Manager to the Integrated EMS topology using Web 
Client. 

To add the SAM21 Manager to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "EMS" from the Type list box.

6 Select "SAM21 Mgr" from the Device Type list box.

The various fields display the location of various log files such as 
Customer Log File, Audit Log File, and Security Log File.

7 Select the version of the device from the Device Version list 
box.

8 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

9 Click the Add EMS/NE button to add the SAM21 Manager.

Once the SAM21 Manager is added, "Successfully added to the 
database" message is displayed. The SAM21 Manager with the 
specified name is added as a map symbol to the Element 

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.
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Managers topology. In addition, a topology node named SAM21 
Manager with the specified display name in brackets is added 
under the Element Managers topology node in the Integrated 
EMS tree.
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Adding an UAS Manager

Universal Audio Server Manager manages Universal Audio Server 
NEs. This procedure describes how to add the Universal Audio Server 
Manager to the topology using Web Client. 

To add the Universal Audio Server Manager to the topology using 
Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "EMS" from the Type list box.

6 Select the "UAS Mgr" value from the Device Type list box.

The channel name and the administrator name are displayed in 
various fields.

7 Select the version of the device from the Device Version list 
box.

8 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

9 Click the Add EMS/NE button to add the Universal Audio Server 
Manager.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.
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Once the Universal Audio Server Manager is added, 
"Successfully added to the database" message is displayed. The 
UAS Manager with the specified name is added as a map 
symbol to the Element Managers topology. In addition, a 
topology node named UAS Manager with the specified display 
name in brackets is added under the Element Managers 
topology node in the Integrated EMS tree.
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Adding an CICM Manager

This procedure describes how to add the CICM Manager to the 
Integrated EMS topology using Web Client.

Note: The CICM Manager is available with selected versions of 
Carrier VoIP platforms. Hence, CICM Manager is available in 
selected sites of Carrier VoIP platforms.

Required prerequisites for Integrated EMS to receive CICM fault and 
performance data

CICM Manager must be configured to send fault data to Integrated 
EMS. The CICM has a script called snmpri_configure which is used 
to configure the CICM with Integrated EMS server virtual IP address 
and port for sending the fault data to Integrated EMS; without this 
configuration, Integrated EMS receives no faults from CICM.

Required prerequisites for launching CICM Manager
CICM Manager has to be configured using SSPFS CLI tool for 
launching CICM Manager from Integrated EMS Client. For details, refer 
to ATM/IP Solution-level Configuration Management, NN10409-500.

Adding an CICM Manager using Web Client

To add the CICM Manager to the topology using Integrated Web 
Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.
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4 Enter the values for the Host Name/IP Address, Time Zone, and 
Display Name fields in the wizard. For details on these fields, 
refer to the following table:

5 Select "EMS" from the Type list box.

6 Select "CICM Mgr" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

8 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

9 Select the manager unit mode from the Mode list box. If "Duplex" 
mode selected, enter the inactive unit IP in the Inactive Unit IP 
field.

10 Enter the card location in the Card Location field.

11 Select the Fault Interface from the vertical tab.

12 Enter the port (in which the EMS communicates with Integrated 
EMS) in the Port field or retain the default value as "161".

13 Enter the community in the Community field.

14 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the element 
manager.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

15 Select the Performance Interface from the vertical tab.

16 Repeat step 12 to step 14.

17 Click the Add EMS/NE button to add the CICM Manager.

Once the CICM Manager is added, "Successfully added to the 
database" message is displayed. The CICM Manager with the 
specified name is added as a map symbol to the Element 
Managers topology.
Integrated EMS Configuration Management
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Adding EMS applications in Web Client

EMS applications manage elements in a network. This section provides 
the procedure that describes how to add the following EMS applications 
to the Integrated EMS topology using Web Client:

• Line Maintenance Manager

• Trunk Maintenance Manager

• OSSGate

• Network Patch Manager

• QoS Collector application

• SBRM application
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Adding an LMM application

Integrated EMS manages the Line Maintenance Manager (LMM) 
application after it is added to the Integrated EMS topology. This 
procedure describes how to add the LMM application to the Integrated 
EMS topology using Web Client.

To add the LMM application to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add Application node under the Network Admin 
tree to invoke the Add Application page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "LMM" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Click the Add Application button to add the LMM application.

Once the LMM application is added, "Successfully added to the 
database" message is displayed. The LMM application with the 
specified name is added as a map symbol to the EMS 
Applications topology. It is also added to the LMM topology 
under the EMS Applications topology node in the Integrated 
EMS tree.

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.
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Adding an TMM application

Integrated EMS manages the Trunk Maintenance Manager application 
after it is added to the Integrated EMS topology. This procedure 
describes how to add the Trunk Maintenance Manager (TMM) 
application to the Integrated EMS topology using Web Client.

To add the TMM application to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add Application node under the Network Admin 
tree to invoke the Add Application page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "TMM" from the Device Type list box.

6 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

7 Click the Add Application button to add the TMM application.

 Once the TMM application is added, "Successfully added to the 
database" message is displayed. The TMM application with the 
specified name is added as a map symbol to the EMS 
Applications topology. It is also added to the TMM topology 
under the EMS Applications topology node in the Integrated 
EMS tree.

Description of fields in Add Application page

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.
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Adding an OSSGate application

Integrated EMS manages OSSGate application after it is added to the 
Integrated EMS topology. This procedure describes how to add the 
OSSGate to the topology using Web Client.

To add the OSSGate application to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add Application node under the Network Admin 
tree to invoke the Add Application page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "OSSGate" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Click the Add Application button to add the OSSGate 
application.

Once the OSSGate application is added, "Successfully added to 
the database" message is displayed. The OSSGate application 
with the specified name is added as a map symbol to the EMS 
Applications topology. It is also added to the OSSGate topology 
under the EMS Applications topology node in the Integrated 
EMS tree.

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.
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Adding an NPM application

Integrated EMS manages the Network Patch Manager application after 
it is added to the Integrated EMS topology. This procedure describes 
how to add Network Patch Manager (NPM) application to the Integrated 
EMS topology using Web Client.

To add the NPM application to the topology using Web Client, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add Application node under the Network Admin 
tree to invoke the Add Application page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields in the wizard. For details on these fields, refer to the 
following table:

5 Select "NPM" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Click the Add Application button to add the NPM application.

Once the NPM application is added, "Successfully added to the 
database" message is displayed. The NPM application with the 
specified name is added as a map symbol to the EMS 
Applications topology. It is also added to the NPM topology 
under the EMS Applications topology node in the Integrated 
EMS tree.

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.
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Adding an QCA

Integrated EMS manages the QoS Collector application after it is added 
to the Integrated EMS topology. This procedure describes how to add 
the QoS Collector application to the Integrated EMS topology using 
Web Client.

To add the QoS Collector Application to the topology, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add Application node under the Network Admin 
tree to invoke the Add Application page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields in the wizard. For details on these fields, refer to the 
following table:

5 Select "QoS Collector" from the Device Type list box.

6 Select the version of the device from the Device Version list 
box.

7 Select the associated platform from the Platform list box or 
retain the default value "None" if it does not belong to any 
platform.

8 Click the Add Application button to add the QoS Collector 
application. 

Once the QoS Collector application is added, "Successfully 
added to the database" message is displayed. The QoS 
Collector application with the specified name is added as a map 
symbol to the EMS Applications topology. It is also added to the 
QoS Collector topology under the EMS Applications topology 
node in the Integrated EMS tree.

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.
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Adding an SBRM application

Integrated EMS manages the SBRM application after it is added to the 
Integrated EMS topology. This procedure describes how to add the 
SBRM application to the Integrated EMS topology using Web Client.

To add the SBRM Application to the topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Click the Admin tab in the Web Client.

3 Select the Add Application node under the Network Admin 
tree to invoke the Add Application page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields in the wizard. For details on these fields, refer to the 
following table:

5 Select "SBRM" from the Device Type list box.

6 Click the Add Application button to add the SBRM application. 

Once the SBRM application is added, the "Successfully added 
to the database" message is displayed. The SBRM application 
with the specified name is added as a map symbol to the EMS 
Applications topology. It is also added to the SBRM topology 
under the EMS Applications topology node in the Integrated 
EMS tree.

Field Description

Host Name/IP Address The field for the host name or IP address of the 
application.

Time Zone A list box to select the time zone associated with the 
object.
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Adding network elements in Web Client

The Nortel Integrated EMS manages the fault domain and provides a 
centralized location to access the management interfaces for the USP, 
Passport 8600, STORM, MS 2000, Session Server, MAS and CICM 
NEs. The following procedures describes how to add these NEs using 
Integrated Web Client.

• Adding an USP NE

• Adding an Ethernet Routing Switch 8600 NE

• Adding a STORM NE

• Adding an MS 2000 NE

• Adding an MAS NE

• Adding a Session Server NE

• Adding an CICM NE
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Adding an USP NE

Universal Signaling Points can be managed using Integrated EMS by 
adding them to the Integrated EMS topology. This procedure describes 
how to add the USP NE to the Integrated EMS topology using Web 
Client.

To add the USP NE to the topology using Web Client, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "NE" from the Type list box.

6 Select the mode of USP NE from the Mode list box ("Simplex" or 
"Duplex"). If you select "Duplex" from the Mode list box, you 
have to enter the inactive agent IP address in the In-Active 
Agent IP field.

7 Select "USP" from the Device Type list box.

8 Select the version of the device from the Device Version list 
box.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

If device version is Do

6.2 follow step 10 to step 18 and 
step 22

7.0 follow step 9 to step 18 and 
step 22
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9 Enter the client server IP in the Client Server IP field.

10 Enter the inactive agent IP address in the Unit1 IP Address 
field.

11 Select the Fault Interface from the vertical tab. 

Note: When adding a USP NE to the Integrated EMS 
inventory the SNMP attributes (refer to step 12 to step 16) 
must align with the configuration of the USP network element. 
In addition, the manager IP address in the USP must be 
configured to forward its SNMP traps to the Integrated EMS 
Server application (the Integrated EMS Virtual IP address). 
The configuration of the SNMP attributes in the USP are 
described in the USP Security and Administration guide, 
NN10159-611 and the USP Compact Security and 
Administration guide, NN10160-611. 

12 Enter the port value "161" (in which the NE agent communicates 
with Integrated EMS) in the Port field.

13 Select the SNMP version "from the Version list box. 

Note: The SNMP version must align with the version 
configured in the USP Network Element. The default SNMP 
version in the USP is V3.  

14 Retain the value "NoAuthNoPriv" for the Security Level list box.

15 Enter the value for the User name field as specified in USP 
Security and Administration guide, NN10159-61.

Note: The value for the Context name field must be left 
blank.

16 Enter the community string in the Community field.

17 Select the Standby Fault Interface from the vertical tab. 

18 Repeat step 12 to step 16.

19 Select the Performance Interface from the vertical tab.

20 Type the user name for FTP PULL in the User ID field.

8.0 follow step 9 to step 22

If the SNMP version is Do

v3 follow step 14 to step 15 and 
proceed to step 17

v2 proceed to step 16

If device version is Do
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21 Type the password in the Password field.

22 Click the Add EMS/NE button to add the USP NE.

Once the USP NE is added, "Successfully added to the 
database" message is displayed. The USP NE with the specified 
name is added as a map symbol to the Network Elements 
topology. It is also added to the USP topology under the 
Network Elements topology node in the Integrated EMS tree.

Note: Only the active USP unit object provides an interface to 
determine the fault state of the USP. The inactive USP unit 
object status is in unknown state (map symbol has gray 
background color). The Integrated EMS dynamically detects 
when the USP unit has been swacted. When this occurs, it 
initiates alarm resync with the newly active USP unit and 
updates the state of the USP unit objects in the Integrated 
EMS Client to reflect this change in activity. When this occurs 
the previous active unit object map is changed to unknown 
state, and the new active unit is updated to reflect the highest 
alarm state of the USP device. For the color mapping of 
various object status, refer to the Significance of map symbol 
background color table of "Updating status of objects 
manually".
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Adding an Ethernet Routing Switch 8600 NE

Ethernet Routing Switch (ERS) 8600 NEs can be managed using 
Integrated EMS by adding them to the Integrated EMS topology. This 
procedure describes how to add the ERS 8600 NE to the topology 
using Web Client.

Note: The IP address associated with the OAM&P VLAN must be 
provided in the Host Name/IP Address field. OAM&P VLAN is the 
interface from which the messages for ERS 8600 originate.

Required prerequisites for Integrated EMS to receive ERS 8600 fault 
and performance data

ERS 8600 NEs must be configured to send fault and performance data 
to Integrated EMS; without this configuration, Integrated EMS receives 
no fault and performance data from ERS 8600 NEs.

Required prerequisites for launching ERS 8600 Device Manager
ERS 8600 Device Manager must be installed on the client machine in 
order to launch the GUI. For details of how to install the Device 
Manager, refer to Installing ERS 8600 Switch Modules-312749F. 

Adding an ERS 8600 NE using Web Client

To add the ERS 8600 to the topology using Web Client, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.
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4 Enter the values for the Name, Time Zone, and Display Name 
fields. For details on these fields, refer to the following table:

5 Select "NE" from the Type list box.

6 Select "ERS 8600" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box. 

8 Select the Fault Interface from the vertical tab. 

9 Enter the Port in the Port field or retain the default value as 
"161".

10 Enter the Community in the Community field.

11 Select the SNMP Version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
Security Level list box. If you select the value "NoAuthNoPriv" 
from the Security Level list box, enter the following details:

• User Name

• Context Name (if any)

If you select the value "AuthNoPriv" from the Security Level list 
box, enter the following details:

• User Name

• Context Name (if any)

• Authentication Protocol

Description of fields in the Add EMS/NE page

Field Description

Name The field for the host name or IP address of the NE.

Note: The IP address associated with the OAM&P VLAN 
must be provided in the Host Name/IP Address field. 
OAM&P VLAN is interface from which the messages for 
ERS 8600 originate.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The  name that must be displayed in the topology for the 
map symbol.
NN10330-511   (I)SN08   Standard 02.05 March 2006



Nortel Networks Confidential323Copyright © 2006, Nortel Networks
If you select the value "AuthPriv" from the Security Level list box, 
enter the following details:

• User Name

• Context Name (if any)

• Authentication Protocol

• Privacy Password

12 Select the Performance Interface from the vertical tab. 

13 Repeat step 9 to step 11.

14 Click the Add EMS/NE button.

Once the ERS 8600 is added, the "Successfully added to 
database" message is displayed in the status bar. The ERS 
8600 NE with the specified name is added as a map symbol to 
the Network Elements topology. It is also added to the ERS 
8600 topology under the Network Elements topology node in 
the Module tree.
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Adding a STORM NE

STORM is the acronym for STORage Management Card. STORM NEs 
can be managed using Integrated EMS by adding them to the 
Integrated EMS topology. This procedure describes how to add the 
STORM NE to the topology using Web Client.

Note: STORM-Integrated EMS integration is not supported with the 
STORM dotHill configuration. The dotHill version of the STORM 
device does not have an SNMP agent to forward or read the faults 
from the STORM device. Integrated EMS integration is only 
supported with the new STORM-XTS configuration.

Required prerequisites for Integrated EMS to receive STORM fault 
and performance data

STORM must be configured to send fault data to Integrated EMS. The 
STORM has a tool called commish which is used to configure the 
STORM with Integrated EMS server virtual IP address and port for 
sending the fault data to Integrated EMS; without this configuration, 
Integrated EMS receives no fault data from STORM. For details, refer 
to Configuring STORM for Integrated EMS section.

Required prerequisites for launching STORM Manager
STORM has to be configured using SSPFS CLI tool for launching 
STORM manager from Integrated EMS Client. For details, refer to 
ATM/IP Solution-level Configuration Management, NN10409-500.

Adding an STORM NE using Web Client

To add the STORM to the topology using Web Client, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.
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4 Enter the values for the Host Name/IP Address and Time Zone 
fields in the wizard. For details on these fields, refer to the 
following table:

5 Select "NE" from the Type list box.

6 Select "STORM" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box. If "6.2" version is selected, follow step 8 to step 11 and 
proceed to step 14.

8 Select the Fault Interface from the vertical tab. 

9 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

10 Enter the community in the Community field.

11 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

Description of fields in Add EMS/NE Page

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.
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12 Select the Performance Interface from the vertical tab. 

13 Repeat step 9 to step 11.

14 Click the Add EMS/NE button to add the STORM.

Once the STORM is added, "Successfully added to the 
database" message is displayed. The STORM NE with the 
specified name is added as a map symbol to the Network 
Elements topology. It is also added to the STORM topology 
under the Network Elements topology node in the Module tree.
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Adding an MS 2000 NE

Media Server 2000 NE can be managed using Integrated EMS by 
adding them to the Integrated EMS topology. This procedure describes 
how to add the Media Server 2000 (MS 2000) NE to the topology using 
Web Client.

To add the MS 2000 NE to the topology using Web Client, follow 
these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "NE" from the Type list box.

6 Select "MS2000" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

8 Enter the SESM Server IP address in the SESM Server IP field.

SESM
Succession Element and Subnetwork Manager

9 Select the Fault Interface from the vertical tab. 

10 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

11 Enter the community in the Community field.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.
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12 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

13 Select the Fault Interface from the vertical tab. 

14 Repeat step 10 to step 12.

15 Click the Add EMS/NE button to add the MS 2000 NE.

 Once the MS 2000 NE is added, the "Successfully added to 
database" message is displayed in the status bar. The MS 2000 
NE with the specified name is added as a map symbol to the 
Network Elements topology. It is also added to the MS2000 
topology under the Network Elements topology node in the 
Module tree.
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Adding an MAS NE

MAS NEs can be managed using Integrated EMS by adding them to the 
Integrated EMS topology. This procedure describes how to add the 
MAS NE to the topology using Web Client.

Required prerequisites for Integrated EMS to receive MAS fault and 
performance data 

MAS must be configured to send fault data to Integrated EMS; without 
this configuration, Integrated EMS receives no fault and performance 
data from MAS NEs.

Adding an MAS NE using Web Client

To add the MAS NE to the topology using Integrated EMS Web 
Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "NE" from the Type list box.

6 Select "MAS" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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8 Select the Fault Interface from the vertical tab. 

9 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

10 Enter the community in the Community field.

11 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

12 Select the Performance Interface from the vertical tab. 

13 Enter the directory name where the CSV file is getting pushed in 
Integrated EMS Server from the device in the Directory Name 
field.

14 Enter the file mask of the CSV file getting pushed in the File 
Name field.

Wildcard support is available for this field.

Example
If the file names starts with "SystemOMs" string, user can 
enter the value "SystemOMs*.csv".

Note: While configuring each MAS device, ensure that the 
operational measurement (OM) file names are unique. This is 
useful to differentiate data transmitted from each of the 
devices. 
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15 Retain the "PUSH" mode of file transfer selected in the Mode list 
box.

Note: In the Mode list box, the "PUSH" mode of file transfer 
must be selected.

16 Click the Add EMS/NE button to add the MAS NE.
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Adding a Session Server NE

Session Server NEs can be managed using Integrated EMS by adding 
them to the Integrated EMS topology. This procedure describes how to 
add the Session Server NE to the topology using Web Client.

Required prerequisites for Session Server to receive fault and 
performance data

Session Server NE must be configured to send fault and performance 
data to Integrated EMS; without this configuration, Integrated EMS 
receives no fault and performance data from Session Server NEs.

Required prerequisites for launching Session Server
Session Server NE has to be configured using SSPFS CLI tool for 
launching Session Server from Integrated EMS Client. For details, refer 
to ATM/IP Solution-level Configuration Management, NN10409-500.

Adding a Session Server NE using Web Client

To add the Session Server NE to the topology using Integrated 
EMS Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.

Display Name The name that must be displayed in the topology for the 
map symbol. 
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5 Select "NE" from the Type list box.

6 Select "Session Server" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

8 Select the device mode from the Mode list box.

9 Select the Fault Interface from the vertical tab. 

10 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

11 Enter the community in the Community field.

12 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

13 Select the Performance Interface from the vertical tab. 

14 Repeat step 10 to step 12.

15 Click the Add EMS/NE button to add the Session Server NE.
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Adding an CICM NE

CICM NEs can be managed using Integrated EMS by adding them to 
the Integrated EMS topology. This procedure describes how to add the 
CICM NE to the topology using Web Client.

Required prerequisites for Integrated EMS to receive CICM fault and 
performance data

CICM Manager must be configured to send fault data to Integrated 
EMS. The CICM has a script called snmpri_configure which is used 
to configure the CICM with Integrated EMS server virtual IP address 
and port for sending the fault data to Integrated EMS; without this 
configuration, Integrated EMS receives no faults from CICM.

Required prerequisites for launching CICM Manager
CICM Manager has to be configured using SSPFS CLI tool for 
launching CICM Manager from Integrated EMS Client. For details, refer 
to ATM/IP Solution-level Configuration Management, NN10409-500.

Adding an CICM NE using Web Client

To add the CICM to the topology using Web Client, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Admin tab in the Web Client.

3 Select the Add EMS/NE node under the Network Admin tree to 
invoke the Add EMS/NE page in the right-side frame.

4 Enter the values for the Host Name/IP Address and Time Zone 
fields. For details on these fields, refer to the following table:

5 Select "NE" from the Type list box.

Description of fields in Add EMS/NE page

Field Description

Host Name/IP Address The field for the host name or IP address of the NE.

Time Zone A list box to select the time zone associated with the 
object.
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6 Select "CICM" from the Device Type list box.

7 Select the version of the device from the Device Version list 
box.

8 Select the NE unit mode from the Mode list box. If "Duplex" 
mode selected, follow these steps:

a Enter the inactive unit IP in the Inactive-Unit IP field,

b Enter the Card B IP address in the Card B IP Address field.

c Enter the Card B display name in the Card B Display Name 
field.

9 Enter the card location in the Card Location field.

10 Enter the Card A IP address in the Card A IP Address field.

11 Select the Fault Interface from the vertical tab. 

12 Enter the port (in which the NE agent communicates with 
Integrated EMS) in the Port field or retain the default value as 
"161".

13 Enter the community in the Community field.

14 Select the SNMP version from the Version list box. If you select 
"v3" from Version list box, select the security level from the 
SecurityLevel list box. If you select the value "NoAuthNoPriv" 
from the SecurityLevel list box, enter the following details:

• User name

• Context name

If you select the value "AuthNoPriv" from the SecurityLevel list 
box, enter the following details:

• User name

• Context name

• Authentication Protocol

If you select the value "AuthPriv" from the SecurityLevel list box, 
enter the following details:

• User name

• Context name

• Authentication Protocol

• Privacy Password

15 Select the Performance Interface from the vertical tab. 

16 Repeat step 12 to step 14.
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17 Click the Add EMS/NE button to add the CICM.

Once the CICM NE is added, the "Successfully added to 
database" message is displayed in the status bar. The CICM NE 
with the specified name is added as a map symbol to the 
Network Elements topology. It is also added to the CICM 
topology under the Network Elements topology node in the 
Module tree.
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Using the topology operations in Web 
Client

This section provides the procedures that describes how to use the 
various operations in topology GUIs of Integrated EMS Web Client. 

• Editing and viewing object properties using Web Client

• Using other operations in topology of Web Client
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Editing and viewing object properties using Web Client

Application
Use this procedure to modify or view the properties of an object in the 
IEMS topology using Web Client.

Prerequisites
None

Action

At the IEMS workstation

1 Launch the IEMS Web Client. Refer to Launching the IEMS Web 
Client in IEMS Basics, NN10329-111.

2 Select the Integrated EMS Topologies tab.

3 Navigate to the required topology node in the Integrated EMS 
Topologies tree.

4 Click the map symbol label to open the General Information 
window. 

Note: The object properties displayed can differ for each 
component. 

A window similar to the following figure opens.
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5 Select each vertical tab and modify the object properties listed 
in the table below if required. 

Managed object properties in Web Client

Field Description

General

Name Displays the unique object name of the 
managed object

Device Type Displays the type of object (element manager, 
EMS, EMS platform or NE)

Status Displays the status of the object

Is Managed? Indicates whether the object is managed or 
unmanaged

Display Name Displays the name or label displayed in map 
symbol

Device Version Select the version of the device from the 
drop-down list
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IP Address Modify the IP address of the object

Web User name Enter your web user name

Web Password Enter your web password

Monitoring

Last Status Update 
Time 

Displays the time when the status of the 
managed object last changed

Last Status Change 
Time 

Displays the time when the status of the 
managed object last changed

Status Polling 
Interval (secs)

Modify the Poll Interval for status updates

Managed object properties in Web Client

Field Description
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6 Click the Update Object button to update the changes.

7 You have completed this procedure.

Fault Interface

If the details are present for the selected object, the details can be 
modified.

Performance Interface

If the details are present for the selected object, the details can be 
modified.

Managed object properties in Web Client

Field Description
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Using other operations in topology of Web Client

Other operations such as manage or unmanage an object, delete an 
object, and view related events or alarms can be done in Integrated 
EMS. These operations are triggered through the menus launched from 
map symbol. 

Manage or Unmanage
You can make Integrated EMS server to stop managing a particular 
object, by selecting the Unmanage menu item. This menu item can be 
found in the popup menu that appears when you click the arrow symbol 
in the map symbol. To unmanage an object in topology, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the required topology node in the Module tree (Integrated 
EMS Topologies tree) in which the required map symbol is 
shown.

3 Click the arrow of the required map symbol in the topology to 
invoke the popup menu.

4 Select the Object -->Unmanage menu command.

To manage an object which is in unmanaged state, follow step 1 to 
step 3 and select the Object-->Manage menu command.

Delete object and traces
An object in the topology can be deleted to remove it from topology. To 
remove an object from topology using Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the required topology node in the Module tree in which the 
required map symbol is shown.

3 Click the arrow of the map symbol (that needs to be removed) in 
the topology to invoke the popup menu and select <Object type 
name>-->Delete Object and Traces menu item.
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Viewing related events
To view events associated with an object in topology, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the required topology node in the Module tree in which the 
required map symbol is shown.

3 Click the arrow in the map symbol of the topology to invoke the 
popup menu.

4 Select Object-->View Events menu command.

 It lists the related events of the object in the Events page.

Viewing related alarms
To view the alarms associated with an object in topology, follow these 
steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the required topology node in the Module tree in which the 
required map symbol is shown.

3 Click the arrow of the map symbol in the topology to invoke the 
popup menu and select Object-->Alarms menu command. 

It lists the related alarms of the object in the Alarms page.
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Working with inventory in Web Client

The Inventory maintains the properties of all the managed objects 
managed in a network. These managed objects and their associated 
properties are listed in the Inventory view. The information is available 
in a table format which is called List View. This section provides the 
procedure that describes how to perform following tasks in inventory:

• Viewing managed object details

• Navigating inventory

• Searching objects in inventory view

• Working with inventory view

• Using other operations in inventory view



Integrated EMS Configuration Management

Nortel Networks Confidential345Copyright © 2006, Nortel Networks

Viewing managed object details

The details of a managed object such as type, status, managed or 
unmanaged, display name can be viewed and some of the properties 
can be modified. This procedure describes how to view the managed 
object details in Integrated EMS Inventory.

To view the details of managed object and update in Inventory, 
follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Inventory tab in Web Client.

3 Select the required node in the Module tree (Inventory tree).

4 Click the required managed object name link under the Name 
column.

The details page of the corresponding managed object is 
launched.

5 Modify the properties in the corresponding horizontal tabs if 
required as indicated in the Managed object properties in Web 
Client.

6 Click the Update button to update the changes.
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Navigating inventory

The inventory in Web Client is navigated with the help of navigation 
tools such as view range, navigator buttons and column reordering. You 
can sort out the inventory based on your requirements. The following 
procedures describes how to change managed objects per page, sort 
and browse inventory. 

To navigate to Inventory tab of Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Inventory tab in Web Client.

3 Select the required node in the Module tree (Inventory tree). 

The Module tree contains the following nodes:

• Complete View

• EMS

• Platform

• Application

• NE

Clicking each node in the Module tree displays its corresponding 
Managed Object details. 

Browsing the Inventory
The navigator buttons First, Previous, Next, and Last are located below 
the module menus. The descriptions of the buttons can be found in 
Description of Buttons in Navigation Bar of "Navigating Events" in the 
Integrated EMS Fault Management, NN10334-911.

Customizing managed objects per page
By default, 50 managed objects are shown per page in the Inventory 
table. You can change the number of events displayed using the 
following procedure:

To change the number of managed objects displayed per page in 
Inventory page, follow these steps:

At Inventory tab in Web Client

1 Select required node in the Module tree. 
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2 Select the required page count from the list box to select the 
entries per page (below the module menus).

The corresponding number of managed objects are displayed 
per page.

Customizing the columns
The event's properties are displayed as columns in the Networks 
Events page. You can show or hide the columns displayed in the 
Network Events table. The procedure to show or hide the columns is 
same as the Customizing the Columns procedure in the "Navigating 
Events" of the Integrated EMS Fault Management, NN10334-911.

Sorting events
By default, the network elements are displayed in the order of their 
discovery and in descending order. This order can be changed using 
the Sorting option.

To sort the managed objects in Inventory table, follow these steps

At Inventory tab in Web Client

1 Select the required node in the Module tree. 

2 Click the required column header in the table to sort in the 
column in the ascending order. 

Click the column order again to sort it in descending order. If the 
arrow in the column header is facing upwards means the column 
is sorted in ascending order and arrow facing downwards means 
column is sorted in descending order.

Example
If you need to sort the managed objects based on their 
status, click the Status column header. This sorts the 
managed objects based on their status with the default order 
of precedence is Critical, Major, Minor, and Warning. For 
descending order of the same column, click the Status 
column header again.
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Searching objects in inventory view

The Search option in Web Client facilitates searching for managed 
objects. The search operation is performed on the entire database and 
is not restricted to the displayed page alone. You can search for a 
required managed object based on a general condition or a unique 
criterion.

To navigate to Inventory tab of Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Inventory tab in Web Client.

3 Select the required node in the Module tree (Inventory tree).

4 Click the Search menu item in Module Menu below the Module 
tab.

The procedure to search for managed objects in Inventory is found in 
"Searching Events" of the Integrated EMS Fault Management, 
NN10334-911.
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Working with inventory view

The managed objects listed in the Inventory can be numerous and 
hence difficulty arises in identifying managed objects of your interest. A 
search can be performed to locate the managed objects you are looking 
for, but if you are looking for a lot of managed objects that satisfy a 
certain set of criteria, then use the Add Child View, Modify View Criteria, 
and Remove View options. This helps you in getting the managed 
objects of your interest alone in that view, instead of doing a search 
every time.

A Child View that you create is a subset of data that satisfy a given 
criteria from a larger collection. By creating new views, it is easy to filter 
and display the required data, and sort through large amount of 
managed objects details.

To navigate to Inventory tab of Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Inventory tab in Web Client.

3 Select the required node in the Module tree (Inventory tree).

Adding Inventory View
By default, the Inventory module has default types of views such as 
Complete View, EMS, Platform, Application, and NE. You can create 
new views under these default views.

Example
You can create a new view named MajorEMS under EMS inventory 
node which shows only managed objects that are in Major status. 
Within this MajorEMS view, you can create more views, say M1, M2, 
and so on. M1 can have a different set of criteria, say only NTSTD 
enabled managed objects in that particular network. Deleting 
MajorEMS deletes its child views (M1, M2, and so on) as well.

To add the inventory View, follow these steps:

At Inventory tab of Web Client

1 Select the required node in Module tree.

2 Click Add Child View menu item in the Module Menus area. 
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The Add Child View page is launched.

3 Enter the child view name in the Child view name field 
(mandatory).

4 Select the Match any of the Following option if you want to 
perform a search operation that satisfies any of the matching 
criteria that you specify. If you need all the matching criteria to 
be satisfied, select Match all the Following.

5 Select the property based on which you need to create the view. 
For description of the properties, refer to Description of 
properties in Properties tab of Custom View GUI for Events table 
of "Custom View for Events: Matching Criteria" in the Integrated 
EMS Fault Management, NN10334-911.

If you have selected property related to date or time, the Date 
Input Helper button option is useful. Clicking this button invokes 
the Date Input Helper popup. The current month, year, date, and 
time is displayed. Select the required date and time for which you 
need the view criteria to be based on and click the Apply button. 
On performing this, the Value field is set with the configured date 
and time.

6 Select the condition based on which you need to restrict your 
view.

7 Enter the exact information in the Value field based on which you 
need to create the view. 

8 Click the More button and repeat step 5 to step 7 to add more 
criteria. Fewer option can be used to remove any criteria.

9 Use Preview Results button for a preview of the required view.

10 Click Add Child View button to add the child view with the 
criterion specified.

Modifying Inventory View
You can modify a view to change the criteria or to rename the view. To 
modify the inventory View, follow these steps:

At Inventory tab of Web Client

1 Select the required inventory view in Module tree that has to be 
modified.

2 Click Edit View Criteria menu item in the Module Menus area. 

The Edit Inventory View Criteria page is launched.

3 Modify the child view name in the Child view name field 
(mandatory).
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4 Follow the step 4 to step 8 in the Adding Inventory View 
procedure to modify the criteria.

5 Use Preview Results button for a preview of the required view.

6 Click Add Child View to add the child view with the criterion 
specified.

Removing Inventory View
You can remove child views and the default view in the Inventory tab of 
Web Client.

To remove the inventory View, follow these steps:

At Inventory tab of Web Client

1 Select the required inventory view in Module tree that has to be 
removed.

2 Click Remove View menu item in the Module Menus area. 

A dialog is launched confirming the removal of inventory view.

3 Click Yes button to remove the selected inventory view.
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Using other operations in inventory view

In the Inventory tab of Integrated EMS Web Client, you can view related 
events or alarms for a selected object, manage or unmanage objects, 
and delete objects. This section provides the procedures do these 
operations.

To navigate to Inventory tab of Web Client, follow these steps:

At Integrated EMS workstation

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Inventory tab in Web Client.

3 Select the required node in the Module tree (Inventory tree).

Managing objects
An object can be managed separately or multiple objects can be 
managed.

To manage an object in the inventory view, follow these steps:

At Inventory tab of Web Client

1 Launch the Integrated EMS Web Client (refer to "Launching 
Integrated EMS Web Client" of Integrated EMS Basics, 
NN10329-111).

2 Select the Object-->Manage menu item from the popup menu.

The Status column of the corresponding object changes to 
current managed object status.

To manage multiple objects in the inventory view, follow these 
steps:

At Inventory tab of Web Client

1 Select the check box against the required rows in the Inventory 
table that needs to be managed.

2 Select the Manage item from Operations list box below the 
Module menus area.

The Status column of the corresponding object changes to 
corresponding managed object status
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Unmanaging objects
An object can be unmanaged separately, or multiple objects can be 
unmanaged.

To unmanage an object in the inventory view, follow these steps:

At Inventory tab of Web Client

1 Click the >> icon next to the Name of the object in the Inventory 
table which needs to be unmanaged.

The inventory popup menu is launched for the object.

2 Select the Object-->Unmanage menu item from the popup 
menu.

The Status column of the corresponding object changes to 
current status of object from "Unknown" status.

To unmanage multiple objects in the inventory view, follow these 
steps:

At Inventory tab of Web Client

1 Select the check box against the required rows in the nventory 
table that needs to be unmanaged.

2 Select the Unmanage item from Operations list box below the 
Module menus area.

The Status column of the corresponding object changes to 
current status of object from "Unknown" status.

Deleting objects
An object can be deleted from the database, or multiple objects can be 
deleted.

To delete an object in the inventory view, follow these steps:

At Inventory tab of Web Client

1 Click the >> icon next to the Name of the object in the Inventory 
table which must be removed.

The inventory popup menu is launched for the object.

2 Select the <object specific menu>-->Delete Object and 
Traces menu item from the popup menu.

The object is removed from database and Inventory table is 
updated.
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To delete multiple objects in the inventory view, follow these 
steps:

At Inventory tab of Web Client

1 Select the check box against the required rows in the Inventory 
table that needs to be removed.

2 Select Delete Objects item from Operations list box below the 
Module menus area.

The selected rows are removed from database and the Inventory 
table is updated.

Viewing related events
The events associated with an object or multiple objects can be viewed 
from Inventory.

To view events related to an object in the inventory view, follow 
these steps:

At Inventory tab of Web Client

1 Click the >> icon next to the Name of the object in the Inventory 
table for which the associated events is listed.

The inventory popup menu is launched for the object.

2 Select the Objects-->View Events menu item from the popup 
menu.

The events associated with the object is listed in Network Events 
page.

Click the Back button of the browser or in Module menus area to 
get back to previous page.

To view events associated to multiple objects in the inventory 
view, follow these steps:

At Inventory tab of Web Client

1 Select the check box against the required rows in Inventory table 
for which associated events are listed.

2 Select the View Events item from Events & Alarms list box 
below the Module menus area.

The events associated with the object is listed in Network Events 
page.

Click the Back button of the browser or in Module menus area to 
get back to previous page.
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Viewing related alarms
The alarms associated with an object or multiple objects can be viewed 
from Inventory.

To view alarms related to an object in the inventory view, follow 
these steps:

At Inventory tab of Web Client

1 Click the >> icon next to the Name of the object in the Inventory 
table for which the associated alarms is listed.

The inventory popup menu is launched for the object.

2 Select the Objects-->View Alarms menu item from the popup 
menu.

The alarms associated with the object is listed in Alarms page.

Click Back button of the browser or in Module menus area to get 
back to previous page.

To view alarms associated to multiple objects in the inventory 
view, follow these steps:

At Inventory tab of Web Client

1 Select the check box against the required rows in Inventory table 
for which associated events are listed.

2 Select the View Alarms item from Events & Alarms list box 
below the Module menus area.

The alarms associated with the object is listed in Alarms page.

Click the Back button of the browser or in Module menus area to 
get back to previous page.

Printing Inventory
Printing a Inventory view helps you to gather information on all the 
elements or those of your interest alone. You can customize a view by 
adding or removing columns using Customizing the Columns option 
(refer to Customizing Columns procedure in the "Navigating Events" of 
the Integrated EMS Fault Management, NN10334-911), order the list 
by sorting, or by creating child views. After customization, use the Print 
Version menu item to get a printed version of the same.
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To print the inventory view, follow these steps:

At Inventory tab of Web Client

1 Click the required Inventory node in the Module tree on the left 
side frame.

2 Click the Print Version menu item located in the Module menus 
area. 

A new page with the list of Inventory details is displayed.

3 Click the Print button to print the details listed.
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